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Function Reference

Requirements Management
Interface (p. 1-2)

Model Coverage (p. 1-3)

Component Analysis and
Verification (p. 1-5)

Model Checking (p. 1-6)

Model Advisor Customization API
(p. 1-7)

Model Advisor Result Template API
(p. 1-9)

Model Advisor Formatting API

(p. 1-10)

Manage links between requirements
documents and Simulink® objects

Configure and execute model
coverage tests; store and report test
results

Define workflows for testing models,
subsystems, and atomic subcharts

Check systems by running Model
Advisor checks; view results in
Command Window, web browser, or
Model Advisor window

Customize the Model Advisor tree;
create new checks and folders

Template for formatting Model
Advisor results

Format Model Advisor outputs



1 Function Reference
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Requirements Management Interface

rmi

rmi.doorssync

rmi.objinfo

rmidocrename

rmiobjnavigate

rmiref.insertRefs

rmiref.removeRefs

rmitag

Interact programmatically with
Requirements Management
Interface

Synchronize model with DOORS
surrogate module

Return navigation information for
model object

Update model requirements
document paths and file names

Navigate to model objects using
unique Requirements Management
Interface identifiers

Insert links to models into
requirements documents

Remove links to models from
requirements documents

Manage user tags for requirements
links



Model Coverage

Model Coverage

add (cv.cvtestgroup) Add cvtest objects

allNames (cv.cvdatagroup) Get names of all models

allNames (cv.cvtestgroup)

associated with cvdata objects
in cv.cvdatagroup

Get names of all models
associated with cvtest objects
in cv.cvtestgroup

complexityinfo Cyclomatic complexity coverage
information
conditioninfo Collect condition coverage

cv.cvdatagroup

cv.cvtestgroup

information for model object

Create collection of cvdata objects
for model reference hierarchy

Create collection of cvtest objects
for model reference hierarchy

cvexit Exit model coverage environment

cvhtml Produce HTML report from model
coverage objects

cvload Load coverage tests and stored
results into memory

cvmodelview Display model coverage results with
model coloring

cvsave Save coverage tests and results to
file

cvsim Simulate and return model coverage
results for test objects

cvsimref Simulate and return model coverage
results for referenced models

cvtest Create model coverage test

specification object

1-3
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decisioninfo

get (cv.cvdatagroup)
get (cv.cvtestgroup)
getAll (cv.cvdatagroup)

getCoveragelnfo

mcdcinfo

sigrangeinfo

sigsizeinfo

tableinfo

Display decision coverage
information for model object

Get cvdata object
Get cvtest objects
Get all cvdata objects

Coverage information for Simulink®
Design Verifier™ blocks

Collect modified condition/decision
coverage information for model
object

Collect signal range coverage
information for model object

Collect signal size coverage
information for model object

Display lookup table coverage
information for model object



Component Analysis and Verification

Component Analysis and Verification

Model Preparation (p. 1-5)

Test Execution (p. 1-5)

Analysis Results (p. 1-5)

Model Preparation

slvnvextract

slvnvlogsignals

Test Execution

slvnvruncgvtest

slvnvruntest

slvnvruntestopts

Analysis Results

slvnvharnessopts
slvnvmakeharness

slvnvmergedata

slvnvmergeharness

Extract subsystem or subchart
contents into new model for analysis

Log simulation input port values

Invoke Code Generation Verification

(CGV) API and execute model

Simulate model using test cases

Generate simulation or execution

options for slvnvruntest or
slvnvruncgvtest

Generate default options for
slvnvmakeharness

Generate Simulink® Verification and

Validation™ harness model

Merge test case data

Merge test cases and initializations

into one model
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Model Checking

ModelAdvisor.lookupCheckID
ModelAdvisor.run

ModelAdvisor.summaryReport
view

viewReport

Look up Model Advisor check ID

Run Model Advisor checks on
systems

Open Model Advisor Command-Line
Summary report

View Model Advisor run results for
checks

View Model Advisor run results for
systems



Model Advisor Customization API

Model Advisor Customization API

addCheck Add check to folder

(ModelAdvisor.FactoryGroup)

addGroup (ModelAdvisor.Group) Add subfolder to folder

addProcedure (ModelAdvisor.Group) Add procedure to folder

addProcedure Add subprocedure to procedure

(ModelAdvisor.Procedure)

addTask (ModelAdvisor.Group) Add task to folder

addTask (ModelAdvisor.Procedure)  Add task to procedure

getID (ModelAdvisor.Check) Return check identifier

ModelAdvisor.Action Add actions to custom checks

ModelAdvisor.Check Create custom checks

ModelAdvisor.FactoryGroup Define subfolder in By Task folder

ModelAdvisor.Group Define custom folder

ModelAdvisor.InputParameter Add input parameters to custom
checks

ModelAdvisor.ListViewParameter Add list view parameters to custom
checks

ModelAdvisor.Procedure Define custom procedures

ModelAdvisor.Root Identify root node

ModelAdvisor.Task Define custom tasks

publish (ModelAdvisor.Root) Publish object in Model Advisor root

register (ModelAdvisor.Root) Register object in Model Advisor root

setAction (ModelAdvisor.Check) Specify action for check

setCallbackFcn Specify action callback function

(ModelAdvisor.Action)

setCallbackFcn Specify callback function for check

(ModelAdvisor.Check)

setCheck (ModelAdvisor.Task) Specify check used in task

1-7
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setColSpan
(ModelAdvisor.InputParameter)

setInputParameters
(ModelAdvisor.Check)

setInputParametersLayoutGrid
(ModelAdvisor.Check)

setRowSpan
(ModelAdvisor.InputParameter)

Specify number of columns for input
parameter

Specify input parameters for check

Specify layout grid for input
parameters

Specify rows for input parameter



Model Advisor Result Template API

Model Advisor Result Template API

addRow
(ModelAdvisor.FormatTemplate)

ModelAdvisor.FormatTemplate

setCheckText
(ModelAdvisor.FormatTemplate)

setColTitles
(ModelAdvisor.FormatTemplate)

setInformation
(ModelAdvisor.FormatTemplate)

setListObj
(ModelAdvisor.FormatTemplate)

setRecAction
(ModelAdvisor.FormatTemplate)

setRefLink
(ModelAdvisor.FormatTemplate)

setSubBar
(ModelAdvisor.FormatTemplate)

setSubResultStatus
(ModelAdvisor.FormatTemplate)

setSubResultStatusText
(ModelAdvisor.FormatTemplate)

setSubTitle
(ModelAdvisor.FormatTemplate)

setTablelnfo
(ModelAdvisor.FormatTemplate)

setTableTitle
(ModelAdvisor.FormatTemplate)

Add row to table

Construct template object for

formatting Model Advisor analysis

results

Add description of check to result

Add column titles to table

Add description of subcheck to result

Add list of hyperlinks to model
objects

Add Recommended Action section
and text

Add See Also section and links

Add line between subcheck results

Add status to check or subcheck
result

Add text below status in result
Add title for subcheck in result

Add data to table

Add title to table

1-9
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Model Advisor Formatting API

addItem (ModelAdvisor.List)
addItem (ModelAdvisor.Paragraph)
getEntry (ModelAdvisor.Table)
ModelAdvisor.Image

ModelAdvisor.LineBreak
ModelAdvisor.List
ModelAdvisor.Paragraph
ModelAdvisor.Table
ModelAdvisor.Text

setAlign (ModelAdvisor.Paragraph)
setBold (ModelAdvisor.Text)
setColHeading (ModelAdvisor.Table)

setColHeadingAlign
(ModelAdvisor.Table)

setColor (ModelAdvisor.Text)
setColWidth (ModelAdvisor.Table)
setEntries (ModelAdvisor.Table)
setEntry (ModelAdvisor.Table)
setEntryAlign (ModelAdvisor.Table)
setHeading (ModelAdvisor.Table)

setHeadingAlign
(ModelAdvisor.Table)

setHyperlink (ModelAdvisor.Image)
setHyperlink (ModelAdvisor.Text)

setImageSource
(ModelAdvisor.Image)

Add item to list
Add item to paragraph
Get table cell contents

Include image in Model Advisor
output

Insert line break

Create list class

Create and format paragraph
Create table

Create Model Advisor text output
Specify paragraph alignment
Specify bold text

Specify table column title

Specify column title alignment

Specify text color

Specify column widths

Set contents of table

Add cell to table

Specify table cell alignment
Specify table title

Specify table title alignment

Specify hyperlink location
Specify hyperlinked text

Specify image location



Model Advisor Formatting API

setltalic ModelAdvisor.Text)

setRetainSpaceReturn
(ModelAdvisor.Text)

setRowHeading
(ModelAdvisor.Table)

setRowHeadingAlign
(ModelAdvisor.Table)

setSubscript (ModelAdvisor.Text)
setSuperscript (ModelAdvisor.Text)
setType (ModelAdvisor.List)
setUnderlined (ModelAdvisor.Text)

Italicize text

Retain spacing and returns in text

Specify table row title

Specify table row title alignment

Specify subscripted text
Specify superscripted text
Specify list type

Underline text
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Class Reference

® “Model Coverage” on page 2-2

® “Model Advisor Customization API” on page 2-3

¢ “Model Advisor Result Template API” on page 2-4
e “Model Advisor Formatting API” on page 2-5



2 Class Reference

Model Coverage

cv.cvdatagroup Collection of cvdata objects

cv.cvtestgroup Collection of cvtest objects



Model Advisor Customization API

Model Advisor Customization API

ModelAdvisor.Action Add actions to custom checks
ModelAdvisor.Check Create custom checks
ModelAdvisor.FactoryGroup Define subfolder in By Task folder
ModelAdvisor.Group Define custom folder
ModelAdvisor.InputParameter Add input parameters to custom
checks
ModelAdvisor.ListViewParameter Add list view parameters to custom
checks
ModelAdvisor.Procedure Define custom procedures
ModelAdvisor.Root Identify root node
ModelAdvisor.Task Define custom tasks

2-3



2 Class Reference

Model Advisor Result Template API

ModelAdvisor.FormatTemplate Template for formatting Model
Advisor analysis results
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Model Advisor Formatting API

Model Advisor Formatting API

ModelAdvisor.Image Include image in Model Advisor
output

ModelAdvisor.LineBreak Insert line break

ModelAdvisor.List Create list class

ModelAdvisor.Paragraph Create and format paragraph

ModelAdvisor.Table Create table

ModelAdvisor.Text Create Model Advisor text output

2-5
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cv.cvtestgroup.add

Purpose
Syntax

Description

Examples

3-2

Add cvtest objects
add(cvtg, cvtol, cvto2, ...)

add(cvtg, cvtol, cvto2, ...) adds the cvtest objects specified
by the strings cvto1, cvto2, ete. to cvtg, which is an instantiation of
the cv.cvtestgroup class.

Create two cvtest objects and add them to a newly created
cv.cvtestgroup object:

cvtol = cvtest;

cvto2 = cvtest;

cvtg = cv.cvtestgroup;
add(cvtg, cvtol, cvto2);



ModelAdvisor.FactoryGroup.addCheck
|

Purpose Add check to folder
Syntax addCheck (fg_obj, check_ID)
Description addCheck (fg_obj, check ID) adds checks, identified by check_ID,

to the folder specified by fg_obj, which is an instantiation of the
ModelAdvisor.FactoryGroup class.

Examples Add three checks to rec:

% --- sample factory group

]

rec = ModelAdvisor.FactoryGroup('com.mathworks.sample.factorygroup');

addCheck(rec, 'com.mathworks.sample.Checkl');
addCheck(rec, 'com.mathworks.sample.Check2');
addCheck(rec, 'com.mathworks.sample.Check3');

3-3



ModelAdvisor.Group.addGroup
|

Purpose Add subfolder to folder
Syntax addGroup (group_obj, child_obj)
Description addGroup(group_obj, child obj) adds a new subfolder, identified

by child_obj, to the folder specified by group_obj, which is an
instantiation of the ModelAdvisor.Group class.

Examples Add three checks to rec:

group_obj = ModelAdvisor.Group('com.mathworks.sample.group');

addGroup(group_obj, 'com.mathworks.sample.subgroupi');
addGroup(group_obj, 'com.mathworks.sample.subgroup2');
addGroup(group_obj, 'com.mathworks.sample.subgroup3');



ModelAdyvisor.List.addltem

Purpose
Syntax

Description

Input
Arguments

Examples

How To

Add item to list
addItem(element)

addItem(element) adds items to the list created by the
ModelAdvisor.List constructor.

element Specifies an element to be added to a list in
one of the following:

¢ Element

e Cell array of elements. When you add a cell
array to a list, they form different rows in
the list.

® String

subList = ModelAdvisor.List();

setType(subList, 'numbered')

addItem(subList, ModelAdvisor.Text('Sub entry 1', {'pass','bold'}));
addItem(subList, ModelAdvisor.Text('Sub entry 2', {'pass', 'bold'}));

“Customizing the Model Advisor”
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ModelAdvisor.Paragraph.additem

Purpose
Syntax

Description

Examples

How To

Add item to paragraph
addItem(text, element)

addItem(text, element) adds an element to text. element is one
of the following:

® String
¢ Element

e Cell array of elements

Add two lines of text:

result = ModelAdvisor.Paragraph;
addItem(result, [resultText1 ModelAdvisor.LineBreak resultText2]);

+ “Customizing the Model Advisor”



ModelAdvisor.Group.addProcedure
|

Purpose Add procedure to folder
Syntax addProcedure(group_obj, procedure_obj)
Descripl‘ion addProcedure(group_obj, procedure_obj) adds a procedure,

specified by procedure_obj, to the folder group_obj. group_obj is an
instantiation of the ModelAdvisor.Group class.

Examples Add three procedures to MAG.
MAG = ModelAdvisor.Group('com.mathworks.sample.GroupSample');
MAP1=ModelAdvisor.Procedure('com.mathworks.sample.procedurel');
MAP2=ModelAdvisor.Procedure('com.mathworks.sample.procedure2');
MAP3=ModelAdvisor.Procedure('com.mathworks.sample.procedure3');
addProcedure (MAG, MAP1);

addProcedure (MAG, MAP2);
addProcedure (MAG, MAP3);

3-7



ModelAdyvisor.Procedure.addProcedure

3-8

Purpose
Syntax

Description

Examples

Add subprocedure to procedure
addProcedure(procedurei_obj, procedure2_obj)

addProcedure(procedurel_obj, procedure2 obj) adds a procedure,
specified by procedure2_obj, to the procedure procedurei_obj.
procedure2_obj and procedurel_obj are instantiations of the
ModelAdvisor.Procedure class.

Add three procedures to MAP.

MAP = ModelAdvisor.Procedure('com.mathworks.sample.ProcedureSample');

MAP1=ModelAdvisor.Procedure('com.mathworks.sample.procedurel');
MAP2=ModelAdvisor.Procedure('com.mathworks.sample.procedure2');
MAP3=ModelAdvisor.Procedure('com.mathworks.sample.procedure3');

addProcedure (MAP, MAP1);
addProcedure (MAP, MAP2);
addProcedure (MAP, MAP3);



ModelAdvisor.FormatTemplate.addRow

Purpose
Syntax

Description

Examples

How To

Add row to table
addRow(ft_obj, {item1, item2, ..., itemn})

addRow(ft_obj, {item1, item2, ..., itemn}) is an optional
method that adds a row to the end of a table in the result. ft_obj is
a handle to the template object previously created. {item?, item2,

., itemn} is a cell array of strings and objects to add to the table.
The order of the items in the array determines which column the item
is in. If you do not add data to the table, the Model Advisor does not
display the table in the result.

Note Before adding rows to a table, you must specify column titles
using the setColTitle method.

Find all of the blocks in the model and create a table of the blocks:

% Create FormatTemplate object, specify table format
ft = ModelAdvisor.FormatTemplate('TableTemplate');

% Add information to the table
setTableTitle(ft, {'Blocks in Model'});
setColTitles(ft, {'Index', 'Block Name'});
% Find all the blocks in the system and add them to a table.
allBlocks = find_system(system);
for inx = 2 : length(allBlocks)
% Add information to the table
addRow(ft, {inx-1,allBlocks(inx)});
end

“Customizing the Model Advisor”
“Formatting Model Advisor Results”
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ModelAdvisor.Group.addTask
|

Purpose Add task to folder
Syntax addTask (group_obj, task _obj)
Descripl‘ion addTask(group_obj, task _obj) adds a task, specified by task_obj,

to the folder group_obj.group_obj is an instantiation of the
ModelAdvisor.Group class.

Examples Add three tasks to MAG.

MAG = ModelAdvisor.Group('com.mathworks.sample.GroupSample');
addTask (MAG, MAT1);
addTask (MAG, MAT2);
addTask (MAG, MAT3);

3-10



ModelAdvisor.Procedure.addTask
|

Purpose Add task to procedure
Syntax addTask(procedure_obj, task_obj)
Descripl‘ion addTask (procedure_obj, task _obj) adds a task, specified by

task_obj, to procedure_obj.procedure_obj is an instantiation of the
ModelAdvisor.Procedure class.

Examples Add three tasks to MAP.
MAP = ModelAdvisor.Procedure('com.mathworks.sample.ProcedureSample');
MAT1=ModelAdvisor.Task('com.mathworks.sample.task1');
MAT2=ModelAdvisor.Task('com.mathworks.sample.task2');
MAT3=ModelAdvisor.Task('com.mathworks.sample.task3');
addTask (MAP, MAT1);

addTask (MAP, MAT2);
addTask (MAP, MAT3);

3-11



cv.cvdatagroup.allNames

3-12

Purpose

Syntax

Description

Examples

Get names of all models associated with cvdata objects in
cv.cvdatagroup

models allNames (cvdg)

models = allNames(cvdg) returns a cell array of strings identifying
all model names associated with the cvdata objects in cvdg, an
instantiation of the cv.cvdatagroup class.

Add three cvdata objects to cvdg and return a cell array of model names:

a = cvdata;
b = cvdata;
c = cvdata;

cvdg = cv.cvdatagroup;
add (cvdg, a, b, c);
model_names = allNames(cvdg)



cv.cvtestgroup.allNames

Purpose

Syntax

Description

Examples

Get names of all models associated with cvtest objects in
cv.cvtestgroup

models = allNames(cvtg)

models = allNames(cvtg) returns a cell array of strings identifying
all model names associated with the cvtest objects in cvtg, an
instantiation of the cv.cvtestgroup class.

Add three cvtest objects to cvtg and return a cell array of model names:

d = cvtest;
e = cvtest;
f = cvtes;

cvtg = cv.cvtestgroup;
add (cvtg, d, e, f);
model_names = allNames(cvtg)

3-13



complexityinfo
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Purpose
Syntax

Description

Input
Arguments

Cyclomatic complexity coverage information
complexity = complexityinfo(cvdo, object)

complexity = complexityinfo(cvdo, object) returns complexity
coverage results from the cvdata object cvdo for the model component
object.

cvdo
cvdata object

object

The object argument specifies an object in the model or
Stateflow® chart that received decision coverage. Valid values for
object include the following:

Object Specification Description

BlockPath Full path to a model or block
BlockHandle Handle to a model or block
s10bj Handle to a Simulink API object
sfID Stateflow ID

sTObj Handle to a Stateflow API

object from a singly instantiated
Stateflow chart

{BlockPath, sfID} Cell array with the path to a
Stateflow chart or atomic subchart
and the ID of an object contained
in that chart or subchart
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Output
Arguments

Examples

Object Specification
{BlockPath, sfObj}

[BlockHandle, sfID]

complexity

Description

Cell array with the path to a
Stateflow chart or subchart and

a Stateflow object API handle
contained in that chart or subchart

Array with a handle to a Stateflow
chart or atomic subchart and the
ID of an object contained in that
chart or subchart

If cvdo does not contain cyclomatic complexity coverage results
for object, complexity is empty.

If cvdo contains cyclomatic complexity coverage results for
object, complexity is a two-element vector of the form
[total_complexity local_complexity]:

total_complexity

Cyclomatic complexity coverage for
object and its descendants (if any)

local_complexity

Cyclomatic complexity coverage for
object

If object has variable-size signals, complexity also contains the

variable complexity.

Open the sldemo_fuelsys model and create the test specification
object testObj. Enable decision, condition, and MCDC coverage
for sldemo_fuelsys and execute testObj using cvsim. Use
complexityinfo to retrieve cyclomatic complexity results for the
Throttle subsystem. The Throttle subsystem itself does not record
cyclomatic complexity coverage results, but the contents of the
subsystem do record cyclomatic complexity coverage.
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mdl = 'sldemo_fuelsys';
open_system(mdl) ;

testObj = cvtest(mdl)
testObj.settings.decision = 1;
testObj.settings.condition = 1;
testObj.settings.mcdc = 1;

data = cvsim(testObj);
blk_handle = get_param([mdl,

'/Engine Gas Dynamics/Throttle & Manifold/Throttle'],...

'Handle');
coverage = complexityinfo(data, blk_handle);
coverage

Alternatives To collect and display cyclomatic complexity coverage results in the
coverage report:

1 Open the model.
2 In the Model Editor, select Tools > Coverage Settings.

3 On the Coverage tab, under Coverage Metrics, select:
® Decision
¢ Condition

e MCDC
4 On the Reporting tab, click HTML Settings.

5 On the HTML Settings dialog box, select:
¢ Include cyclomatic complexity numbers in summary

¢ Include cyclomatic complexity numbers in block details

6 Click OK to close the HTML Settings dialog box and save your
changes.
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7 Click OK to close the Coverage Settings dialog box and save your
changes.

8 Simulate the model and review the results in the HTML report.

See Also conditioninfo | decisioninfo | cvsim | getCoverageInfo |
mcdcinfo | sigrangeinfo | sigsizeinfo | tableinfo

How To + “Cyclomatic Complexity”
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Purpose

Syntax

Description

Input
Arguments

3-18

Collect condition coverage information for model object

coverage = conditioninfo(cvdo, object)
coverage conditioninfo(cvdo, object, ignore_descendants)
[coverage, description] = conditioninfo(cvdo, object)

coverage = conditioninfo(cvdo, object) returns condition
coverage results from the cvdata object cvdo for the model component
specified by object.

coverage = conditioninfo(cvdo, object, ignore_descendants)
returns condition coverage results for object, depending on the value
of ignore_descendants.

[coverage, description] = conditioninfo(cvdo, object) returns
condition coverage results and textual descriptions of each condition
in object.

cvdo
cvdata object
ignore_descendants

Logical value that specifies whether to ignore the coverage of
descendant objects

1 to ignore coverage of descendant objects
0 (default) to collect coverage of descendant objects

object

An object in the Simulink model or Stateflow diagram that
receives decision coverage. Valid values for object are as follows:

BlockPath Full path to a Simulink model
or block

BlockHandle Handle to a Simulink model or
block
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s10bj

sfID
sfObj

{BlockPath, sfID}

{BlockPath, sfObj}

[BlockHandle, sfID]

Output coverage
Arguments

Handle to a Simulink API
object

Stateflow ID

Handle to a Stateflow API
object

Cell array with the path to

a Stateflow chart or atomic
subchart and the ID of an
object contained in that chart
or subchart

Cell array with the path to

a Stateflow chart or atomic
subchart and a Stateflow
object API handle contained in
that chart or subchart

Array with a handle to a
Stateflow chart or atomic
subchart and the ID of an
object contained in that chart
or subchart

The value of coverage is a two-element vector of form

[covered outcomes total outcomes]. coverage is empty if
cvdo does not contain condition coverage results for object. The

two elements are:

covered_outcomes

total_outcomes

description

Number of condition outcomes
satisfied for object

Total number of condition
outcomes for object
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A structure array with the following fields:

text String describing a condition
or the block port to which it
applies

trueCnts Number of times the condition
was true in a simulation

falseCnts Number of times the condition

was false in a simulation

Examples The following example opens the slvnvdemo_cv_small controller
demo model, creates the test specification object testObj, enables
condition coverage for test0Obj, and executes testObj. Then retrieve
the condition coverage results for the Logic block (in the Gain
subsystem) and determine its percentage of condition outcomes covered:

mdl = 'slvnvdemo_cv_small_controller';

open_system(mdl)

testObj = cvtest(mdl)

testObj.settings.condition = 1;

data = cvsim(testObj)

blk_handle = get_param([mdl, '/Gain/Logic'], 'Handle');
cov = conditioninfo(data, blk_handle)

percent_cov = 100 * cov(1) / cov(2)

Alternatives To collect condition coverage for a model using the GUI:
1 Open the model for which you want condition coverage.
2 In the Model Editor, select Tools > Coverage Settings.

3 On the Coverage tab, under Coverage Metrics, select Condition
Coverage.

4 View the Results and Report tab to specify the type of output you
need.
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5 Click OK.

6 Simulate the model.

complexityinfo | cvsim | decisioninfo | getCoveragelInfo |

See Also
mcdcinfo | sigrangeinfo | sigsizeinfo | tableinfo

How To + “Condition Coverage (CC)”
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Purpose

Description

Construction

Methods

Properties

Copy
Semantics

Collection of cvdata objects

Instances of this class contain a collection of cvdata objects. For more
information, see “Extracting Results from cv.cvdatagroup”.

cv.cvdatagroup Create collection of cvdata objects
for model reference hierarchy

allNames Get names of all models
associated with cvdata objects in
cv.cvdatagroup

get Get cvdata object
getAll Get all cvdata objects
name cv.cvdatagroup object name

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB® Programming Fundamentals documentation.
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Purpose
Syntax

Description

Examples

Create collection of cvdata objects for model reference hierarchy

cvdg = cv.cvdatagroup(cvdol, cvdo2,...)

cvdg cv.cvdatagroup(cvdol, cvdo2,...) creates an instantiation
of the cv.cvdatagroup class (cvdg) that contains the cvdata objects
cvdo1, cvdo2, etc. A cvdata object contains results of the simulation
runs.

Create an instantiation of the cv.cvdatagroup class and add two
cvdata objects to it:

a cvdata;
b = cvdata;
cvdg = cv.cvdatagroup(a, b);
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Purpose Collection of cvtest objects

Description Instances of this class contain a collection of cvtest objects. For more
information, see “Creating a Test Group with cv.cvtestgroup”.

Construction cv.cvtestgroup Create collection of cvtest objects
for model reference hierarchy

Methods add Add cvtest objects

allNames Get names of all models
associated with cvtest objects in
cv.cvtestgroup

get Get cvtest objects
Properties name cv.cvtestgroup object name
Copy Handle. To learn how this affects your use of the class, see Copying
Semantics Objects in the MATLAB Programming Fundamentals documentation.

3-24



cv.cvtestgroup

Purpose
Syntax

Description

Examples

See Also

Create collection of cvtest objects for model reference hierarchy

cvtg = cv.cvtestgroup(cvtol, cvto2,...)

cvtg = cv.cvtestgroup(cvtol, cvto2,...) creates an instantiation
of the cv.cvtestgroup class (cvtg) that contains the cvtest objects
cvtol, cvto2, etc. A cvtest object is a test specification object for a
Simulink model.

Create an instantiation of the cv.cvtestgroup class and add two
cvtest objects to it:

a cvtest;
b = cvtest;
cvtg = cv.cvtestgroup(a, b);

cvtest
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Purpose Exit model coverage environment
Syntax cvexit
Description cvexit exits the model coverage environment. Issuing this command

closes the Coverage Display window and removes coloring from a block
diagram that displays its model coverage results.
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Purpose

Syntax

Description

Input
Arguments

Produce HTML report from model coverage objects

cvhtml(file, cvdo)

cvhtml(file, cvdol, cvdo2, ...)
cvhtml(file, cvdoi1, cvdo2, ..., options)
cvhtml(file, cvdol1, cvdo2, ..., options, detail)

cvhtml(file, cvdo) creates an HTML report of the coverage results
in the cvdata or cv.cvdatagroup object cvdo when you run model
coverage in simulation. cvhtml saves the coverage results in file. The
model must be open when you use cvhtml to generate its coverage
report.

cvhtml(file, cvdol, cvdo2, ...) creates a combined report
of several cvdata objects. The results from each object appear in
a separate column of the HTML report. Each cvdata object must
correspond to the same root model or subsystem. Otherwise, the
function fails.

cvhtml(file, cvdol, cvdo2, ..., options) creates a combined
report of several cvdata objects using the report options specified by
options.

cvhtml(file, cvdol, cvdo2, ..., options, detail) creates a
combined coverage report for several cvdata objects and specifies the
detail level of the report with the value of detail.
cvdo

A cv.cvdatagroup object
detail

Specifies the level of detail in the report. Set detail to an integer
from 0 to 3. Greater numbers for detail indicate greater detail.

Default: 2

file
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String specifying the HTML file in the MATLAB current folder
where cvhtml stores the results

Default: []

options

Specify the report options that you specify in options:

¢ To enable an option, set it to 1 (e.g., ' -hTR=1").
e To disable an option, set it to 0 (e.g., ' -bRG=0").

® To specify multiple report options, list individual options in
a single options string separated by commas or spaces (e.g.,
'-hTR=1 -bRG=0 -scm=0").

The following table lists all the options:

Option Description Default

-aTs Include each test in the model on
summary

-bRG Produce bar graphs in the model on
summary

-bTC Use two color bar graphs (red, blue) off

-hTR Display hit/count ratio in the model off
summary

-nFC Do not report fully covered model off
objects

-scm Include cyclomatic complexity on

numbers in summary

-bcm Include cyclomatic complexity on
numbers in block details

-XEv Filter Stateflow events from report off
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Examples Make sure you have write access to the default MATLAB folder. Create
a cumulative coverage report for the slvnvdemo_cv_small controller
mode and save it as ratelim_coverage.html:

model = 'slvnvdemo_cv_small_controller';
open_system(model);

cvt = cvtest(model);

cvd cvsim(cvt);

outfile = 'ratelim_coverage.html';
cvhtml(outfile, cvd);

Alternatives To create an HTML model coverage report:

1 Open the model for which you want model coverage.
2 In the Model Editor, select Tools > Coverage Settings.

3 On the Report tab of the Coverage Settings dialog box, select
Generate HTML report.

4 Click OK.
See Also cv.cvdatagroup | cvmodelview | cvsim
How To + “Creating HTML Reports with cvhtml”
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Purpose

Syntax

Description

Examples

See Also

How To

Load coverage tests and stored results into memory

[cvtos, cvdos] = cvload(filename)
[cvtos, cvdos] cvload(filename, restoretotal)

[cvtos, cvdos] cvload(filename) loads the tests and data stored
in the text file filename.cvt. cvtos is a cell array of cvtest objects
that are successfully loaded. cvdos is a cell array of cvdata objects
that are successfully loaded. cvdos has the same size as cvtos, but if a
particular test has no results, cvdos can contain empty elements.

[cvtos, cvdos] = cvload(filename, restoretotal) restores or
clears the cumulative results from prior runs, depending on the value of
restoretotal. If restoretotal is 1, cvload restores the cumulative
results from prior runs. If restoretotal is unspecified or 0, cvload
clears the model’s cumulative results.

The following are special considerations for using the cvload command:
e If a model with the same name exists in the coverage database, the

software loads only the compatible results that reference the existing
model to prevent duplication.

e [f the Simulink models referenced from the file are open but do not
exist in the coverage database, the coverage tool resolves the links to
the existing models.

¢ When you are loading several files that reference the same model,
the software loads only the results that are consistent with the
earlier files.

Store coverage results in cvtest and cvdata objects:

[test_objects, data_objects] = cvload(test_results, 1);

cvsave

* “Loading Stored Coverage Test Results with cvload”
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Purpose
Syntax

Description

Examples

Alternatives

See Also

How To

Display model coverage results with model coloring
cvmodelview(cvdo)

cvmodelview(cvdo) displays coverage results from the cvdata object
cvdo by coloring the objects in the model that have model coverage
results.

Open the slvnvdemo _cv_small controller demo model, create the
test specification object testObj, and execute testObj to collect model
coverage. Run cvmodelview to color the model objects for which you
collect model coverage information:

mdl = 'slvnvdemo_cv_small_controller';
open_system(mdl)
testObj = cvtest(mdl)

data = cvsim(testObj)
cvmodelview(data)

To display model coverage results by coloring objects:

1 Open the model.
2 Select Tools > Coverage Settings.
3 On the Coverage tab, select Coverage for this model.

4 On the Results tab, select Display coverage results using model
coloring.

5 Click OK to close the Coverage Settings dialog box.

6 Simulate the model.
cvhtml | cvsim

+ “Enabling Coverage Highlighting”
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+ “Examples: Model Coverage Coloring”
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Purpose

Syntax

Description

Examples

Alternatives

Save coverage tests and results to file

cvsave(filename, model)
cvsave(filename, cvtol, cvto2, ...)
cvsave(filename, cvdol, cvdo2, ...)

cvsave(filename, model) saves all the tests (cvtest objects) and
results (cvdata objects) related to model in the text file filename.cvt.
model is a handle to or name of a Simulink model.

cvsave(filename, cvtol, cvto2, ...) saves multiple cvtest
objects in the text file filename.cvt. cvsave also saves information
about any referenced models.

cvsave(filename, cvdol, cvdo2, ...) saves the tests and test
results for multiple cvdata objects to the text file filename.cvt.
cvsave also saves information about any referenced models.

Save coverage results for the slvnvdemo_cv_small_controller model
in ratelim_testdata.cvt:

model = 'slvnvdemo_cv_small_controller';
open_system(model);

cvt = cvtest(model);

cvd cvsim(cvt);
cvsave('ratelim_testdata', model);

To save cumulative coverage results:

1 In the Model Editor, select Tools > Coverage Settings.

2 On the Results tab:
a Select Save cumulative results in workspace variable.

b Select Save last run in workspace variable.

3 Click OK to close the Coverage Settings dialog box.
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4 Simulate the model.
See Also cvload

How To + “Saving Test Runs to a File with cvsave”
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Purpose

Syntax

Description

Input
Arguments

Simulate and return model coverage results for test objects

cvdo = cvsim(cvto)

[cvdo,t,x,y] = cvsim(cvto)

[cvdo,t,x,y] = cvsim(cvto, timespan, options)
[cvdo,t,x,y] = cvsim(cvto, label, setupcmd)
[cvdol, cvdo2, ...] = cvsim(cvtol, cvto2, ...)

cvdo = cvsim(cvto) simulates the cvtest object cvto by starting a
simulation run for the corresponding model. The software returns the
results in the cvdata object cvdo. However, when recording coverage
for multiple models in a hierarchy, cvsim returns its results in a
cv.cvdatagroup object.

[cvdo,t,Xx,y] = cvsim(cvto) returns the time vector t, matrix of
state values x, and matrix of output values y from the simulation.

[cvdo,t,x,y] = cvsim(cvto, timespan, options) returns the time
vector t, matrix of state values x, and matrix of output values y from
the simulation, and overrides default simulation values with the values
for timespan and options.

[cvdo,t,x,y] = cvsim(cvto, label, setupcmd) creates the cvtest
object cvto and simulates it in one command. The arguments label
and setupcmd are passed directly to the cvtest function, which creates
the cvtest object cvto.

[cvdo1, cvdo2, ...] = cvsim(cvtol, cvto2, ...) executes the
cvtest objects cvtol, cvto2, ... and returns the results in the set of
cvdata objects cvdo1, cvdo2,

You do not have to enable model coverage reporting for the model to
use the cvsim command

cvto
cvtest object

label
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Label for test object (passed to cvtest)
Default: []

options
Optional simulation parameters specified as a structure.
setupcmd

Setup command used to create test object (passed to cvtest)
Default: []

timespan

Simulation start and stop time:

tFinal To specify the stop time. The
start time is 0.

[tStart tFinal] To specify the start and stop
times.

[tStart OutputTimes To specify the start and stop

tFinal] times and time points to be

returned in t.

Generally, t includes

more time points.
OutputTimes is equivalent
to specifying Configuration
Parameters > Data
Import/Export > Output
options > Produce
specified output only.

Output cvdo

Arguments cvdata object
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t
The simulation’s time vector

X
The simulation’s state matrix consisting of continuous states
followed by discrete states

y
The simulation’s output matrix. Each column contains the output
of a root-level Outport block, in port number order. If any Outport
block has a vector input, its output takes the appropriate number
of columns.

Examples Simulate the slvnvdemo_cv_small_controller model, get the test

data, and simulate the model with that test data. cvsim returns the
time vector, matrix of state values, and matrix of output values:

model = 'slvnvdemo_cv_small_controller';

open_system(model);

testObj = cvtest(model); %Get test data

[data, T, X, Y] = cvsim(testObj); %Get coverage data
See Also cv.cvdatagroup | cvtest

How To + “Creating and Running Test Cases”
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Purpose

Syntax

Description

Input
Arguments

Simulate and return model coverage results for referenced models

cvdg = cvsimref (topModelName)
cvdg cvsimref (topModelName, cvtg)
[cvdg,t,x,y] = cvsimref (topModelName, cvtg)
[cvdg,t,x,y] = cvsimref (topModelName, cvtg, timespan,
options)
[cvdgl, cvdg2, ...] = cvsimref(topModelName, cvtgl, cvtg2,
.)

cvdg = cvsimref (topModelName) simulates the top model and all
referenced models in the hierarchy, collects model coverage data, and
returns the results in the cv.cvdatagroup object cvdg. You do not have
to enable model coverage reporting for any of the models in a model
hierarchy to use the cvsimref command.

cvdg = cvsimref (topModelName, cvtg) simulates topModelName and
collects model coverage data by executing the cv.cvtestgroup object
cvtg. cvtg contains cvtest specifications for the top-level model and
all the referenced models in the hierarchy. cvsimref returns the model
coverage results in cvdg.

[cvdg,t,x,y] = cvsimref (topModelName, cvtg) returns the time
vector t, matrix of state values x, and matrix of output values y from
the simulation.

[cvdg,t,x,y] = cvsimref(topModelName, cvtg, timespan,
options) overrides default simulation values with the values in
timespan and options

[cvdgl, cvdg2, ...] = cvsimref(topModelName, cvtgl, cvtg2,
.) executes multiple cv.cvtestgroup objects and returns the results
in a set of cv.cvdatagroup objects.

cvtg

cv.cvtestgroup object that contains test specifications for the
referenced models in the hierarchy
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options

Optional simulation parameters specified as a structure.

timespan

Simulation start and stop time:

tFinal

[tStart tFinal]

[tStart OutputTimes

tFinal]

topModelName

Specify the stop time. The
start time 1s 0.

Specify the start and stop
times.

Specify that cvsimref return
the start and stop times and
time points in t. Generally,
t includes more time points.
OutputTimes is equivalent to
specifying Configuration
Parameters > Data
Import/Export > Output
options > Produce
specified output only.

Name of the top-level model in the hierarchy

The simulation time vector

Output cvdg
Arguments

t

X

cv.cvdatagroup object

The simulation state matrix consisting of continuous states

followed by discrete states
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Examples

See Also

How To

The simulation output matrix. Each column contains the output
of a root-level Outport block, in port number order. If any Outport
block has a vector input, its output takes the appropriate number
of columns.

Open and simulate the slvnvdemo_ratelim_harness model and its
two subsystems:

topModel = 'slvnvdemo_cv_mutual_exclusion';
load_system(topModel);

% Make sure coverage is off for this run for the entire tree

set_param(topModel, 'RecordCoverage', 'off');
set_param(topModel, 'CovModelRefEnable', '0Off');

simObj = sim(topModel); % Normal data
allData = cvsimref (topModel); % cvsimref data

cv.cvdatagroup | cv.cvtestgroup | cvsim | cvtest

+ “Creating and Running Test Cases”

+ “Using Model Coverage Commands for Referenced Models”



cvtest

Purpose

Syntax

Description

Input
Arguments

Output
Arguments

Create model coverage test specification object

cvto = cvtest(root)

cvto = cvtest(root, label)
cvto = cvtest(root, label, setupcmd)
cvto = cvtest(root) creates a test specification object with the handle

cvto. Simulate cvto with the cvsim command

cvto = cvtest(root, label) creates a test object with the label
label, which is used for reporting results.

cvto = cvtest(root, label, setupcmd) creates a test object with
the setup command setupcmd.

label
Label for test object
root

The name of, or a handle to, a Simulink model or a subsystem.
Only the specified model or subsystem and its descendants are
subject to model coverage testing.

setupcmd

Setup command for creating test object. The setup command is
executed in the base MATLAB workspace just prior to running
the simulation. This command is useful for loading data prior to
a test.

cvto

A test specification object with the following structure:

Field Description
id Read-only internal ID
modelcov Read-only internal ID
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Field
rootPath

label
setupCmd

settings.condition
settings.decision

settings.
designverifier

settings.mcdc
settings.sigrange
settings.sigsize
settings.tableExec

modelRefSettings.
enable

modelRefSettings.
excludeTopModel

modelRefSettings.
excludedModels

Description

Name of system or subsystem for
analysis

String used when reporting results

Command executed in base workspace
prior to simulation

Set to 1 for condition coverage.
Set to 1 for decision coverage.

Set to 1 for coverage for Simulink
Design Verifier blocks.

Set to 1 for MC/DC coverage.

Set to 1 for signal range coverage.
Set to 1 for signal size coverage.
Set to 1 for lookup table coverage.

e 'off' — Disable coverage for all
referenced models.

e 'all' or on — Enable coverage for
all referenced models.

e 'filtered' — Enable coverage
only for referenced models not
listed in the excludedModels
subfield.

Set to 1 to exclude coverage for the
top model.

String specifying a comma-
separated list of referenced models for
which coverage is disabled.
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Field Description

emlSettings. Set to 1 to enable coverage for external

enableExternal program files called by MATLAB
functions in your model.

options. Set to 1 to override the Simulink

forceBlockReduction Block reduction parameter if it is
enabled.

Examples Create a cvtest object of the Adjustable Rate Limiter block in the demo

model slvnvdemo_ratelim_harness and display its contents:

open_system('slvnvdemo_ratelim_harness');
testObj1 = cvtest(['slvnvdemo_ratelim_harness',
'/Adjustable Rate Limiter']);
testObji1.label = 'Gain within slew limits';
testObji1.setupCmd = 'load(''within_lim.mat'');"';
testObj1.settings.mcdc = 1;

testObj1
See Also cv.cvtestgroup
How To + “Creating Tests with cvtest”

“Creating a Test Group with cv.cvtestgroup”
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Purpose Display decision coverage information for model object
Syntax coverage = decisioninfo(cvdo, object)
coverage = decisioninfo(cvdo, object, ignore_descendants)

[coverage, description] = decisioninfo(cvdo, object)

Descripl’ion coverage = decisioninfo(cvdo, object) returns decision coverage
results from the cvdata object cvdo for the model component specified
by object.

coverage = decisioninfo(cvdo, object, ignore_descendants)
returns decision coverage results for object, depending on the value
of ignore_descendants.

[coverage, description] = decisioninfo(cvdo, object) returns
decision coverage results and text descriptions of decision points
associated with object.

Input cvdo

Arguments cvdata object
ignore_descendants

Specifies to ignore the coverage of descendant objects if
ignore_descendants is set to 1.

object

The object argument specifies an object in the model or Stateflow
chart that received decision coverage. Valid values for object
include the following:

Object Specification Description

BlockPath Full path to a model or block
BlockHandle Handle to a model or block
s10bj Handle to a Simulink API object
sfID Stateflow ID
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Object Specification
sfOb

{BlockPath, sfID}

{BlockPath, sfObj}

[BlockHandle, sfID]

Output coverage
Arguments

Description

Handle to a Stateflow API
object from a singly instantiated
Stateflow chart

Cell array with the path to a
Stateflow chart or atomic subchart
and the ID of an object contained
in that chart or subchart

Cell array with the path to a
Stateflow chart or subchart and

a Stateflow object API handle
contained in that chart or subchart

Array with a handle to a Stateflow
chart or atomic subchart and the
ID of an object contained in that
chart or subchart

The value of coverage is a two-element vector of the form

[covered outcomes total outcomes].coverage is empty if
cvdo does not contain decision coverage results for object. The

two elements are:

covered_outcomes

total_outcomes

description

Number of decision outcomes
satisfied for object

Number of decision outcomes
for object

description is a structure array containing the following fields:
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Examples

Alternatives

decision.text String describing a decision
point, e.g., 'U > LL'

decision.outcome.text String describing a decision
outcome, i.e., 'true' or
'false'

decision.outcome. Number of times a decision

executionCount outcome occurred in a
simulation

Open the slvnvdemo_cv_small controller model and create the
test specification object testObj. Enable decision coverage for
slvnvdemo_cv_small controller and execute testObj using cvsim.
Use decisioninfo to retrieve the decision coverage results for the
Saturation block and determine the percentage of decision outcomes
covered:

mdl = 'slvnvdemo_cv_small controller';

open_system(mdl)

testObj = cvtest(mdl)

testObj.settings.decision = 1;

data = cvsim(testObj)

blk_handle = get _param([mdl, '/Saturation'], 'Handle');
cov = decisioninfo(data, blk_handle)

percent_cov = 100 * cov(1) / cov(2)

To collect and display decision coverage results:

1 Open the model.
2 In the Model Editor, select Tools > Coverage Settings.
3 On the Coverage tab, under Coverage Metrics, select Decision.

4 Click OK to close the Coverage Settings dialog box and save your
changes.



decisioninfo

5 Simulate the model and review the results.

See Also complexityinfo | conditioninfo | cvsim | getCoverageInfo |
mcdcinfo | sigrangeinfo | sigsizeinfo | tableinfo

How To + “Condition Coverage (CC)”
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cv.cvdatagroup.get

Purpose Get cvdata object
Syntax get(cvdg, model name)
Description get(cvdg, model name) returns the cvdata object in the

cv.cvdatagroup object cvdg that corresponds to the model specified
in model name.

Examples Get a cvdata object from the specified Simulink model:

get(cvdg, 'slvnvdemo_cv_small _controller');
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Purpose
Syntax

Description

Examples

See Also

Get cvtest objects
get(cvtg, model_name)

get(cvtg, model name) returns the cvtest object in the
cv.cvtestgroup object cvtg that corresponds to the model specified
in model name.

Get a cvtest object from the specified Simulink model:

get(cvtg, 'slvnvdemo_cv_small _controller');

cvsimref | cvtest
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cv.cvdatagroup.getAll

Purpose Get all cvdata objects

Syntax getAll(cvdo)

Description getAll(cvdo) returns all cvdata objects in the cv.cvdatagroup object
cvdo.

Examples Return all cvdata object from the specified Simulink model:

getAll(cvdg, 'slvnvdemo_cv_small controller');
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Purpose

Syntax

Description

Input
Arguments

Coverage information for Simulink Design Verifier blocks

[coverage, description] = getCoveragelnfo(cvdo, object)

[coverage, description] getCoverageInfo(cvdo, object,
metric)

[coverage, description] = getCoverageInfo(cvdo, object,
metric, ignore_descendants)

[coverage, description] = getCoverageInfo(cvdo, object)
collects Simulink Design Verifier coverage for object, based on
coverage results in cvdo. object can be a handle to any block,
subsystem, or Stateflow chart. getCoverageData returns coverage data
only for Simulink Design Verifier library blocks in object’s hierarchy.

[coverage, description] = getCoverageInfo(cvdo, object,
metric) returns coverage data for the block type specified in metric.
If object does not match the block type, getCoverageInfo does not
return any data.

[coverage, description] = getCoverageInfo(cvdo, object,
metric, ignore_descendants) returns coverage data about object,
omitting coverage data for its descendant objects if ignore_descendants
equals 1.

cvdo
cvdata object
object

In the model or Stateflow chart, object that received Simulink
Design Verifier coverage. The following are valid values for

object.
BlockPath Full path to a model or block
BlockHandle Handle to a model or block
s10bj Handle to a Simulink API object
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sfID

sfobj

{BlockPath, sfID}

{BlockPath, sfObj}

[BlockHandle, sfID]

metric

Stateflow ID from a singly
instantiated Stateflow chart

Handle to a Stateflow API
object from a singly instantiated
Stateflow chart

Cell array with the path to a
Stateflow chart or atomic subchart
and the ID of an object contained
in that chart or subchart

Cell array with the path to a
Stateflow chart or atomic subchart
and a Stateflow object API handle
contained in that chart or subchart

Array with a handle to a Stateflow
chart or atomic subchart and the
ID of an object contained in that
chart or subchart

cvmetric.Sldv enumeration object with values that correspond
to Simulink Design Verifier library blocks.

test
proof
condition

assumption

ignore_descendants

Test Objective block
Proof Objective block
Test Condition block
Proof Assumption block

Boolean value that specifies to ignore the coverage of descendant

objects if set to 1.
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Output coverage

Arguments Two-element vector of the form [covered outcomes

total outcomes].

covered_outcomes Number of test objectives
satisfied for object

total outcomes Total number of test objectives
for object

coverage is empty if cvdo does not contain decision coverage
results for object.

description

Structure array containing descriptions of each test objective, and
descriptions and execution counts for each outcome within object.

Examples Collect and display coverage data for the Test Objective block named
True in the sldvdemo_debounce_testobjblks model:

mdl = 'sldvdemo_debounce_testobjblks';
open_system(mdl)

testObj = cvtest(mdl)
testObj.settings.designverifier = 1;

data = cvsim(testObj)

blk_handle = get_param([mdl, '/True'], 'Handle');
getCoverageInfo(data, blk_handle)

Alternatives To collect and display coverage results for Simulink Design Verifier
library blocks using the Coverage Settings dialog box:

1 Open the model.
2 In the Model Editor, select Tools > Coverage Settings.

3 On the Coverage tab, under Coverage Metrics, select Simulink
Design Verifier.
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4 Click OK.

5 Simulate the model and review the results.

See Also complexityinfo | conditioninfo | cvsim | decisioninfo | mcdcinfo
| sigrangeinfo | sigsizeinfo | tableinfo

How To + “Simulink Design Verifier Coverage”
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ModelAdvisor.Table.getEntry

Purpose
Syntax

Description

Input
Arguments

Output
Arguments

Examples

How To

Get table cell contents
content = getEntry(table, row, column)

content = getEntry(table, row, column) gets the contents of the
specified cell.

table Instantiation of the ModelAdvisor.Table
class

row An integer specifying the row

column An integer specifying the column

content An element object or object array specifying

the content of the table entry

Get the content of the table cell in the third column, third row:

table1l = ModelAdvisor.Table(4, 4);

content = getEntry(tablet1, 3, 3);

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

How To

Return check identifier
id = getID(check_obj)

id = getID(check_obj) returns the ID of the check check _obj. idis a
unique string that identifies the check.

You create this unique identifier when you create the check. This unique
identifier is the equivalent of the ModelAdvisor.Check ID property.

* “Defining Custom Checks”
+ “Customizing the Model Advisor”



mcdcinfo

Purpose

Syntax

Description

Input
Arguments

Collect modified condition/decision coverage information for model
object

coverage = mcdcinfo(cvdo, object)
coverage = mcdcinfo(cvdo, object, ignore_descendants)
[coverage, description] = mcdcinfo(cvdo, object)

coverage = mcdcinfo(cvdo, object) returns modified
condition/decision coverage (MCDC) results from the cvdata object
cvdo for the model component specified by object.

coverage = mcdcinfo(cvdo, object, ignore_descendants)
returns MCDC results for object, depending on the value of
ignore_descendants.

[coverage, description] = mcdcinfo(cvdo, object) returns
MCDC results and text descriptions of each condition/decision in
object.

cvdo
cvdata object
ignore_descendants

Logical value specifying whether to ignore the coverage of
descendant objects

1 — Ignore coverage of descendant objects
0 — Collect coverage for descendant objects

object

The object argument specifies an object in the Simulink model or
Stateflow diagram that receives decision coverage. Valid values
for object include the following:
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Output
Arguments

Object Specification
BlockPath
BlockHandle

s10bj

sfID

sfobj

{BlockPath, sfID}

{BlockPath, sfObj}

[BlockHandle, sfID]

coverage

Description

Full path to a model or block
Handle to a model or block
Handle to a Simulink API object
Stateflow ID

Handle to a Stateflow API object

Cell array with the path to a
Stateflow chart or atomic subchart
and the ID of an object contained
in that chart or subchart

Cell array with the path to a

Stateflow chart or atomic subchart
and a Stateflow object API handle
contained in that chart or subchart

Array with a handle to a Stateflow
chart or atomic subchart and the
ID of an object contained in that
chart or subchart

Two-element vector of the form [covered_outcomes
total outcomes]. coverage is empty if cvdo does not contain
modified condition/decision coverage results for object. The two

elements are:

covered_outcomes

total_outcomes

description

Number of condition/decision
outcomes satisfied for object

Total number of
condition/decision outcomes
for object
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A structure array containing the following fields:

text String denoting whether
the condition/decision is
associated with a block output
or Stateflow transition

condition.text String describing a
condition/decision or the
block port to which it applies

condition.achieved Logical array indicating
whether a condition case has
been fully covered

condition.trueRslt String representing a condition
case expression that produces
a true result

condition.falseRslt String representing a condition
case expression that produces
a false result

Examples Collect MCDC coverage for the slvnvdemo_cv_small_controller
model and determine the percentage of MCDC coverage collected for the
Logic block in the Gain subsystem:

mdl = 'slvnvdemo_cv_small_controller';
open_system(mdl)

testObj = cvtest(mdl) %Create test specification object
testObj.settings.mcdc = 1; %Enable MCDC coverage

data = cvsim(testObj) %Simulate model

blk_handle = get_param([mdl, '/Gain/Logic'], 'Handle');

cov = mcdcinfo(data, blk_handle) %Retrieve MCDC results for Logic block
percent_cov = 100 * cov(1) / cov(2) %sPercentage of MCDC outcomes covered

Alternatives To collect MCDC coverage for a model:

1 Open the model.
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See Also

How To

3-60

2 In the Model Editor, select Tools > Coverage Settings.

3 On the Coverage tab, under Coverage Metrics, select MCDC
Coverage.

4 On the Results and Report tabs, select the desired options.
5 Click OK to close the Coverage Settings dialog box.

6 Simulate the model and review the MCDC coverage in the report.

complexityinfo | conditioninfo | cvsim | decisioninfo |
getCoverageInfo | sigrangeinfo | sigsizeinfo | tableinfo

+ “Modified Condition/Decision Coverage (MCDC)”
+ “MCDC Analysis”



ModelAdvisor.Action

Purpose Add actions to custom checks

Description Instances of this class define actions you take when the Model Advisor
checks do not pass. Users access actions by clicking the Action button
that you define in the Model Advisor window.

Construction ModelAdvisor.Action Add actions to custom checks
Methods setCallbackFcn Specify action callback function
Properties Description Message in Action box

Name Action button label
Copy Handle. To learn how this affects your use of the class, see Copying
Semantics Objects in the MATLAB Programming Fundamentals documentation.
Examples % define action (fix) operation

myAction = ModelAdvisor.Action;
myAction.Name='Fix block fonts';
myAction.Description=...
'Click the button to update all blocks with specified font';

How To + “Customizing the Model Advisor”
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Purpose
Syntax

Description

Examples

How To

Add actions to custom checks

action_obj = ModelAdvisor.Action

action_obj
object.

ModelAdvisor.Action creates a handle to an action

Note

e Include an action definition in a check definition.

® Each check can contain only one action.

% define action (fix) operation
myAction = ModelAdvisor.Action;

“Customizing the Model Advisor”



ModelAdyvisor.Check

Purpose

Description

Create custom checks

The ModelAdvisor.Check class creates a Model Advisor check object.
All checks must have an associated ModelAdvisor.Task object to be
displayed in the Model Advisor tree.

You can use one ModelAdvisor.Check object in multiple
ModelAdvisor.Task objects, allowing you to place the same check

in multiple locations in the Model Advisor tree. For example,

Check for implicit signal resolution is displayed in the By
Product > Simulink folder and in the By Task > Model Referencing
folder in the Model Advisor tree.

When you use checks in task definitions, the following rules apply:

e If you define the properties of the check in the check definition
and the task definition, the task definition takes precedence. The
Model Advisor displays the information contained in the task
definition. For example, if you define the name of the check in the
task definition using the ModelAdvisor.Task.DisplayName property
and in the check definition using the ModelAdvisor.Check.Title
property, the Model Advisor displays the information provided in
ModelAdvisor.Task.DisplayName.

¢ [f you define the properties of the check in the check definition
but not the task definition, the task uses the properties from the
check. For example, if you define the name of the check in the check
definition using the ModelAdvisor.Check.Title property, and you
register the check using a task definition, the Model Advisor displays
the information provided in ModelAdvisor.Check.Title.

e If you define the properties of the check in the task definition
but not the check definition, the Model Advisor displays the
information correctly as long as you register the task with
the Model Advisor instead of the check. For example, if you
define the name of the check in the task definition using the
ModelAdvisor.Task.DisplayName property instead of the
ModelAdvisor.Check.Title property, and you register the check
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Construction

Methods

Properties

using a task definition, the Model Advisor displays the information

provided in ModelAdvisor.Task.DisplayName.

ModelAdvisor.Check

getID
setAction

setCallbackFen

setInputParameters

setInputParametersLayoutGrid

CallbackContext
CallbackHandle

CallbackStyle
Enable

ID

LicenseName

ListViewVisible
Result
Title

Create custom checks

Return check identifier
Specify action for check

Specify callback function for
check

Specify input parameters for
check

Specify layout grid for input
parameters

Specify when to run check

Callback function handle for
check

Callback function type

Indicate whether user can enable

or disable check

Identifier for check

Product license names required

to display and run check
Status of button
Results cell array

Name of check



ModelAdyvisor.Check

Copy
Semantics

Examples

How To

TitleTips Description of check
Value Status of check
Visible Indicate to display or hide check

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

rec = ModelAdvisor.Check('com.mathworks.sample.Checkl');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Examples

How To

Create custom checks
check_obj = ModelAdvisor.Check(check_ID)

check_obj = ModelAdvisor.Check(check ID) creates a check object,
check_obj, and assigns it a unique identifier, check_ID. check_ID must
remain constant. To display checks in the Model Advisor tree, all checks
must have an associated ModelAdvisor.Task or ModelAdvisor.Root
object.

Note You can use one ModelAdvisor.Check object in multiple
ModelAdvisor.Task objects, allowing you to place the same check in
multiple locations in the Model Advisor tree. For example, Check for
implicit signal resolution appears in the By Product > Simulink
folder and in the By Task > Model Referencing folder in the Model
Advisor tree.

rec = ModelAdvisor.Check('com.mathworks.sample.Checkl');

“Customizing the Model Advisor”



ModelAdvisor.FactoryGroup

Purpose

Description

Construction

Methods

Properties

Copy
Semantics

Examples

How To

Define subfolder in By Task folder

The ModelAdvisor.FactoryGroup class defines a new subfolder to add
to the By Task folder.

ModelAdvisor.FactoryGroup Define subfolder in By Task
folder

addCheck Add check to folder

Description Description of folder

DisplayName Name of folder

ID Identifier for folder

MAODj Model Advisor object

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

% --- sample factory group
rec = ModelAdvisor.FactoryGroup('com.mathworks.sample.factorygroup');

+ “Customizing the Model Advisor”

3-67



ModelAdvisor.FactoryGroup

3-68

Purpose
Syntax

Description

Examples

How To

Define subfolder in By Task folder

fg_obj = ModelAdvisor.FactoryGroup(fg_ID)

fg_obj ModelAdvisor.FactoryGroup(fg_ID) creates a handle to a
factory group object, fg_obj, and assigns it a unique identifier, fg_ID.
fg_ID must remain constant.

% --- sample factory group
rec = ModelAdvisor.FactoryGroup('com.mathworks.sample.factorygroup');

+ “Customizing the Model Advisor”



ModelAdvisor.FormatTemplate

Purpose

Description

Construction

Methods

Template for formatting Model Advisor analysis results

Use the ModelAdvisor.FormatTemplate class to format the result of
a check in the analysis result pane of the Model Advisor for a uniform
look and feel among the checks you create. There are two formats for

the analysis result:

e Table
e List

ModelAdvisor.FormatTemplate

addRow
setCheckText
setColTitles

setInformation

setListObj

setRecAction

setRefLink
setSubBar

setSubResultStatus

setSubResultStatusText

Construct template object
for formatting Model Advisor
analysis results

Add row to table
Add description of check to result
Add column titles to table

Add description of subcheck to
result

Add list of hyperlinks to model
objects

Add Recommended Action section
and text

Add See Also section and links

Add line between subcheck
results

Add status to check or subcheck
result

Add text below status in result
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setSubTitle Add title for subcheck in result

setTablelnfo Add data to table

setTableTitle Add title to table
Copy Handle. To learn how this affects your use of the class, see Copying
Semantics Objects in the MATLAB Programming Fundamentals documentation.
Exumples The following code creates two template objects, ft1 and ft2, and uses

them to format the result of running the check in a table and a list.

The result identifies the blocks in the model. The graphics following
the code display the output as it appears in the Model Advisor when
the check passes and fails.

% Sample Check With Subchecks Callback Function
function ResultDescription = SampleStyleOneCallback(system)
mdladvObj = Simulink.ModelAdvisor.getModelAdvisor(system); % get object

%Initialize variables

ResultDescription={};

ResultStatus = false; % Default check status is 'Warning'
mdladvObj.setCheckResultStatus(ResultStatus);

% Create FormatTemplate object for first subcheck, specify table format
ft1 = ModelAdvisor.FormatTemplate('TableTemplate');

% Add information describing the overall check
setCheckText(ft1, ['Find and report all blocks in the model. '...
' (setCheckText method - Description of what the check reviews)']);

% Add information describing the subcheck
setSubTitle(ft1, 'Table of Blocks (setSubTitle method - Title of the subcheck)');
setInformation(ft1, ['Find and report all blocks in a table. '...

'(setInformation method - Description of what the subcheck reviews)']);

% Add See Also section for references to standards
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setRefLink(ft1, {{'Standard 1 reference (setRefLink method) '},
{'Standard 2 reference (setRefLink method'}});

% Add information to the table
setTableTitle(ft1, {'Blocks in the Model (setTableTitle method)'});
setColTitles(ft1, {'Index (setColTitles method)',

'Block Name (setColTitles method)'});

% Perform the check actions
allBlocks = find_system(system);
if length(find_system(system)) ==
% Add status for subcheck
setSubResultStatus(ft1, 'Warn');
setSubResultStatusText(ft1, ['The model does not contain blocks. '...
' (setSubResultStatusText method - Description of result status)']);
setRecAction(ft1, {'Add blocks to the model. '...
' (setRecAction method - Description of how to fix the problem)'});
ResultStatus = false;
else
% Add status for subcheck
setSubResultStatus(ft1, 'Pass');
setSubResultStatusText(ft1, ['The model contains blocks. '...
' (setSubResultStatusText method - Description of result status)']);
for inx = 2 : length(allBlocks)
% Add information to the table
addRow(ft1, {inx-1,allBlocks(inx)});
end
ResultStatus = true;
end

% Pass table template object for subcheck to Model Advisor
ResultDescription{end+1} = ft1;

% Create FormatTemplate object for second subcheck, specify list format
ft2 = ModelAdvisor.FormatTemplate('ListTemplate');

% Add information describing the subcheck
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setSubTitle(ft2, 'List of Blocks (setSubTitle method - Title of the subcheck)');

setInformation(ft2, ['Find and report all blocks in a list.
'(setInformation method - Description of what the subcheck reviews)']);

% Add See Also section for references to standards
setRefLink (ft2, {{'Standard 1 reference (setRefLink method) '},
{'Standard 2 reference (setRefLink method)'}});

% Last subcheck, supress line
setSubBar (ft2, false);

% Perform the subcheck actions
if length(find_system(system)) ==
% Add status for subcheck
setSubResultStatus(ft2, 'Warn');
setSubResultStatusText(ft2, ['The model does not contain blocks.
' (setSubResultStatusText method - Description of result status)']);
setRecAction(ft2, {'Add blocks to the model. '...
' (setRecAction method - Description of how to fix the problem)'});
ResultStatus = false;

else
% Add status for subcheck
setSubResultStatus(ft2, 'Pass');
setSubResultStatusText(ft2, ['The model contains blocks. '...
' (setSubResultStatusText method - Description of result status)']);
% Add information to the list
setListObj (ft2, allBlocks);
end

% Pass list template object for the subcheck to Model Advisor
ResultDescription{end+1} = ft2;

% Set overall check status
mdladvObj.setCheckResultStatus(ResultStatus);
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The following graphic displays the output as it appears in the Model
Advisor when the check passes.

Result: % Passed

Find and report all blocks in the model, (setCheckText method - Description of what the ched: reviews)

Table of Blocks (setSubTitle method - Title of the subcheck)
Find and report all blocks in a table. {setInformation method - Description of what the subcheck reviews)

See Also

» Standard 1 reference (setReflink method)
* Standard 2 reference (setReflink method

Passed
The model contains blocks, (setSubResultStatusText method - Description of result status)

Blocks in the Model (setTableTite method)

[Index (setColTitles method) | Block Name (setColTitles method)
|1 IH‘-:urmat template test/Constant

|2 I}ﬁ:urmat template test/Constantl

B format template test/Gain

|4 IH‘-:urmat template test/Product

5 format template test/Outl

List of Blocks (setSubTitle method - Title of the subcheck)
Find and report all blocks in a list, (setinformation method - Description of what the subchecdk reviews)

See Also

* Standard 1 reference (setReflink method)
» Standard 2 reference (setRefLink method)

Passed
The model contains blocks, (setSubResultStatusText method - Description of result status)

* format_template test

* format_template testiConstant
» format_template testiConstanti
+ format template test/Gain

+ format_template test/Product

* format_template testiOutil

3-73



ModelAdvisor.FormatTemplate

The following graphic displays the output as it appears in the Model
Advisor when the check fails.

Result: /% Warning

Find and report all blocks in the model. (setChedkText method - Description of what the check reviews)

Table of Blocks (setSubTitle method - Title of the subcheck)
Find and report all blocks in a table. (setinformation method - Description of what the subched: reviews)
See Also

« Standard 1 reference (setRefLink method)
» Standard 2 reference (setReflink method

The model does not contain blocks. (setSubResultStatusText method - Description of result status)

Recommended Action
Add blocks to the model,

(setRecAction method - Description of how to fix the problem)

List of Blocks (setSubTitle method - Title of the subcheck)
Find and report all blocks in a list. (setInformation method - Description of what the subchedk reviews)

See Also

» Standard 1 reference (setReflink method)
» Standard 2 reference (setReflink method)

The model does not contain blocks, (setSubResultStatusText method - Description of result status)

Recommended Action
Add blodks to the model,

(setRecAction method - Description of how to fix the problem)

Alternatives Use the Model Advisor Formatting API to format check analysis

results. However, MathWorks recommends that you use the
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ModelAdvisor.FormatTemplate class for a uniform look and feel among
the checks you create.

How To + “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Examples

How To

Construct template object for formatting Model Advisor analysis results

obj = ModelAdvisor.FormatTemplate('type')

obj ModelAdvisor.FormatTemplate('type') creates a handle, obj,
to an object of the ModelAdvisor.FormatTemplate class. type is a
string identifying the format type of the template, either list or table.
Valid values are ListTemplate and TableTemplate.

You must return the result object to the Model Advisor to display the
formatted result in the analysis result pane.

Note Use the ModelAdvisor.FormatTemplate class in check callbacks.

Create a template object, ft, and use it to create a list template:

ft = ModelAdvisor.FormatTemplate('ListTemplate');

“Customizing the Model Advisor”
“Formatting Model Advisor Results”



ModelAdvisor.Group

Purpose Define custom folder
Description The ModelAdvisor.Group class defines a folder that is displayed in the
Model Advisor tree. Use folders to consolidate checks by functionality
or usage.
Construction ModelAdvisor.Group Define custom folder
Methods addGroup Add subfolder to folder
addProcedure Add procedure to folder
addTask Add task to folder
Properties Description Description of folder
DisplayName Name of folder
ID Identifier for folder
MAODj Model Advisor object
Copy Handle. To learn how this affects your use of the class, see Copying
Semantics Objects in the MATLAB Programming Fundamentals documentation.
How To + “Customizing the Model Advisor”
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Purpose
Syntax

Description

Examples

How To

Define custom folder
group_obj = ModelAdvisor.Group(group_ID)

group_obj = ModelAdvisor.Group(group_ ID) creates a handle to a
group object, group_obj, and assigns it a unique identifier, group_ID.
group_ID must remain constant.

MAG = ModelAdvisor.Group('com.mathworks.sample.GroupSample');

+ “Customizing the Model Advisor”



ModelAdvisor.Image

Purpose

Description

Construction

Methods

Copy
Semantics

How To

Include image in Model Advisor output

The ModelAdvisor.Image class adds an image to the Model Advisor
output.

ModelAdvisor.Image Include image in Model Advisor
output

setHyperlink Specify hyperlink location

setImageSource Specify image location

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Examples

How To

Include image in Model Advisor output
object = ModelAdvisor.Image

object = ModelAdvisor.Image creates a handle to an image object,
object, that the Model Advisor displays in the output. The Model
Advisor supports many image formats, including, but not limited to,
JPEG, BMP, and GIF.

image_obj = ModelAdvisor.Image;

+ “Customizing the Model Advisor”
* “Formatting Model Advisor Results”



ModelAdvisor.InputParameter

Purpose Add input parameters to custom checks

Description Instances of the ModelAdvisor. InputParameter class specify the input
parameters a custom check uses in analyzing the model. Access input
parameters in the Model Advisor window.

Construction ModelAdvisor.InputParameter Add input parameters to custom

checks
Methods setColSpan Specify number of columns for
input parameter
setRowSpan Specify rows for input parameter
Properhes Description Description of input parameter
Entries Drop-down list entries
Name Input parameter name
Type Input parameter type
Value Value of input parameter
Copy Handle. To learn how this affects your use of the class, see Copying
Semantics Objects in the MATLAB Programming Fundamentals documentation.
How To + “Customizing the Model Advisor”
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Purpose Add input parameters to custom checks
Syntax input_param = ModelAdvisor.InputParameter
Description input_param = ModelAdvisor.InputParameter creates a handle to an

input parameter object, input_param.

Note You must include input parameter definitions in a check
definition.

Examples
Note The following example is a fragment of code from the
sl _customization.m file for the demo model, slvnvdemo_mdladv. The
example does not execute as shown without the additional content
found in the s1_customization.m file.
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How To

rec = ModelAdvisor.Check('com.mathworks.sample.Check1');

rec.setInputParametersLayoutGrid([3 2]);

% define input parameters

inputParami
inputParami
inputParami
inputParami
inputParami
inputParami
inputParami
inputParam2

inputParam2.
inputParam2.
inputParam2.
inputParam2.
inputParam2.
inputParam2.

inputParam3

inputParam3.
inputParam3.
inputParam3.
inputParam3.
inputParam3.
inputParam3.
rec.setInputParameters({inputParami,inputParam2,inputParam3});

= ModelAdvisor.InputParameter;

.Name = 'Skip font checks.';
.Type = 'Bool';

.Value = false;

.Description = 'sample tooltip';
.setRowSpan([1 1]);
.setColSpan([1 1]);

= ModelAdvisor.InputParameter;
Name = 'Standard font size';
Value='12";

Type='String';
Description='sample tooltip';
setRowSpan([2 2]);
setColSpan([1 1]1);

= ModelAdvisor.InputParameter;
Name='Valid font';
Type="'Combobox " ;
Description='sample tooltip';

Entries={'Arial', 'Arial Black'};

setRowSpan([2 2]);
setColSpan([2 2]);

“Customizing the Model Advisor”
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Purpose

Description

Construction

Copy
Semantics

How To

Insert line break

Use instances of the ModelAdvisor.LineBreak class to insert line
breaks in the Model Advisor outputs.

ModelAdvisor.LineBreak Insert line break

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Examples

How To

Insert line break
ModelAdvisor.LineBreak

ModelAdvisor.LineBreak inserts a line break into the Model Advisor
output.

Add a line break between two lines of text:

result = ModelAdvisor.Paragraph;
addItem(result, [resultText1l ModelAdvisor.LineBreak resultText2]);

+ “Customizing the Model Advisor”
* “Formatting Model Advisor Results”
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Purpose

Description

Construction

Methods

Copy
Semantics

How To

Create list class

Use instances of the ModelAdvisor.List class to create list-formatted
outputs.

ModelAdvisor.List Create list class
addItem Add item to list
setType Specify list type

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax
Description

Examples

How To

Create list class

list ModelAdvisor.List

ModelAdvisor.List creates a list object, 1ist.

list

subList = ModelAdvisor.List();

setType(subList, 'numbered')

addItem(subList, ModelAdvisor.Text('Sub entry 1', {'pass','bold'}));
addItem(subList, ModelAdvisor.Text('Sub entry 2', {'pass', 'bold'}));

“Customizing the Model Advisor”
“Formatting Model Advisor Results”
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Purpose

Description

Construction

Properties

Copy
Semantics

Examples

Add list view parameters to custom checks

The Model Advisor uses list view parameters to populate the Model
Advisor Result Explorer. Access the information in list views by clicking
Explore Result in the Model Advisor window.

ModelAdvisor.ListViewParameter Add list view parameters to
custom checks

Attributes Attributes to display in Model
Advisor Report Explorer

Data Objects in Model Advisor Result
Explorer

Name Drop-down list entry

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

Note The following example is a fragment of code from the
sl_customization.m file for the demo model, slvnvdemo_mdladv. The
example does not execute as shown without the additional content
found in the s1_customization.m file.

mdladvObj = Simulink.ModelAdvisor.getModelAdvisor(system);
mdladvObj.setCheckResultStatus(true);

% define list view parameters

myLVParam = ModelAdvisor.ListViewParameter;

myLVParam.Name = 'Invalid font blocks'; % the name appeared at pull down filter
myLVParam.Data = get_param(searchResult, 'object')"';



ModelAdyvisor.ListViewParameter

myLVParam.Attributes = {'FontName'}; % name is default property
mdladvObj.setListViewParameters ({myLVParam});

How To + “Customizing the Model Advisor”
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Purpose Add list view parameters to custom checks
Syntax lv_param = ModelAdvisor.ListViewParameter
Description lv_param = ModelAdvisor.ListViewParameter defines a list view,

lv_param.

Note Include list view parameter definitions in a check definition.

How To * “Defining Model Advisor Result Explorer Views”
+ “Customizing the Model Advisor”
+ “Batch-Fixing Warnings or Failures”
* “Demo and Code Example”
+ “getListViewParameters”

+ “setListViewParameters”

3-90



ModelAdvisor.lookupCheckID

Purpose
Syntax

Description

Input
Arguments

Output
Arguments

Examples

Alternatives
See Also

How To

Look up Model Advisor check ID
NewID = ModelAdvisor.lookupCheckID('0OldCheckID"')

NewID = ModelAdvisor.lookupCheckID('0ldCheckID') returns the
check ID of the check specified by 01dCheckID. 01dCheckID is the ID of
a check prior to R2010b.

01dCheckID
01dCheckID is the ID of a check prior to R2010b.

NewID

Check ID that corresponds to the previous check ID identified
by 01dCheckID.

Look up the check ID for By Product > Simulink Verification and
Validation > Modeling Standards > DO-178B Checks > Check

safety-related optimization settings using the previous ID
D0178B:0OptionSet:

NewID = ModelAdvisor.lookupCheckID('DO178B:0OptionSet');

“Finding Check IDs”
ModelAdvisor.run

* “Finding Check IDs”
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Purpose

Description

Construction

Methods

Copy
Semantics

Examples

How To

Create and format paragraph

The ModelAdvisor.Paragraph class creates and formats a paragraph
object.

ModelAdvisor.Paragraph Create and format paragraph
addItem Add item to paragraph
setAlign Specify paragraph alignment

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

% Check Simulation optimization setting
ResultDescription{end+1} = ModelAdvisor.Paragraph(['Check Simulation '...
'optimization settings:']);

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Examples

How To

Create and format paragraph

para_obj = ModelAdvisor.Paragraph

para_obj = ModelAdvisor.Paragraph defines a paragraph object
para_obj.

% Check Simulation optimization setting

ResultDescription{end+1} = ModelAdvisor.Paragraph(['Check Simulation '

'optimization settings:']);

“Customizing the Model Advisor”
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Purpose

Description

Construction

Properties

Define custom procedures

The ModelAdvisor.Procedure class defines a procedure that is
displayed in the Model Advisor tree. Use procedures to organize
additional procedures or checks by functionality or usage.

ModelAdvisor.Procedure Define custom procedures

Description

Provides information about the procedure. Details about the
procedure are displayed in the right pane of the Model Advisor.

Default: ' ' (null string)
Name
Specifies the name of the procedure that is displayed in the Model
Advisor.
Default: ' ' (null string)
ID

Specifies a permanent, unique identifier for the procedure.

Note

® You must specify this field.

The value of ID must remain constant.

The Model Advisor generates an error if ID is not unique.

¢ Procedure definitions must refer to other procedures by ID.




ModelAdvisor.Procedure

Methods

Copy
Semantics

How To

MAOQD j
Specifies a handle to the current Model Advisor object.

addProcedure Add subprocedure to procedure

addTask Add task to procedure

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Examples

How To

Define custom procedures
procedure_obj = ModelAdvisor.Procedure(procedure_ID)

procedure_obj = ModelAdvisor.Procedure(procedure_ID) creates a
handle to a procedure object, procedure_obj, and assigns it a unique
identifier, procedure_ID. procedure_ID must remain constant.

MAP = ModelAdvisor.Procedure('com.mathworks.sample.ProcedureSample');

“Customizing the Model Advisor”



ModelAdvisor.Root

Purpose

Description

Construction

Methods

Copy
Semantics

How To

Identify root node

The ModelAdvisor.Root class returns the root object.

ModelAdvisor.Root Identify root node

publish Publish object in Model Advisor
root

register Register object in Model Advisor
root

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Examples

How To

Identify root node

root_obj = ModelAdvisor.Root

root_obj
root_obj.

ModelAdvisor.Root creates a handle to the root object,

mdladvRoot = ModelAdvisor.Root;

+ “Customizing the Model Advisor”
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Purpose

Syntax

Description

Tips

Input
Arguments

Run Model Advisor checks on systems

SysResultObjArray =

ModelAdvisor.run(SysList,CheckIDList,Name,
Value)

SysResultObjArray =

ModelAdvisor.run(SysList, 'Configuration',
FileName,Name,Value)

SysResultObjArray =
ModelAdvisor.run(SysList,CheckIDList,Name,Value) runs the
Model Advisor on the systems provided by SysList with additional
options specified by one or more optional Name,Value pair arguments.
CheckIDList contains cell array of check IDs to run.

SysResultObjArray =

ModelAdvisor.run(SysList, 'Configuration',FileName,Name,Value)
runs the Model Advisor on the systems provided by SysList.

The list of checks to run is specified using a Model Advisor
configuration file, specified by FileName.

¢ [f you have a Parallel Computing Toolbox™ license and a multicore
machine, you can run the Model Advisor on multiple systems in
parallel. Start a MATLAB pool using the matlabpool function.

SysList
Cell array of systems to run.
CheckIDList

Cell array of check IDs to run. For details on how to find check
IDs, see “Finding Check IDs”.

CheckIDList optionally can include input parameters

for specific checks using the following syntax;

{'CheckID', 'InputParam',{'IP',"'IPV'}}, where IP is

the input parameter name and IPV is the corresponding input
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parameter value. You can specify several input parameter name
and value pair arguments in any order as IP1,IPV1, ;IPN,IPVN.

FileName

Name of the Model Advisor configuration file. For details on
creating a configuration file, see “Organizing Checks and Folders
Using the Model Advisor Configuration Editor”.

Name-Value Pair Arguments

Optional comma-separated pairs of Name,Value arguments, where Name
1s the argument name and Value is the corresponding value. Name must
appear inside single quotes (' '). You can specify several name-value
pair arguments in any order as Name1,Valuel, ,NameN,ValueN.

Force

Setting Force to 'On' removes existing modeladvisor/system
folders. Setting Force to 'Off' prompts you before removing
existing modeladvisor/system folders.

Default: 'Off'

TempDir

Setting TempDir to 'On' runs the Model Advisor from a temporary
working folder, to avoid concurrency issues when running using

a MATLAB pool. For more information, see “Resolving Data
Concurrency Issues”. Setting TempDir to 'Off' runs the Model
Advisor in the current working folder.

Default: 'Off'

DisplayResults

Setting DisplayResults to 'Summary' displays a summary of the
system results in the Command Window. Setting DisplayResults
to 'Details' displays the following in the Command Window:
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Output
Arguments

Examples

¢ Which system the Model Advisor is checking while the run is
in progress.

¢ For each system, the pass and fail results of each check.

® A summary of the system results.

Setting DisplayResults to 'None' displays no information in
the Command Window.

Default: 'Summary'

SysResultObjArray

Cell array of ModelAdvisor.SystemResult objects, one for each
model specified in SysList. Each ModelAdvisor.SystemResult
object contains an array of CheckResultObj objects. Save
SysResultObjArray to review results at a later time without
having to rerun the Model Advisor (see “Saving and Loading
Objects”).

CheckResultObj

Array of ModelAdvisor.CheckResult objects, one for each check
that runs.

Runs the Model Advisor checks Check model diagnostic
parameters and Check for fully defined interface on
the sldemo_auto_climatecontrol/Heater Control and
sldemo_auto_climatecontrol/AC Control subsystems:

% Create list of checks and models to run.

CheckIDList = {'StyleGuide: jc_0021','IEC61508:RootLevelInports'};

SysList={'sldemo_auto_climatecontrol/Heater Control',...
'sldemo_auto_climatecontrol/AC Control'};

% Run the Model Advisor.
SysResultObjArray = ModelAdvisor.run(SysList,CheckIDList);
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Runs the Model Advisor configuration file
slvnvdemo_mdladv_config.mat on the
sldemo_auto_climatecontrol/Heater Control and
sldemo_auto_climatecontrol/AC Control subsystems:

% Identify Model Advisor configuration file.

% Create list of models to run.

fileName = 'slvnvdemo mdladv_config.mat';

SysList={'sldemo_auto_climatecontrol/Heater Control',...
'sldemo_auto_climatecontrol/AC Control'};

% Run the Model Advisor.
SysResultObjArray = ModelAdvisor.run(SysList, 'Configuration',fileName);

Alternatives e Use the Model Advisor GUI to run each system, one at a time.
¢ Create a script or function using the Simulink.ModelAdvisor class
to run each system, one at a time.
See Also ModelAdvisor.summaryReport | view | viewReport |
ModelAdvisor.lookupCheckID
Tutorials + “Workflow for Checking Systems Programmatically”
“Checking Multiple Systems in Parallel”
How To * “Checking Systems Programmatically”

* “Finding Check IDs”

* “Organizing Checks and Folders Using the Model Advisor
Configuration Editor”

+ “Saving and Loading Objects”
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Purpose
Syntax

Description

Input
Arguments

Examples

Alternatives

See Also

Tutorials

Open Model Advisor Command-Line Summary report
ModelAdvisor.summaryReport(SysResultObjArray)

ModelAdvisor.summaryReport (SysResultObjArray) opens the
Model Advisor Command-Line Summary report in a web browser.
SysResultObjArray is a cell array of ModelAdvisor.SystemResult
objects returned by ModelAdvisor.run.

SysResultObjArray

Cell array of ModelAdvisor.SystemResult objects returned by
ModelAdvisor.run.

Opens the Model Advisor Command-Line Summary report after
running the Model Advisor:

% Identify Model Advisor configuration file.

% Create list of models to run.

fileName = 'slvnvdemo_mdladv_config.mat';

SysList={'sldemo_auto_climatecontrol/Heater Control',...
'sldemo_auto_climatecontrol/AC Control'};

% Run the Model Advisor.
SysResultObjArray = ModelAdvisor.run(SysList, 'Configuration',fileName);

% Open the Model Advisor Command-Line Summary report.
ModelAdvisor.summaryReport (SysResultObjArray)

“Viewing Results in the Model Advisor Command-Line Summary
Report”

ModelAdvisor.run | view | viewReport

“Workflow for Checking Systems Programmatically”
“Checking Multiple Systems in Parallel”
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How To * “Checking Systems Programmatically”

+ “Archiving and Viewing Results”
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Purpose

Description

Construction

Methods

Copy
Semantics

How To

Create table

Instances of the ModelAdvisor.Table class create and format a table.
Specify the number of rows and columns in a table, excluding the table
title and table heading row.

ModelAdvisor.Table Create table

getEntry Get table cell contents
setColHeading Specify table column title
setColHeadingAlign Specify column title alignment
setColWidth Specify column widths
setEntries Set contents of table

setEntry Add cell to table
setEntryAlign Specify table cell alignment
setHeading Specify table title
setHeadingAlign Specify table title alignment
setRowHeading Specify table row title
setRowHeadingAlign Specify table row title alignment

Handle. To learn how this affects your use of the class, see Copying
Objects in the MATLAB Programming Fundamentals documentation.

+ “Customizing the Model Advisor”
* “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Examples

How To

3-106

Create table

table = ModelAdvisor.Table(row, column)

table = ModelAdvisor.Table(row, column) creates a table object
(table). The Model Advisor displays the table object containing the
specified number of rows (row) and columns (column).

In the following example, you create two table objects, table1 and
table2. The Model Advisor displays table1 in the results as a table
with 1 row and 1 column. The Model Advisor display table2 in the
results as a table with 2 rows and 3 columns.

tableil
table2

ModelAdvisor.Table(1,1);
ModelAdvisor.Table(2,3);

+ “Customizing the Model Advisor”
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Purpose

Description

Construction

Methods

Properties

Define custom tasks

The ModelAdvisor.Task class is a wrapper for a check so that you can
access the check with the Model Advisor.

You can use one ModelAdvisor.Check object in multiple
ModelAdvisor.Task objects, allowing you to place the same check

in multiple locations in the Model Advisor tree. For example,

Check for implicit signal resolution is displayed in the By
Product > Simulink folder and in the By Task > Model Referencing
folder in the Model Advisor tree.

When adding checks as tasks, the Model Advisor uses the task
properties instead of the check properties, except for Visible and
LicenseName.

ModelAdvisor.Task Define custom tasks

setCheck Specify check used in task

Description Description of task

DisplayName Name of task

Enable Indicate if user can enable and
disable task

1D Identifier for task

LicenseName Product license names required
to display and run task

MAODbj Model Advisor object

Value Status of task

Visible Indicate to display or hide task
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|

Copy Handle. To learn how this affects your use of the class, see Copying
Semantics Objects in the MATLAB Programming Fundamentals documentation.
Examples MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');

MAT2 = ModelAdvisor.Task('com.mathworks.sample.TaskSample2');
MAT3 = ModelAdvisor.Task('com.mathworks.sample.TaskSample3');
How To + “Authoring Custom Checks”
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Purpose
Syntax

Description

Examples

How To

Define custom tasks

task_obj = ModelAdvisor.Task(task_ID)

task_obj ModelAdvisor.Task(task _ID) creates a task object,
task_obj, with a unique identifier, task_ID. task_ID must remain
constant. If you do not specify task_ID, the Model Advisor assigns a
random task_ID to the task object.

You can use one ModelAdvisor.Check object in multiple
ModelAdvisor.Task objects, allowing you to place the same check in
multiple locations in the Model Advisor tree. For example, Check for
implicit signal resolution appears in the By Product > Simulink
folder and in the By Task > Model Referencing folder in the Model
Advisor tree.

When adding checks as tasks, the Model Advisor uses the task
properties instead of the check properties, except for Visible and
LicenseName.

In the following example, you create three task objects, MAT1, MAT2,
and MATS3.

MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');
MAT2 = ModelAdvisor.Task('com.mathworks.sample.TaskSample2');
MAT3 = ModelAdvisor.Task('com.mathworks.sample.TaskSample3');

“Customizing the Model Advisor”
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Purpose Create Model Advisor text output

Description Instances of ModelAdvisor.Text class create formatted text for the
Model Advisor output.

Construction ModelAdvisor.Text Create Model Advisor text output
Methods setBold Specify bold text
setColor Specify text color
setHyperlink Specify hyperlinked text
setltalic ITtalicize text
setRetainSpaceReturn Retain spacing and returns in
text
setSubscript Specify subscripted text
setSuperscript Specify superscripted text
setUnderlined Underline text
Copy Handle. To learn how this affects your use of the class, see Copying
Semantics Objects in the MATLAB Programming Fundamentals documentation.
Examples t1 = ModelAdvisor.Text('This is some text');
How To + “Customizing the Model Advisor”

* “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Input
Arguments

Create Model Advisor text output

text

ModelAdvisor.Text(content, {attribute})

text = ModelAdvisor.Text(content, {attribute}) creates a text
object for the Model Advisor output.

content

attribute

Optional string specifying the content of the
text object. If content is empty, empty text
is output.

Optional cell array of strings specifying the
formatting of the content. If no attribute is

specified, the output text has default coloring

with no formatting. Possible formatting
options include:

¢ normal (default) — Text is default color
and style.

® bold — Text is bold.

e italic — Text is italicized.

¢ underline — Text is underlined.

e pass — Text is green.

e warn — Text is yellow.

e fail — Text is red.

e keyword — Text is blue.

e subscript — Text is subscripted.

e superscript — Text is superscripted.
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OUtPUt text The text object you create

Arguments

Examples text = ModelAdvisor.Text('Sub entry 1', {'pass', 'bold'})
How To + “Customizing the Model Advisor”

+ “Formatting Model Advisor Results”

3-112



ModelAdvisor.Root.publish

Purpose

Syntax

Description

Examples

How To

Publish object in Model Advisor root

publish(root_obj, check_obj, location)
publish(root_obj, group_obj)
publish(root_obj, procedure_obj)
publish(root_obj, fg_obj)

publish(root_obj, check obj, location) specifies where the Model
Advisor places the check in the Model Advisor tree. location is either
one of the subfolders in the By Product folder, or the name of a new
subfolder to put in the By Product folder. Use a pipe-delimited string
to indicate multiple subfolders. For example, to add a check to the
Simulink Verification and Validation > Modeling Standards
folder, use the following string: 'Simulink Verification and
Validation|Modeling Standards'.

publish(root_obj, group_obj) specifies the ModelAdvisor.Group
object to publish as a folder in the Model Advisor Task Manager
folder.

publish(root_obj, procedure_obj) specifies the
ModelAdvisor.Procedure object to publish.

publish(root_obj, fg obj) specifies the
ModelAdvisor.FactoryGroup object to publish as a subfolder in the
By Task folder.

% publish check into By Product > Demo group.
mdladvRoot.publish(rec, 'Demo');

+ “Defining Where Custom Checks Appear”
+ “Defining Where Tasks Appear”
+ “Defining Where Custom Folders Appear”
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Purpose
Syntax

Description

Examples

3-114

Register object in Model Advisor root

register (MAobj, obj)

register(MAobj, obj) registers the object, obj, in the root object
MAobj.

In the Model Advisor memory, the register method registers the
following types of objects:

ModelAdvisor.Check
ModelAdvisor.FactoryGroup
ModelAdvisor.Group
ModelAdvisor.Procedure

ModelAdvisor.Task

The register method places objects in the Model Advisor memory that
you use in other functions. The register method does not place objects
in the Model Advisor tree.

mdladvRoot = ModelAdvisor.Root;

MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');
MAT1.DisplayName='Example task with input parameter and auto-fix ability';
MAT1.setCheck('com.mathworks.sample.Check1');

mdladvRoot.register (MAT1);

MAT2 = ModelAdvisor.Task('com.mathworks.sample.TaskSample2');
MAT2.DisplayName='Example task 2';
MAT2.setCheck('com.mathworks.sample.Check2');
mdladvRoot.register (MAT2);

MAT3 = ModelAdvisor.Task('com.mathworks.sample.TaskSample3');
MAT3.DisplayName='Example task 3';
MAT3.setCheck('com.mathworks.sample.Check3');
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mdladvRoot.register (MAT3)
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Purpose

Syntax

Description
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Interact programmatically with Requirements Management Interface

rmi setup

number_problems = rmi('checkdoc', reqtsDocName)
rmi('doorssync', object)

reqglinks = rmi('createempty')

reqlinks = rmi('get', object)

reqglinks = rmi('get', object, group)
rmi('report', object)

rmi('set', object, reqlinks)

rmi('set', object, reqlinks, group)
rmi('cat', object, reqlinks)

cnt = rmi('count', object)

rmi('clearall', object)

rmi('clearAll', object, 'deep')

rmi register linktypename

rmi unregister linktypename

rmi linktypelist

cmdstr = rmi('navCmd', object)

[cmdstr, titlestr] = rmi('navCmd', object)
guidstr = rmi('guidget', object)

object = rmi('guidlookup', model, guidstr)
rmi('highlightModel', object)
rmi(‘'unhighlightModel', object)
rmi('view', object, index)

dialog = rmi('edit', object)
rmi('copyObj', object)

rmi setup configures RMI for use with your MATLAB software and
installs the interface for use with the Telelogic® DOORS® software, if
needed.

number_problems = rmi('checkdoc', reqtsDocName) validates
links in a Microsoft® Word or IBM® Rational® DOORS® requirements
document to Simulink models. rmi returns the total count of detected
problems in number_problems and generates an HTML report.
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rmi('doorssync', object) opens the DOORS synchronization
settings dialog box, where you can customize the synchronization
settings and synchronize your model with an open project in an IBM
Rational DOORS database. See rmi.doorssync for information about
synchronizing your model with DOORS at the MATLAB command line.

reqlinks = rmi('createempty') creates an empty instance of the
requirement links data structure.

reqlinks = rmi('get', object) returns the requirement links data
structure for object. object is the name or handle of a Simulink or
Stateflow object with which requirements can be associated.

reqlinks = rmi('get', object, group) returns the requirement
links data structure for the Signal Builder group specified by the index
group. In this case, object is the name or handle of a Signal Builder
block whose signal groups are associated with requirements.

rmi('report', object) creates an HTML report that describes the
requirements in object.

rmi('set', object, reqlinks) sets the requirement links data
structure reqlinks to object.

rmi('set', object, reqlinks, group) sets the requirement links
data structure reqlinks to the Signal Builder group specified by
the index group. In this case, object is the name or handle of a
Signal Builder block whose signal groups you want to associate with
requirements.

rmi('cat', object, reqlinks) appends the requirement links data
structure reqlinks to the end of the existing structure associated with
object. If no structure exists, RMI sets reqlinks to object.

cnt = rmi('count', object) returns the number of requirement
links associated with object.

rmi('clearall', object) removes the requirement links data
structure associated with object, deleting its requirements.

rmi('clearAll', object, 'deep') deletes all requirements links
in the model containing object.
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Input
Arguments
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rmi register linktypename registers the custom link type specified
by the function linktypename.

rmi unregister linktypename removes the custom link type specified
by the function linktypename.

rmi linktypelist displays a list of the currently registered link types.
The list indicates whether each link type is built-in or custom, and
provides the path to the function used for its registration.

cmdstr = rmi('navCmd', object) returns the MATLAB command
string used to navigate to object.

[cmdstr, titlestr] = rmi('navCmd', object) returns the
MATLAB command string cmdstr and the title string titlestr that
provides descriptive text for object.

guidstr = rmi('guidget', object) returns the globally unique
identifier for object. A globally unique identifier is created for object
if 1t lacks one.

object = rmi('guidlookup', model, guidstr) returns the object
name in model that has the globally unique identifier guidstr.

rmi('highlightModel', object) highlights all of the objects in the
parent model of object that have requirement links.

rmi('unhighlightModel', object) removes highlighting of objects in
the parent model of object that have requirement links.

rmi('view', object, index) accesses the requirement numbered
index in the requirements document associated with object. index is
an integer that represents the nth requirement linked to object.

dialog = rmi('edit', object) displays the Requirements dialog box
for object and returns the handle of the dialog box.

rmi('copyObj', object) resets the globally unique identifier for
object, preserving its requirement links.
group

Signal Builder group index
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guidstr
Globally unique model identifier
index
Integer that represents the nth requirement linked to object
model
Name or handle of a Simulink model
object

Name or handle of a Simulink or Stateflow object with which
requirements can be associated.

regqlinks
Requirement links are represented using a MATLAB structure
array with the following fields:
doc String identifying requirements document

id String defining location in requirements
document. The first character specifies the
identifier type:

First Identifier Example
Character
? Search text, the '?Requirement

first occurrence of 1'
which 1s located

in requirements
document

@ Named item, such '@my_req'
as bookmark in
a Microsoft Word
file or an anchor
in an HTML file
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Output
Arguments
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# Page or item "#21'
number

> Line number '>3156"

$ Worksheet range  '$A2:C5'

in a spreadsheet

linked Boolean value specifying whether the
requirement link is accessible for report
generation and highlighting:

1 (default). Highlight model object and include
requirement link in reports.

0
description String describing the requirement
keywords Optional string supplementing description
reqsys String identifying the link type registration

name; 'other' for built-in link types

reqtsbDocName

Path name to a Microsoft Word or IBM Rational DOORS
requirements document or a DOORS module ID

cmdstr
MATLAB command string
cnt
Number of requirement links associated with object
dialog
Handle for object
guidstr

Globally unique model identifier
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Examples

number_problems

Integer representing the number of invalid links in a requirements
document

object

Name or handle of a Simulink or Stateflow object with which
requirements can be associated.

regqlinks

Requirement links are represented using a MATLAB structure
array. See “Input Arguments” on page 3-118 for details.

titlestr

Descriptive text for object

Get a requirement associated with a block in the
slvnvdemo_fuelsys htmreq model, change its description,
and save the requirement back to that block:

slvnvdemo_fuelsys_htmreq;

blk_with_req = ['slvnvdemo_fuelsys_htmreq/fuel rate' 10 'controller/...
Airflow calculation'];

reqts = rmi('get', blk_with_req);

reqts.description = 'Mass airflow estimation';

rmi('set', blk_with_req, reqts);

rmi('get', blk_with_req);

Add a new requirement to the block in the previous example:

new_req = rmi('createempty’');

new_req.doc = 'fuelsys_requirements2.htm';
new_req.description = 'A new requirement';
rmi('cat',blk_with_req, new_req);
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Create an HTML requirements report for the
slvnvdemo_fuelsys htmreq model:

rmi('report', 'slvnvdemo_fuelsys_htmreq');
See Also rmi.objinfo | rmi.doorssync | rmidocrename | rmiobjnavigate |
rmitag
How To + “Linking to Requirements with the Requirements Management

Interface (RMI)”
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Purpose

Syntax

Description

Examples

Alternatives

Update model requirements document paths and file names

rmidocrename (model_handle, old_path, new_path)
rmidocrename (model_name, old_path, new_path)

rmidocrename (model handle, old path, new_path) collectively
updates the links from a Simulink model to requirements files whose
names or locations have changed. model_handle is a handle to the
model that contains links to the files that you have moved or renamed.
old_path is a string that contains the existing full or partial file or
path name. new_path is a string with the new full or partial file or
path name.

rmidocrename (model name, old path, new_path) updates the
links to requirements files associated with model name. You can pass
rmidocrename a model handle or a model file name.

When using the rmidocrename function, make sure to enter specific
strings for the old document name fragments so that you do not
inadvertently modify other links.

For the current Simulink model, update all links to requirements
files that contain the string 'project 0220', replacing them with
‘project_0221"':

rmidocrename(gcs, '00000220', '00000221')
Processed 6 objects with requirements, 5 out of 13 links were modified.

To update the requirements links one at a time, for each model object
that has a link:

1 For each object with requirements, open the Requirements dialog box
by right-clicking and selecting Requirements > Edit/Add Links.

2 Edit the Document field for each requirement that points to a
moved or renamed document.

3 Click Apply to save the changes.
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See Also rmi
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rmi.doorssync

Purpose

Syntax

Description

Synchronize model with DOORS surrogate module

rmi.doorssync(model_name)

rmi.doorssync(model_name, settings)

current_settings = rmi.doorssync(model_name, 'settings')
current_settings = rmi.doorssync(model_name, [])
default_settings rmi.doorssync([])

rmi.doorssync(model name) opens the DOORS synchronization
settings dialog box. Select the options for synchronizing model name
with an IBM Rational DOORS surrogate module and click
Synchronize.

Synchronizing a Simulink model with a DOORS surrogate module is
a user-initiated process that creates or updates a surrogate module in
a DOORS database. A surrogate module is a DOORS formal module
that is a representation of a Simulink model hierarchy. When you
synchronize a model for the first time, the DOORS software creates a
surrogate module. Depending on your synchronization settings, the
surrogate module contains a representation of the model.

rmi.doorssync(model name, settings) synchronizes model name
with a DOORS surrogate module using the options that settings
specifies.

current_settings = rmi.doorssync(model_name, 'settings')
returns the current settings for model_name, but does not synchronize
the model with the DOORS surrogate module.

current_settings = rmi.doorssync(model name, []) performs
synchronization with current settings known for model_name. If the
RMI has not synchronized the model previously, rmi.doorssync uses
the default settings.

default settings = rmi.doorssync([]) returns a settings object
with the default values.
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Input
Arguments

3-126

model name

Name or handle of a Simulink model

settings

Structure with the following fields.

Field

Description

surrogatePath

Path to a DOORS project in the form
' /PROJECT /FOLDER/MODULE '.)

The default, './$ModelName$', resolves
to the given model name under the
current DOORS project.

saveModel

Specifies to save the model after
synchronization.

Default: 1

saveSurrogate

Specifies to save the modified surrogate
module.

Default: 1

slToDoors

Specifies to copy links from Simulink to

DOORS.
Default: 0

doorsToS1

Specifies to copy links from surrogate
module to Simulink.

If both doorsToS1 and s1ToDoors are set
to 1, an error occurs.

Default: 0




rmi.doorssync

Field

Description

purgeSimulink

Specifies to remove unmatched links in
Simulink. (ignored if doorsToS1 is set
to 0).

rmi.doorssync ignores purgeSimulink
if doorsToS1 is set to 0.

Default: 0

purgeDoors

Specifies to remove unmatched links in
DOORS (ignored if s1ToDoors is set to 0).

Default: 0

detaillLevel

Specifies which objects with no links
to DOORS to include in the surrogate
module.

Valid values are 1 through 6. 1 means
include only objects with requirements,
for fast synchronization. 6 means include
all model objects, for complete model
representation in the surrogate. For
complete details about these values, see

Default: 1

The current values of the synchronization settings for the

The default values of the synchronization settings

Output current_settings
Arguments
specified Simulink model
default_settings
Examples Before running this example:

1 Start the DOORS software.
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2 Create a new DOORS project or open an existing DOORS project.

Open the slvnvdemo_fuelsys officereq model, specify to copy the
links from the model to the DOORS surrogate module, and synchronize:

slvnvdemo_fuelsys_officereq;

settings = rmi.doorssync('slvnvdemo_fuelsys_officereq', 'settings');
settings.slToDoors = 1;

setting.purgeDoors = 1;

rmi.doorssync('slvnvdemo_fuelsys_officereq', settings);

Alternatives Synchronize your Simulink model with a DOORS surrogate module:

1 Open the model.
2 Select Tools > Requirements > Synchronize with DOORS.

3 In the DOORS synchronization settings dialog box, select the
synchronization settings that you want.

4 Click Synchronize.

See Also rmi

How To + “Synchronizing a Simulink Model with a DOORS Surrogate Module”
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rmi.objinfo

Purpose
Syntax

Description

Input
Arguments

Output
Arguments

Examples

See Also

Return navigation information for model object
[navCmd, dispString] = rmi.objinfo(obj)

[navCmd, dispString] = rmi.objinfo(obj) returns navigation
information for the Simulink model object obj.

obj
Name or handle of a Simulink or Stateflow object.

navCmd
String that contains the MATLAB command that navigates to the
model object obj. Pass this command to the MATLAB Automation
server to highlight obj.

dispString

String that contains the name and path to the model object obj.

Open the slvnvdemo fuelsys officereq demo model, get the unique
identifier for the MAP Sensor block, and navigate to that block using
the rmiobjnavigate function:

o°

slvnvdemo_fuelsys_officereq; Open demo model
gch = ...
'slvnvdemo_fuelsys_officereq/MAP sensor'; % Make current block

[navCmdString, objPath] = rmi.objinfo(gcb); % Get rmiobjnavigate command

o

s and path

rmi | rmiobjnavigate
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Purpose
Syntax

Description

Input
Arguments

Examples

See Also

3-130

Navigate to model objects using unique Requirements Management
Interface identifiers

rmiobjnavigate(modelPath, gulId)
rmiobjnavigate(modelPath, guId, grpNum)

rmiobjnavigate(modelPath, guld) navigates to and highlights the
specified object in a Simulink model.

rmiobjnavigate(modelPath, guld, grpNum) navigates to the signal
group number grpNum of a Signal Builder block identified by guId in
the model modelPath.

modelPath

A full path to a Simulink model file, or a Simulink model file
name that can be resolved on the MATLAB path.

guld

A unique string that the RMI uses to identify a Simulink or
Stateflow object.
grpNum

Integer indicating a signal group number in a Signal Builder block

Open the slvnvdemo_fuelsys officereq demo model, get the unique
identifier for the MAP Sensor block, and navigate to that block using
the rmiobjnavigate function:

slvnvdemo_fuelsys_officereq; % Open demo model
gcb = ...
'slvnvdemo_fuelsys_officereq/MAP sensor'; % Make current block

o°

navCmdString = rmi.objinfo(gchb); Get rmoobjnavigate command

°

s with model name and object ID

o°

eval(navCmdString); Execute rmiobjnavigate command

rmi | rmi.objinfo
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How To + “Using the rmiobjnavigate Function”
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rmiref.insertRefs

Purpose

Syntax

Description

Input
Arguments

Examples

3-132

Insert links to models into requirements documents

[total_links, total_matches,
total_inserted] = rmiref.insertRefs(model_name,
doc_type)

[total_links, total_matches, total_inserted] =
rmiref.insertRefs(model name, doc_type) inserts ActiveX®
controls into the open, active requirements document of type doc_type.
These controls correspond to any links from model_name to the
document. With these controls, you can navigate from the requirements
document to the model.
model name

Name or handle of a Simulink model
doc_type

A string that indicates the requirements document type:

® 'word'

® 'excel'

Remove the links in a demo requirements document, and then reinsert
them:

1 Open the demo model:

slvnvdemo_fuelsys officereq

2 Open the demo requirements document:

open([matlabroot strcat('/toolbox/slvnv/rmidemos/fuelsys_req_docs/',...
'slvnvdemo_FuelSys_DesignDescription.docx')])

3 Remove the links from the requirements document:



rmiref.insertRefs

rmiref.removeRefs('word')

4 Enter y to confirm the removal.
5 Reinsert the links from the requirements document to the model:

[total links, total matches, total inserted] = rmiref.insertRefs(gcs, 'word')

See Also rmiref.removeRefs
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Purpose Remove links to models from requirements documents
Syntax rmiref.removeRefs(doc_type)
Description rmiref.removeRefs(doc_type) removes all links to models from the

open, active requirements document of type doc_type.

Input doc_type

Arguments A string that indicates the requirements document type:
e 'word'
e 'excel'’
e 'doors’

Examples Remove the links in this demo requirements document:

open([matlabroot strcat('/toolbox/slvnv/rmidemos/fuelsys_req_docs/', ...
'slvnvdemo_FuelSys_DesignDescription.docx')])
rmiref.removeRefs('word")

See Also rmiref.insertRefs
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Purpose

Syntax

Description

Manage user tags for requirements links

rmitag(model, 'add', tag)

rmitag(model, 'add', tag, doc_pattern)
rmitag(model, 'delete', tag)

rmitag(model, 'delete', tag, doc_pattern)
rmitag(model, 'replace', tag, new_tag)
rmitag(model, 'replace', tag, new_tag, doc_pattern)
rmitag(model, 'clear', tag)

rmitag(model, 'clear', tag, doc_pattern)

rmitag(model, 'add', tag) adds a string tag as a user tag for all
requirement links in model.

rmitag(model, 'add', tag, doc pattern) adds tag as a user tag for
all links in model, where the full or partial document name matches the
regular expression doc_pattern.

rmitag(model, 'delete', tag) removes the user tag, tag, from all
requirements links in model.

rmitag(model, 'delete', tag, doc pattern) removes the user tag
tag, from all requirements links in model, where the full or partial
document name matches doc_pattern.

rmitag(model, 'replace', tag, new_tag) replaces tag with
new_tag for all requirements links in model.

rmitag(model, 'replace', tag, new_tag, doc_pattern) replaces
tag with new_tag for links in model, where the full or partial document
name matches the regular expression doc_pattern.

rmitag(model, 'clear', tag) deletes all requirement links that have
the user tag, tag.

rmitag(model, 'clear', tag, doc_pattern) deletes all requirement
links that have the user tag, tag, and link to the full or partial document
name specified in doc_pattern.
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Input model
Arguments Simulink model name or handle
tag

String
doc_pattern

Regular expression to match in the linked requirements document
name

new_tag

String that indicates the name of a user tag for a requirements
link. Use this argument when replacing an existing user tag with
a new user tag.

Examples Open the slvnvdemo_fuelsys_officereq demo model; add the user
tag tmptag to all objects with requirements links:

open_system('slvnvdemo_fuelsys_officereq');
rmitag(gcs, 'add', 'tmptag');

Remove the user tag test from all requirements links:

open_system('slvnvdemo_fuelsys_officereq');
rmitag(gcs, 'delete', 'test');

Delete all requirements links that have the user tag design:

open_system('slvnvdemo_fuelsys_officereq');
rmitag(gcs, 'clear', 'design');

Change all instances of the user tag tmptag to safety requirement,
where the document filename extension is .docx:
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open_system('slvnvdemo_fuelsys officereq');

rmitag(gcs, 'replace', 'tmptag',
‘safety requirements', '\.docx');
See Also rmi | rmidocrename
How To + “Filtering Requirements with User Tags”
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ModelAdvisor.Check.setAction

Purpose
Syntax

Description

See Also

How To

3-138

Specify action for check
setAction(check_obj, action_obj)

setAction(check_obj, action_obj) returns the action object
action.obj to use in the check check_obj. The setAction method
identifies the action you want to use in a check.

ModelAdvisor.Action

+ “Customizing the Model Advisor”



ModelAdvisor.Paragraph.setAlign
|

Purpose Specify paragraph alignment
Syntax setAlign(paragraph, alignment)
Description setAlign(paragraph, alignment) specifies the alignment of text.

Possible values are:

o 'left' (default)

® 'right'
e 'center'
Examples report_paragraph = ModelAdvisor.Paragraph;

setAlign(report_paragraph, 'center');

How To + “Customizing the Model Advisor”
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ModelAdvisor.Text.setBold

Purpose
Syntax

Description

Input
Arguments

Examples

How To

3-140

Specify bold text
setBold(text, mode)

setBold(text, mode) specifies whether text should be formatted in
bold font.

text Instantiation of the ModelAdvisor.Text class
mode A Boolean value indicating bold formatting
of text:

¢ true — Format the text in bold font.

e false — Do not format the text in bold font.

t1 = ModelAdvisor.Text('This is some text');
setBold(t1, 'true');

+ “Customizing the Model Advisor”



ModelAdvisor.Action.setCallbackFcn

Purpose
Syntax

Description

Examples

How To

Specify action callback function

setCallbackFcn(action_obj, @handle)

setCallbackFcn(action obj, @handle) specifies the handle to the
callback function, handle, to use with the action object, action_obj.

Note The following example is a fragment of code from the

sl _customization.m file for the demo model, slvnvdemo_mdladv. The
example does not execute as shown without the additional content
found in the s1_customization.m file.

rec = ModelAdvisor.Check('mathworks.example.optimizationSettings');

% Define an automatic fix action for this check

modifyAction = ModelAdvisor.Action;

modifyAction.setCallbackFcn(@modifyOptmizationSetting);

modifyAction.Name = 'Modify Settings';

modifyAction.Description = ['Modify model configuration optimization' ...
' settings that can impact safety'];

modifyAction.Enable = true;

rec.setAction(modifyAction);

“Defining Check Actions”
“Customizing the Model Advisor”

“setActionenable”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Specify callback function for check

setCallbackFcn(check_obj, @handle, context, style)

setCallbackFcn(check obj, @handle, context, style) specifies
the callback function to use with the check, check_obj.

check_obj

handle

context

style

°

% --- sample check 1

Instantiation of the ModelAdvisor.Check
class

Handle to a check callback function

Context for checking the model or subsystem:

® 'None' — No special requirements.

® 'PostCompile' — The model must be
compiled.

Type of callback function:

e 'StyleOne' — Simple check callback
function, for formatting results using
template

e 'StyleTwo' — Detailed check callback
function

e 'StyleThree' — Check callback functions
with hyperlinked results

rec = ModelAdvisor.Check('com.mathworks.sample.Check1');

rec.Title = 'Check Simulink block font';

rec.TitleTips = 'Example style three callback';
rec.setCallbackFcn(@SampleStyleThreeCallback, 'None','StyleThree');

+ “Creating Callback Functions and Results”
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+ “Customizing the Model Advisor”
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|

Purpose Specify check used in task
Syntax setCheck (task, check_ID)
Description setCheck(task, check_ID) specifies the check to use in the task.

You can use one ModelAdvisor.Check object in multiple
ModelAdvisor.Task objects, allowing you to place the same check in
multiple locations in the Model Advisor tree. For example, Check for
implicit signal resolution appears in the By Product > Simulink
folder and in the By Task > Model Referencing folder in the Model
Advisor tree.

When adding checks as tasks, the Model Advisor uses the task
properties instead of the check properties, except for Visible and

LicenseName.
IA“PU" task Instantiation of the ModelAdvisor.Task class
rguments . : : -
9 check _ID A unique string that identifies the check to
use in the task
Examples MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');

setCheck (MAT1, 'com.mathworks.sample.Checkl');
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Purpose Add description of check to result
Syntax setCheckText(ft_obj, text)
Description setCheckText (ft_obj, text) is an optional method that adds text or

a model advisor template object as the first item in the report. Use this
method to add information describing the overall check.

Input ft_obj
Arguments A handle to a template object.
text

A string or a handle to a formatting object.

Valid formatting objects are: ModelAdvisor.Image,
ModelAdvisor.LineBreak, ModelAdvisor.List,
ModelAdvisor.Paragraph, ModelAdvisor.Table, and
ModelAdvisor.Text.

text appears as the first line in the analysis result.

Examples Create a list object, ft, and add a line of text to the result:
ft = ModelAdvisor.FormatTemplate('ListTemplate');

setCheckText(ft, ['Identify unconnected lines, input ports,'...
‘and output ports in the model']);

How To + “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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ModelAdvisor.Table.setColHeading

Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Specify table column title
setColHeading(table, column, heading)

setColHeading(table, column, heading) specifies that the column
header of column is set to heading.

table Instantiation of the ModelAdvisor.Table
class

column An integer specifying the column number

heading A string, element object, or object array

specifying the table column title

tablel = ModelAdvisor.Table(2, 3);

setColHeading(table1, 1, 'Header 1');
setColHeading(table1, 2, 'Header 2');
setColHeading(table1, 3, 'Header 3');

+ “Customizing the Model Advisor”
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|

Purpose Specify column title alignment
Syntax setColHeadingAlign(table, column, alignment)
Description setColHeadingAlign(table, column, alignment) specifies the

alignment of the column heading.

InPUt table Instantiation of the ModelAdvisor.Table
Arguments class
column An integer specifying the column number
alignment Alignment of the column heading. alignment

can have one of the following values:

o left (default)
® right

® center

Examples tablel = ModelAdvisor.Table(2, 3);
setColHeading(table1, 1, 'Header 1');
setColHeadingAlign(tabletl, 1, 'center');
setColHeading(table1, 2, 'Header 2');
setColHeadingAlign(tablel, 2, 'center');
setColHeading(table1, 3, 'Header 3');
setColHeadingAlign(tabletl, 3, 'center');

How To + “Customizing the Model Advisor”
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Purpose Specify text color

Syntax setColor(text, color)

Descripl‘ion setColor(text, color) sets the text color to color.

IA“PUt text Instantiation of the ModelAdvisor.Text class

rguments : o
9 color An enumerated string specifying the color of

the text. Possible formatting options include:
¢ normal (default) — Text is default color.
e pass — Text is green.
e warn — Text is yellow.
e fail — Text is red.
e keyword — Text is blue.

Examples t1 = ModelAdvisor.Text('This is a warning');

setColor(t1, 'warn');
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ModelAdvisor.InputParameter.setColSpan

Purpose
Syntax

Description

Input
Arguments

Examples

Specify number of columns for input parameter

setColSpan(input_param, [start_col end_col])

setColSpan(input_param, [start _col end col]) specifies the
number of columns that the parameter occupies. Use the setColSpan
method to specify where you want an input parameter located in the
layout grid when there are multiple input parameters.

input_param

start_col

end_col

inputParam2

inputParam2.
.Value="'12";
.Type='String"’;

inputParam2
inputParam2

inputParam2.
inputParam2.
inputParam2.

Instantiation of the
ModelAdvisor.InputParameter class

A positive integer representing the first
column that the input parameter occupies in
the layout grid

A positive integer representing the last
column that the input parameter occupies in
the layout grid

= ModelAdvisor.InputParameter;
Name = 'Standard font size';

Description='sample tooltip';
setRowSpan([2 2]);
setColSpan([1 1]);
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Purpose Add column titles to table
Syntax setColTitles(ft_obj, {col title 1, col title 2, ...})
Description setColTitles(ft obj, {col title 1, col title 2, ...})is

method you must use when you create a template object that is a table
type. Use it to specify the titles of the columns in the table.

Note Before adding data to a table, you must specify column titles.

Input ft_obj
Arguments A handle to a template object.
col_title N

A cell of strings or handles to formatting objects, specifying the
column titles.

Valid formatting objects are: ModelAdvisor.Image,
ModelAdvisor.LineBreak, ModelAdvisor.List,
ModelAdvisor.Paragraph, ModelAdvisor.Table, and
ModelAdvisor.Text.

The order of the col _title N inputs determines which column
the title is in. If you do not add data to the table, the Model
Advisor does not display the table in the result.

Examples Create a table object, ft, and specify two column titles:

ft = ModelAdvisor.FormatTemplate('TableTemplate');
setColTitles(ft, {'Index', 'Block Name'});

How To + “Customizing the Model Advisor”
“Formatting Model Advisor Results”
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ModelAdyvisor.Table.setColWidth

Purpose
Syntax

Description

Input
Arguments

Examples

How To

Specify column widths
setColWidth(table, column, width)

setColWidth(table, column, width) specifies the column.

The setColwidth method specifies the table column widths relative to
the entire table width. If column widths are [1 2 3], the second column
is twice the width of the first column, and the third column is three
times the width of the first column. Unspecified columns have a default
width of 1. For example:

setColWidth(1, 1);
setColWidth (3, 2);

specifies [1 1 2] column widths.

table Instantiation of the ModelAdvisor.Table
class

column An integer specifying column number

width An integer or array of integers specifying the
column widths, relative to the entire table
width

tablel = ModelAdvisor.Table(2, 3)
setColwidth(tablet, 1, 1);
setColWidth(tablel, 3, 2);

+ “Customizing the Model Advisor”
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Purpose Set contents of table
Syntax setEntries(content)
Description setEntries(content)
InPUt content A 2-D cell array containing the contents
Arguments of the table. Each item of the cell array
must be either a string or an instance of
ModelAdvisor.Element. The size of the
cell array must be equal to the size of the
table specified in the ModelAdvisor.Table
constructor.
Examples table = ModelAdvisor.Table(4,3);
contents = cell(4,3); % 4 by 3 table
for k=1:4
for m=1:3
contents{k,m} = ['Contents for row-' num2str(k) ' column-' num2str(m)];
end
end

table.setEntries(contents);

How To + “Customizing the Model Advisor”
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ModelAdvisor.Table.setEntry
|

Purpose Add cell to table

Syntax setEntry(table, row, column, string)
setEntry(table, row, column, content)

Description setEntry(table, row, column, string) adds a string to a cell in
a table.

setEntry(table, row, column, content) adds an object specified by
content to a cell in a table.

InPUt table Instantiation of the ModelAdvisor.Table
Arguments class
row An integer specifying the row
column An integer specifying the column
string A string representing the contents of the entry
content An element object or object array specifying

the content of the table entries

Examples Create two tables and insert table?2 into the first cell of table1:

tablet
table2

ModelAdvisor.Table(1, 1);
ModelAdvisor.Table(2, 3);

setEntry(table1, 1, 1, table2);

How To + “Customizing the Model Advisor”
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Purpose Specify table cell alignment
Syntax setEntryAlign(table, row, column, alignment)
Description setEntryAlign(table, row, column, alignment) specifies the cell

alignment of the designated cell.

InPUt table Instantiation of the ModelAdvisor.Table
Arguments class
row An integer specifying row number
column An integer specifying column number
alignment A string specifying the cell alignment.

Possible values are:

e left (default)
®* right

® center
Examples tablel = ModelAdvisor.Table(2,3);

setHeading(table1, 'New Table');

setEntry(table1, 1, 1, 'First Entry');
setEntryAlign(tablet, 1, 1, 'center');

How To + “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To

Specify table title
setHeading(table, title)

setHeading(table, title) specifies the table title

table Instantiation of the ModelAdvisor.Table
class
title A string, element object, or object array that

specifies the table title

tablel = ModelAdvisor.Table(2, 3);
setHeading(table1, 'New Table');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Specify table title alignment
setHeadingAlign(table, alignment)

setHeadingAlign(table, alignment) specifies the alignment for the
table title.

table Instantiation of the ModelAdvisor.Table
class
alignment A string specifying the table title alignment.

Possible values are:
e left (default)

® right

® center

table1 = ModelAdvisor.Table(2, 3);
setHeading(table1, 'New Table');
setHeadingAlign(tablel1, 'center');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To

Specify hyperlink location
setHyperlink(image, url)

setHyperlink(image, url) specifies the target location of the
hyperlink associated with image.

image Instantiation of the ModelAdvisor.Image
class
url A string specifying the target URL

matlab_logo=ModelAdvisor.Image;
setHyperlink(matlab_logo, 'http://www.mathworks.com');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Specify hyperlinked text
setHyperlink(text, url)

setHyperlink(text, url) creates a hyperlink from the text to the
specified URL.

text Instantiation of the ModelAdvisor.Text class
url A string that specifies the target location of
the URL

t1 = ModelAdvisor.Text('MathWorks home page');
setHyperlink(t1, 'http://www.mathworks.com');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

How To

Specify image location
setImageSource(image_obj, source)

setImageSource(image_obj, source) specifies the location of the
image.

image_obj Instantiation of the ModelAdvisor.Image
class

source A string specifying the location of the image
file

+ “Customizing the Model Advisor”
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Purpose Add description of subcheck to result
Syntax setInformation(ft_obj, text)
Description setInformation(ft _obj, text) is an optional method that adds

text as the first item after the subcheck title. Use this method to add
information describing the subcheck.

Input ft_obj

Arguments A handle to a template object.
text

A string or a handle to a formatting object, that describes the
subcheck.

Valid formatting objects are: ModelAdvisor.Image,
ModelAdvisor.LineBreak, ModelAdvisor.List,
ModelAdvisor.Paragraph, ModelAdvisor.Table, and
ModelAdvisor.Text.

The Model Advisor displays text after the title of the subcheck.

Examples Create a list object, ft, and specify a subcheck title and description:

ft = ModelAdvisor.FormatTemplate('ListTemplate');

setSubTitle(ft, ['Check for constructs in the model '
‘that are not supported when generating code']);

setInformation(ft, ['Identify blocks that should not '
'be used for code generation.']);

How To + “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Input
Arguments

Examples

See Also

How To

Specify input parameters for check
setInputParameters(check_obj, params)

setInputParameters(check_obj, params) specifies
ModelAdvisor.InputParameter objects (params) to be used
as input parameters to a check (check_obj).

check_obj Instantiation of the ModelAdvisor.Check
class
params A cell array of

ModelAdvisor.InputParameters objects

rec = ModelAdvisor.Check('com.mathworks.sample.Checkl');
inputParami = ModelAdvisor.InputParameter;

inputParam2 ModelAdvisor.InputParameter;

inputParam3 ModelAdvisor.InputParameter;
setInputParameters(rec, {inputParami,inputParam2,inputParam3});

ModelAdvisor.InputParameter

“Customizing the Model Advisor”
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Purpose Specify layout grid for input parameters
Syntax setInputParametersLayoutGrid(check_obj, [row col])
Descripl‘ion setInputParametersLayoutGrid(check obj, [row col]) specifies

the layout grid for input parameters in the Model Advisor. Use the
setInputParametersLayoutGrid method if there are multiple input

parameters.
InPUt check_obj Instantiation of the ModelAdvisor.Check
Arguments class
row Number of rows in the layout grid
col Number of columns in the layout grid
Examples % --- sample check 1

rec = ModelAdvisor.Check('com.mathworks.sample.Check1');

rec.Title = 'Check Simulink block font';

rec.TitleTips = 'Example style three callback';
rec.setCallbackFcn(@SampleStyleThreeCallback, '‘None', 'StyleThree');
rec.setInputParametersLayoutGrid([3 2]);

See Also ModelAdvisor.InputParameter

How To + “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To

Italicize text
setltalic(text, mode)

setItalic(text, mode) specifies whether text should be italicized.

text Instantiation of the ModelAdvisor.Text class
mode A Boolean value indicating italic formatting
of text:

e true — Italicize the text.

e false — Do not italicize the text.

t1 = ModelAdvisor.Text('This is some text');
setItalic(t1, 'true');

+ “Customizing the Model Advisor”

3-163



ModelAdvisor.FormatTemplate.setListObj

Purpose
Syntax

Description

Examples

How To

3-164

Add list of hyperlinks to model objects
setListObj (ft_obj, {model_obj})

setListObj (ft_obj, {model obj}) is an optional method that
generates a bulleted list of hyperlinks to model objects. ft_obj is a
handle to a list template object. model obj is a cell array of handles or
full paths to blocks, or model objects that the Model Advisor displays
as a bulleted list of hyperlinks in the report.

Create a list object, ft, and add a list of the blocks found in the model:
ft = ModelAdvisor.FormatTemplate('ListTemplate');

% Find all the blocks in the system
allBlocks = find_system(system);

% Add the blocks to a list
setListObj (ft, allBlocks);

+ “Customizing the Model Advisor”
* “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Input
Arguments

Examples

Add Recommended Action section and text
setRecAction(ft_obj, {text})

setRecAction(ft_obj, {text}) is an optional method that adds a
Recommended Action section to the report. Use this method to describe
how to fix the check.

ft_obj
A handle to a template object.
text

A cell array of strings or handles to formatting objects, that

describes the recommended action to fix the issues reported by
the check.

Valid formatting objects are: ModelAdvisor.Image,
ModelAdvisor.LineBreak, ModelAdvisor.List,
ModelAdvisor.Paragraph, ModelAdvisor.Table, and
ModelAdvisor.Text.

The Model Advisor displays the recommended action as a separate
section below the list or table in the report.

Create a list object, ft, find Gain blocks in the model, and recommend
changing them:

ft = ModelAdvisor.FormatTemplate('ListTemplate');
% Find all Gain blocks
gainBlocks = find_system(gcs, 'BlockType','Gain');

% Find Gain blocks with expression evaluates to 1
for idx = 1:length(gainBlocks)
gainObj = get_param(gainBlocks(idx), 'Object');
resGain = slResolve(gainObj.Gain, gainObj.getFullName);
if ~isempty(resGain)
% Find the first index that computes to 1
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if ~isempty(find(resGain == 1, 1))

setRecAction(ft, {'If you are using these blocks '

‘as buffers, you should replace them with '
'Signal Conversion blocks'});
end
end
end

How To + “Customizing the Model Advisor”
“Formatting Model Advisor Results”
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|

Purpose Add See Also section and links

Syntax setRefLink(ft_obj, {{’standard’}})
setRefLink(ft_obj, {{’url’, ’standard’}})

Description setRefLink(ft_obj, {{’standard’}}) is an optional method that
adds a See Also section above the table or list in the result. Use this
method to add references to standards. ft_obj is a handle to a template
object. standard is a cell array of strings that you want to display in
the result. If you include more than one cell, the Model Advisor displays
the strings in a bulleted list.

setRefLink(ft_obj, {{’url’, ’standard’}}) generates a list of
links in the See Also section. url is a string that indicates the location
to link to. You must provide the full link including the protocol.

For example, http:\\www.mathworks.com is a valid link, while
www.mathworks.com is not a valid link. You can create a link to any
protocol that is valid URL, such as a web site address, a full path to

a file, or a relative path to a file.

Note setReflLink expects a cell array of cell arrays for the second
input.

Examples Create a list object, ft, and add a related standard:

ft = ModelAdvisor.FormatTemplate('ListTemplate');
setRefLink(ft, {{'IEC 61508-3, Table A.3 (3) ''Language subset'''}});

Create a list object, ft, and add a list of related standards:

ft = ModelAdvisor.FormatTemplate('ListTemplate');

setRefLink (ft, {
{'IEC 61508-3, Table A.3 (2) ''Strongly typed programming language'''},...
{'IEC 61508-3, Table A.3 (3) ''Language subset'''}});

How To + “Customizing the Model Advisor”

3-167



ModelAdvisor.FormatTemplate.setRefLink

* “Formatting Model Advisor Results”

3-168



ModelAdvisor.Text.setRetainSpaceReturn

Purpose
Syntax

Description

Input
Arguments

Examples

How To

Retain spacing and returns in text
setRetainSpaceReturn(text, mode)

setRetainSpaceReturn(text, mode) specifies whether the text must
retain the spaces and carriage returns.

text Instantiation of the ModelAdvisor.Text class

mode A Boolean value indicating whether to
preserve spaces and carriage returns in the
text:

¢ true (default) — Preserve spaces and
carriage returns.

e false — Do not preserve spaces and
carriage returns.

t1 = ModelAdvisor.Text('MathWorks home page');
setRetainSpaceReturn(ti1, 'true');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Specify table row title
setRowHeading(table, row, heading)

setRowHeading(table, row, heading) specifies a title for the
designated table row.

table Instantiation of the ModelAdvisor.Table
class

row An integer specifying row number

heading A string, element object, or object array

specifying the table row title

tablel = ModelAdvisor.Table(2,3);

setRowHeading(tablei1, 1, 'Row 1 Title');
setRowHeading(tablei1, 2, 'Row 2 Title');
setRowHeading(tablei1, 3, 'Row 3 Title');

+ “Customizing the Model Advisor”



ModelAdvisor.Table.setRowHeadingAlign

Purpose
Syntax

Description

Input
Arguments

Examples

How To

Specify table row title alignment

setRowHeadingAlign(table, row, alignment)

setRowHeadingAlign(table, row, alignment) specifies the

alignment for the designated table row.

table Instantiation of the ModelAdvisor.Table
class

row An integer specifying row number.

alignment A string specifying the cell alignment.

Possible values are:

o left (default)

® right

® center

table1 = ModelAdvisor.Table(2,

setRowHeading(tablei, 1, 'Row
setRowHeadingAlign(tablel, 1,
setRowHeading(tablei1, 2, 'Row
setRowHeadingAlign(tablel, 2,
setRowHeading(tablei, 3, 'Row
setRowHeadingAlign(tablel, 3,

“Customizing the Model Advisor”

3);

1 Title'
‘center’
2 Title'
‘center’
3 Title'
‘center’

)
)
)
)
)
)

H

H

H

H

H

H
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Purpose
Syntax

Description

Input
Arguments

Examples

3-172

Specify rows for input parameter

setRowSpan(input_param, [start_row end_row])

setRowSpan(input_param, [start _row end_row]) specifies the
number of rows that the parameter occupies. Specify where you want
an input parameter located in the layout grid when there are multiple
input parameters.

input_param

start_row

end_row

inputParam2

inputParam2.

inputParam2
inputParam2

inputParam2

The input parameter object

A positive integer representing the first row
that the input parameter occupies in the
layout grid

A positive integer representing the last row
that the input parameter occupies in the
layout grid

= ModelAdvisor.InputParameter;
Name = 'Standard font size';
.Value="'12";

.Type="String';
inputParam2.
inputParam2.
.setColSpan([1 1]);

Description='sample tooltip';
setRowSpan([2 2]);
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Purpose
Syntax

Description

Examples

How To

Add line between subcheck results
setSubBar(ft_obj, value)

setSubBar(ft_obj, value) is an optional method that adds lines
between results for subchecks. ft_obj is a handle to a template object.
value is a boolean value that specifies when the Model Advisor includes
a line between subchecks in the check results. By default, the value is
true, and the Model Advisor displays the bar. The Model Advisor does
not display the bar when you set the value to false.

Create a list object, ft, turn off the subbar:

ft = ModelAdvisor.FormatTemplate('ListTemplate');
setSubBar(ft, false);

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Examples

How To
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Add status to check or subcheck result
setSubResultStatus(ft_obj, 'status')

setSubResultStatus(ft_obj, 'status') is an optional method that
displays the status in the result. Use this method to display the status
of the check or subcheck in the result. ft_obj is a handle to a template
object. status is a string identifying the status of the check. Valid
strings are:

Pass
warn
Fail

Create a list object, ft, and add a passing status:

ft = ModelAdvisor.FormatTemplate('ListTemplate');
setSubResutlStatus(ft, 'Pass');

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To

Add text below status in result
setSubResultStatusText(ft_obj, message)

setSubResultStatusText (ft_obj, message) is an optional method
that displays text below the status in the result. Use this method to
describe the status.

ft_obj
A handle to a template object.
message

A string or a handle to a formatting object that the Model Advisor
displays below the status in the report.

Valid formatting objects are: ModelAdvisor.Image,
ModelAdvisor.LineBreak, ModelAdvisor.List,
ModelAdvisor.Paragraph, ModelAdvisor.Table, and
ModelAdvisor.Text.

Create a list object, ft, add a passing status and a description of why
the check passed:

ft = ModelAdvisor.FormatTemplate('ListTemplate');

setSubResutlStatus(ft, 'Pass');

setSubResultStatusText(ft, ['Constructs that are not supported when '
'generating code were not found in the model or subsystem']);

“Customizing the Model Advisor”
“Formatting Model Advisor Results”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Specify subscripted text
setSubscript(text, mode)

setSubscript(text, mode) indicates whether to make text subscript.

text Instantiation of the ModelAdvisor.Text class

mode A Boolean value indicating subscripted
formatting of text:

® true — Make the text subscript.

e false — Do not make the text subscript.

t1 = ModelAdvisor.Text('This is some text');
setSubscript(t1, 'true');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To

Specify superscripted text
setSuperscript(text, mode)
setSuperscript(text, mode) indicates whether to make text

subscript.

text Instantiation of the ModelAdvisor.Text class

mode A Boolean value indicating superscripted
formatting of text:

® true — Make the text superscript.

e false — Do not make the text superscript.

t1 = ModelAdvisor.Text('This is some text');
setSuperscript(tl, 'true');

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Add title for subcheck in result
setSubTitle(ft_obj, title)

setSubTitle(ft_obj, title) is an optional method that adds a
subcheck result title. Use this method when you create subchecks to
distinguish between them in the result.

ft_obj
A handle to a template object.

title

A string or a handle to a formatting object specifying the title of
the subcheck.

Valid formatting objects are: ModelAdvisor.Image,
ModelAdvisor.LineBreak, ModelAdvisor.List,
ModelAdvisor.Paragraph, ModelAdvisor.Table, and
ModelAdvisor.Text.

Create a list object, ft, and add a subcheck title:

ft = ModelAdvisor.FormatTemplate('ListTemplate');
setSubTitle(ft, ['Check for constructs in the model '
‘that are not supported when generating code']);

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Examples

How To

Add data to table
setTableInfo(ft_obj, {data})

setTableInfo(ft_obj, {data}) is an optional method that creates a
table. ft_obj is a handle to a table template object. data is a cell array
of strings or objects specifying the information in the body of the table.
The Model Advisor creates hyperlinks to objects. If you do not add data
to the table, the Model Advisor does not display the table in the result.

Note Before creating a table, you must specify column titles using
the setColTitle method.

Create a table object, ft, add column titles, and add data to the table:
ft = ModelAdvisor.FormatTemplate('TableTemplate');

setColTitle(ft, {'Index', 'Block Name'});
setTableInfo(ft, {'1', 'Gain'});

+ “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose Add title to table

Syntax setTableTitle(ft _obj, title)

Description setTableTitle(ft obj, title) is an optional method that adds a
title to a table.

Input ft_obj

Arguments A handle to a template object.

title

A string or a handle to a formatting object specifying the title of
the table.

Valid formatting objects are: ModelAdvisor.Image,
ModelAdvisor.LineBreak, ModelAdvisor.List,
ModelAdvisor.Paragraph, ModelAdvisor.Table, and
ModelAdvisor.Text.

The title appears above the table. If you do not add data to the
table, the Model Advisor does not display the table and title in
the result.

Examples Create a table object, ft, and add a table title:

ft = ModelAdvisor.FormatTemplate('TableTemplate');
setTableTitle(ft, 'Table of fonts and styles used in model');

How To + “Customizing the Model Advisor”
+ “Formatting Model Advisor Results”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To

Specify list type
setType(list_obj, listType)

setType(list obj, listType) specifies the type of list the
ModelAdvisor.List constructor creates.

list_obj Instantiation of the ModelAdvisor.List class
listType Specifies the list type:

®* numbered

® pulleted

subList = ModelAdvisor.List();

subList.setType('numbered')

subList.addItem(ModelAdvisor.Text('Sub entry 1', {'pass','bold'}));
subList.addItem(ModelAdvisor.Text('Sub entry 2', {'pass','bold'}));

+ “Customizing the Model Advisor”
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Purpose
Syntax

Description

Input
Arguments

Examples

How To
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Underline text
setUnderlined(text, mode)

setUnderlined(text, mode) indicates whether to underline text

text Instantiation of the ModelAdvisor.Text class

mode A Boolean value indicating underlined
formatting of text:

¢ true — Underline the text.

e false — Do not underline the text.

t1 = ModelAdvisor.Text('This is some text');
setUnderlined(t1, 'true');

+ “Customizing the Model Advisor”
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Purpose

Syntax

Description

Input
Arguments

Collect signal range coverage information for model object

[min, max] = sigrangeinfo(cvdo, object)
[min, max] sigrangeinfo(cvdo, object, portID)

[min, max] = sigrangeinfo(cvdo, object) returns the minimum
and maximum signal values output by the model component object
within the cvdata object cvdo.

[min, max] = sigrangeinfo(cvdo, object, portID) returns the
minimum and maximum signal values associated with the output port
portID of the Simulink block object.

cvdo
cvdata object
object

An object in the model or Stateflow chart that receives signal
range coverage. Valid values for object include the following:

Object Specification Description

BlockPath Full path to a model or block
BlockHandle Handle to a model or block
s10bj Handle to a Simulink API object
sfID Stateflow ID

stObj Handle to a Stateflow API object
{BlockPath, sfID} Cell array with the path to a

Stateflow chart or atomic subchart
and the ID of an object contained in
that chart or subchart
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Object Specification
{BlockPath, sfObj}

[BlockHandle, sfID]

portID

Description

Cell array with the path to a
Stateflow chart or atomic subchart
and a Stateflow object API handle
contained in that chart or subchart

Array with a handle to a Stateflow

chart or atomic subchart and the ID
of an object contained in that chart

or subchart

Output port of the block object

Output max
Arguments

Maximum signal value output by the model component object

within the cvdata object, cvdo. If object outputs a vector, min

and max are also vectors.

min

Minimum signal value output by the model component object
within the cvdata object, cvdo. If object outputs a vector, min

and max are also vectors.

Alternatives To collect signal range coverage for a model, using the GUI:

1 Open the model for which you want signal range coverage.

2 In the Model Editor, select Tools > Coverage Settings.

3 On the Coverage tab, under Coverage Metrics, select Signal

Range Coverage.

4 Open the Results and Report tabs and specify the type of output

that you need.
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5 Click OK.

6 Simulate the model and view the results.

Examples Collect signal range data for the Product block in the
slvnvdemo _cv_small controller model:
mdl = 'slvnvdemo_cv_small_controller';
open_system(mdl)
testObj = cvtest(mdl) %Create test spec object
testObj.settings.sigrange = 1; %Enable signal range coverage
data = cvsim(testObj) %Simulate the model

blk_handle = get_param([mdl, '/Product'], 'Handle');
[minVal, maxVal] = sigrangeinfo(data, blk_handle) %Get signal range data

See Also complexityinfo | conditioninfo | cvsim | decisioninfo |
getCoverageInfo | mcdcinfo | sigsizeinfo | tableinfo
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Purpose

Syntax

Description

Input
Arguments
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Collect signal size coverage information for model object

[min, max, allocated] = sigsizeinfo(cvdo, object)
[min, max] = sigsizeinfo(cvdo, object, portID)

[min, max, allocated] = sigsizeinfo(cvdo, object) returns the
minimum, maximum, and allocated signal sizes for the outputs of the
model component object within the cvdata object cvdo.

[min, max] = sigsizeinfo(cvdo, object, portID) returns the
minimum and maximum signal sizes associated with the output port
portID of the model component object.

cvdo
cvdata object
object

An object in the model or Stateflow chart that receives signal size
coverage. Valid values for object include the following:

Object Specification Description

BlockPath Full path to a Simulink model or
block

BlockHandle Handle to a Simulink model or
block

s10bj Handle to a Simulink API object

sfID Stateflow ID

stObj Handle to a Stateflow API object

{BlockPath, sfID} Cell array with the path to a

Stateflow chart or atomic subchart
and the ID of an object contained in
that chart or subchart
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Output
Arguments

Examples

Object Specification Description

{BlockPath, sfObj} Cell array with the path to a
Stateflow chart or atomic subchart
and a Stateflow object API handle
contained in that chart or subchart

[BlockHandle, sfID] Array with a handle to a Stateflow
chart or atomic subchart and the ID
of an object contained in that chart
or subchart

portID
Output port of the block object

max

Maximum signal size output by the model component object
within the cvdata object, cvdo. If object outputs a vector, min
and max are also vectors.

min
Minimum signal size output by the model component object

within the cvdata object, cvdo. If object outputs a vector, min
and max are also vectors.

allocated

Allocated signal size output by the model component object
within the cvdata object, cvdo. If object outputs a vector, min
and max are also vectors.

Collect signal size coverage data for the Switch block in the
sldemo_varsize basic model:

mdl = 'sldemo_varsize_basic';
open_system(mdl);
testObj = cvtest(mdl); %Create test spec object

testObj.settings.sigsize=1; %Enable signal size coverage
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data = cvsim(testObj); %Simulate the model

blk_handle = get_param([mdl, '/Switch'], 'Handle'); %Set the block handle

[minval, maxVal, allocVal] = sigsizeinfo(data, blk_handle); %Get signal size data

Alternatives To collect signal size coverage for a model, using the GUI:
1 Open the model for which you want signal size coverage.
2 In the Model Editor, select Tools > Coverage Settings.

3 On the Coverage tab, under Coverage Metrics, select Signal Size
Coverage.

4 Open the Results and Report tabs and specify the type of output
that you need.

5 Click OK.
6 Simulate the model and view the results.

See Also complexityinfo | conditioninfo | cvsim | decisioninfo | mcdcinfo

| sigrangeinfo | tableinfo
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Purpose

Syntax

Description

Input
Arguments

Extract subsystem or subchart contents into new model for analysis

newModel = slvnvextract(subsystem)
newModel slvnvextract(subchart)
newModel = slvnvextract(subsystem, showModel)
newModel slvnvextract(subchart, showModel)

newModel = slvnvextract(subsystem) extracts the contents of

the Atomic Subsystem block subsystem and creates a new model.
slvnvextract returns the name of the new model in newModel.
slvnvextract uses the subsystem name for the model name, appending
a numeral to the model name if that model name already exists.

newModel = slvnvextract(subchart) extracts the contents of the
atomic subchart subchart and creates a new model. subchart should
specify the full path of the atomic subchart. slvnvextract uses the
subchart name for the model name, appending a numeral to the model
name if that model name already exists.

Note If the atomic subchart calls an exported graphical function that
1s outside the subchart, slvnvextract creates the model, but the new
model will not compile.

newModel = slvnvextract(subsystem, showModel) and newModel =
slvnvextract(subchart, showModel) open the extracted model if you
set showModel to true. The extracted model is only loaded if showModel
1s set to false.

subsystem
Full path to the atomic subsystem
subchart

Full path to the atomic subchart

showModel
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Boolean indicating whether to display the extracted model

Default: True

OUi‘pUi‘ newModel

Arguments Name of the new model

Examples Extract the Atomic Subsystem block, Bus Counter, from the
sldemo_mdlref_conversion model and copy it into a new model:

open_system('sldemo_mdlref_conversion');
newmodel = slvnvextract('sldemo_mdlref_conversion/Bus Counter', true);

Extract the Atomic Subchart block, Sensorl, from the
sf_atomic_sensor_pair model and copy it into a new model:

open_system('sf_atomic_sensor_pair');
newmodel = slvnvextract('sf_atomic_sensor_pair/RedundantSensors/Sensori', true);
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Purpose
Syntax
Description

Output
Arguments

Generate default options for slvnvmakeharness

harnessopts = slvnvharnessopts

harnessopts = slvnvharnessopts generates the default configuration
for running slvnvmakeharness.

harnessopts

A structure whose fields specify the default configuration for
slvnvmakeharness. The harnessopts structure can have the
following fields. Default values are used if not specified.

Field

Description

harnessFilePath

Specifies the file path for creating
the harness model. If an invalid
path is specified, slvnvmakeharness
does not save the harness model,
but it creates and opens the harness
model. If this option is not specified,
slvnvmakeharness generates a new

harness model and saves it in the
MATLAB current folder.

Default: "'

modelRefHarness

Generates the test harness model that
includes model in a Model block. When
false, the test harness model includes
a copy of model.

Default: true
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Field Description

usedSignalsOnly When true, the Signal Builder block
in the harness model has signals only
for input signals used in the model.
The Simulink Design Verifier software
must be available, and model must be
compatible with the Simulink Design
Verifier software to detect the used
input signals.

Default: false

systemTestHarness | When true, generates a SystemTest
harness. This option requires dataFile
path in addition to model.

Default: false

Examples Create a test harness for the sldemo_mdlref house model using the
default options:

open_system('sldemo_mdlref_house');
harnessOpts = slvnvharnessopts;

[harnessfile] = slvnvmakeharness('sldemo_mdlref_house',...
"', harnessOpts);
See Also slvnvmakeharness
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Purpose

Syntax

Description

Input
Arguments

Log simulation input port values

data = slvnvlogsignals(model_block)
data slvnvlogsignals(harness_model)
data slvnvlogsignals(harness_model, test_case_index)

data = slvnvlogsignals(model block) simulates the model that
contains model block and logs the input signals to the model block
block. model block must be a Simulink Model block. slvnvlogsignals
records the logged data in the structure data.

data = slvnvlogsignals(harness_model) simulates every test
case in harness_model and logs the input signals to the Test Unit
block in the harness model. You must generate harness_model
using the Simulink Design Verifier analysis, sldvmakeharness, or
slvnvmakeharness

data = slvnvlogsignals(harness_model, test_case_index)
simulates every test case in the Signal Builder block of the
harness_model specified by test_case_index. slvnvlogsignals logs
the input signals to the Test Unit block in the harness model. If you
omit test _case_index, slvnvlogsignals simulates every test case in
the Signal Builder.

model block
Full block path name or handle to a Simulink Model block
harness_model

Name or handle to a harness model that the Simulink Design
Verifier software, sldvmakeharness, or slvnvmakeharness
creates

test_case_index

Array of integers that specifies which test cases in the Signal
Builder block of the harness model to simulate
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Output data

Arguments Structure that contains the logged data

Examples Simulate the sldemo_mdlref bus model and log the input signals to
the Model block CounterA in logged_data:

open_system('sldemo_mdlref_bus')
logged_data = slvnvlogsignals('sldemo_mdlref _bus/CounterA')

Use the logged data to create a harness model in order to visualize
the data:

1 Simulate the CounterB Model block, which references
the sldemo_mdlref_counter model, in the context of the
sldemo_mdlref_basic model and log the data:

open_system('sldemo_mdlref_basic');
data = slvnvlogsignals('sldemo_mdlref_basic/CounterB');

2 Create a harness model for sldemo_mdlref counter using the logged
data and the default harness options:

load_system('sldemo_mdlref_counter');
harnessOpts = slvnvharnessopts
[~, harnessFilePath] = ...
slvnvmakeharness('sldemo_mdlref_counter', data,
harnessOpts);

See Also sldvmakeharness | slvnvruncgvtest | slvnvruntest |
slvnvmakeharness
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Purpose

Syntax

Description

Input
Arguments

Generate Simulink Verification and Validation harness model

[harnessFilePath] = slvnvmakeharness(model)

[harnessFilePath] slvnvmakeharness(model, dataFile)

[harnessFilePath] slvnvmakeharness(model, dataFile,
harnessOpts)

[harnessFilePath] = slvnvmakeharness(model) generates a test
harness from model, which is a handle to a Simulink model or a
string with the model name. slvnvmakeharness returns the path
and file name of the generated harness model in harnessFilePath.
slvnvmakeharness creates an empty harness model; the test harness
includes one default test case that specifies the default values for all
input signals.

[harnessFilePath] = slvnvmakeharness(model, dataFile)
generates a test harness from the data file dataFile.

[harnessFilePath] = slvnvmakeharness(model, dataFile,
harnessOpts) generates a test harness from model using the dataFile
and harnessOpts, which specifies the harness creation options.
Requires '' for dataFile if dataFile is not available.
model

Handle to a Simulink model or a string with the model name

dataFile

Name of the file containing the data.
Default: '

harnessOpts

A structure whose fields specify the configuration for
slvnvmakeharness
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Field

Description

harnessFilePath

Specifies the file path for creating the
harness model. If an invalid path is
specified, slvnvmakeharness does not
save the harness model, but it creates
and opens the harness model. If this
option is not specified, the slvnvoptions
object is used. If this option is not
specified, slvnvmakeharness generates
a new harness model and saves it in the
MATLAB current folder.

Default: "'

modelRefHarness

Generates the test harness model that
includes model in a Model block. When
false, the test harness model includes a
copy of model.

Default: true

Note If your model contains bus objects
and you set modelRefHarness to true,
in the Configuration Parameters >
Diagnostics > Connectivity pane,
you must set the Mux blocks used to
create bus signals parameter to error.
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Output
Arguments

Examples

See Also

Field Description

usedSignalsOnly When true, the Signal Builder block

in the harness model has signals only
for input signals used in the model.

The Simulink Design Verifier software
must be available, and model must be
compatible with the Simulink Design
Verifier software to detect the used input
signals.

Default: false

systemTestHarness | When true, generates a SystemTest
harness. This option requires dataFile
path in addition to model.

Default: false

Note To create a default harnessOpts object, use
slvnvharnessopts.

harnessFilePath

String containing the path and file name of the generated harness
model

Create a test harness for the sldemo_mdlref_house model using the
default options:

open_system('sldemo_mdlref_house');
[harnessfile] = slvnvmakeharness('sldemo_mdlref_house', '', harnessOpts);

slvnvharnessopts | slvnvmergeharness
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Purpose Merge test case data
Syntax merged_data = slvnvmergedata(datail,data2,...)
Descripl‘ion merged_data = slvnvmergedata(datail,data2,...) combines two or

more test cases and counterexamples data into a single test case data
structure merged_data.

Input data

Arguments Structure that contains test case or counterexample data.

Generate this structure by running slvnvlogsignals, or by
running a Simulink Design Verifier analysis.

Output merged_data

Arguments Structure that contains the merged test cases or counterexamples

Examples Open the sldemo_mdlref basic model, which contains three
Model blocks that reference the model sldemo_mdlref counter.
Log the input signals to the three Model blocks and merge the
logged data using slvnvmergedata. Simulate the referenced model,
sldemo_mdlref_counter, for coverage with the merged data and
display the coverage results in an HTML file.

sldemo_mdlref_basic;

datal = slvnvlogsignals('sldemo_mdlref_basic/CounterA');

data2 = slvnvlogsignals('sldemo_mdlref_basic/CounterB');

data3 = slvnvlogsignals('sldemo_mdlref_basic/CounterC');

merged_data = slvnvmergedata(datal, data2, data3);

open_system('sldemo_mdlref_counter');

runOpts = slvnvruntestopts;

runOpts.coverageEnabled = true;

[ outData, initialCov ] = slvnvruntest('sldemo_mdlref_counter'
merged_data, runOpts);

cvhtml('Initial coverage', initialCov);
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See Also sldvrun | slvnvlogsignals | slvnvmakeharness | slvnvruncgvtest
| slvnvruntest
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Purpose

Syntax

Description

Input
Arguments

3-200

Merge test cases and initializations into one model

status = slvnvmergeharness(name, models,
initialization_commands)

status = slvnvmergeharness(name, models,
initialization_commands) collects the test data and initialization
commands from each test harness model in models. slvnvharnessmerge
saves the data and initialization commands in name, which is a handle
to the new model.

initialization_commands is a cell array of strings the same length
as models. It defines parameter settings for the test cases of each test
harness model.

If name does not exist, slvnvmergeharness creates it as a copy of

the first model in models. slvnvmergeharness then merges data

from other models listed in models into this model. If you create

name from a previous slvnvmergeharness run, subsequent runs of
slvnvmergeharness for name maintain the correct structure and
initialization from the earlier run. If name matches an existing Simulink
model, slvnvmergeharness merges the test data from models into name.

slvnvmergeharness assumes that name and the rest of the models in
models have only one Signal Builder block on the top level. If a model
in models does not meet this restriction or its top-level Signal Builder
block does not have the same number of signals as the top-level Signal
Builder block in name, slvnvmergeharness does not merge that model’s
test data into NAME.

name

Name of the new harness model, to be stored in the default
MATLAB folder

models
A cell array of strings that represent harness model names

initialization_commands
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A cell array of strings the same length as models.
initialization_commands defines parameter settings for the
test cases of each test harness model.

OUi‘pUi‘ status

Arguments If the operation is successful, slvnvmergeharness returns a
status of 1. Otherwise, it returns 0.

Examples Log the input signals to the three Model blocks in the
sldemo_mdlref_basic demo model that all reference the same model.
Make three test harnesses using the logged signals and merge the three
test harnesses:

open_system('sldemo_mdlref_basic');

datal = slvnvlogsignals('sldemo_mdlref_basic/CounterA');

data2 = slvnvlogsignals('sldemo_mdlref_basic/CounterB');

data3 = slvnvlogsignals('sldemo_mdlref_basic/CounterC');
open_system('sldemo_mdlref_counter');

harness1FilePath = slvnvmakeharness('sldemo_mdlref_counter', datal);
harness2FilePath = slvnvmakeharness('sldemo_mdlref_counter', data2);
harness3FilePath = slvnvmakeharness('sldemo_mdlref_counter', data3)

[~, harness1] = fileparts(harnessiFilePath);
[~, harness2] = fileparts(harness2FilePath);
[~, harness3] = fileparts(harness3FilePath);

slvnvmergeharness('new_harness_model',{harness1, harness2, harness3});

See Also slvnvlogsignals | slvnvmakeharness
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Purpose

Syntax

Description

Tips

Input
Arguments
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Invoke Code Generation Verification (CGV) API and execute model

cgvObject = slvnvruncgvtest(model, dataFile)
cgvObject slvnvruncgvtest(model, dataFile, runOpts)

cgvObject = slvnvruncgvtest(model, dataFile) invokes the
Code Generation Verification (CGV) API methods and executes the
model using all test cases in dataFile. cgvObject is a cgv.CGV object
that slvnvruncgvtest creates during the execution of the model.
slvnvruncgvtest sets the execution mode for cgvObject to'sim' by
default.

cgvObject = slvnvruncgvtest(model, dataFile, runOpts) invokes
CGV API methods and executes the model using test cases in dataFile.
runOpts defines the options for executing the test cases. The settings in
runOpts determine the configuration of cgvObject.

To run slvnvruncgvtest, you must have a Embedded Coder™ license.

If your model has parameters that are not configured correctly for
executing test cases with the CGV API, slvnvruncgvtest reports
warnings about the invalid parameters. If you see these warnings, do
one of the following:

® Modify the invalid parameters and rerun slvnvruncgvtest.

® Set allowCopyModel in runOpts to be true and rerun
slvnvruncgvtest. slvnvruncgvtest makes a copy of your model
with the correct configuration, and invokes the CGV API.

model
Name of the Simulink model to execute

dataFile

Name of the data file or a structure that contains the input data.
Data can be generated either by:
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¢ Analyzing the model using the Simulink Design Verifier
software.

¢ Using the slvnvlogsignals function.

runOpts
A structure whose fields specify the configuration of
slvnvruncgvtest.
Field Name Description
testIdx Test case index array to simulate from
dataFile.
If testIdx = [] (the default),
slvnvruncgvtest simulates all test
cases.
outputFormat Specifies format of output values:

e 'TimeSeries' (default) —
slvnvruncgvtest stores output
values in time-series format.

® 'StructureWithTime' —
slvnvruncgvtest stored output
values in the Structure with time
format.
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Field Name

Description

allowCopyModel

Specifies to create and configure the model
if you have not configured it correctly for
executing test cases with the CGV APL

If true and you have not configured model
correctly to execute test cases with the CGV
API, slvnvruncgvtest copies the model,
corrects the configuration, and executes the
test cases on the copied model.

If false (the default), an error occurs if the
tests cannot execute with the CGV API.

Note If you have not configured the
top-level model or any referenced models
correctly, slvnvruncgvtest does not copy
the model, even if allowCopyModel is true.
An error occurs.

cgvComType

Defines the software-in-the-loop (SIL) or
processor-in-the-loop (PIL) approach for
CGV:

e 'topmodel' (default)

® 'modelblock’

cgvConn

Specifies mode of execution for CGV:
e 'sim' (default)
® 'sil'

® 'tasking'
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Output
Arguments

Examples

See Also

Note runOpts = slvnvruntestopts('cgv') returns a runOpts
structure with the default values for each field.

cgvObject

cgv.CGV object that slvnvruncgvtest creates during the
execution of model.

Open the sldemo_mdlref bus demo model and log the input signals
to the CounterA Model block. Create the default configuration object
for slvnvruncgvtest, and allow the model to be configured correctly
to execute test cases with the CGV API. Using the logged signals,
execute slvnvruncgvtest—first in simulation mode, and then in
Software-in-the-Loop (SIL) mode—to invoke the CGV API and execute
the specified test cases on the generated code for the model. Use the
CGV API to compare the results of these two executions:

open_system('sldemo_mdlref_bus');

load_system('sldemo_mdlref_counter_bus');

loggedData = slvnvlogsignals('sldemo_mdlref_bus/CounterA');

runOpts = slvnvruntestopts('cgv');

runOpts.allowCopyModel = true;

cgvObjectSim = slvnvruncgvtest('sldemo_mdlref_counter_bus',
loggedData, runOpts);

runOpts.cgvConn = 'sil';

cgvObjectSil = slvnvruncgvtest('sldemo_mdlref_counter_bus',
loggedData, runOpts);

simout = cgvObjectSim.getOutputData(1);

silout = cgvObjectSil.getOutputData(1);

[matchNames, ~, mismatchNames, ~ ] = ...

cgv.CGV.compare(simout, silout);

fprintf('\nTest Case: %d Signals match, %d Signals mismatch',

length(matchNames), length(mismatchNames));

cgv.CGV | slvnvlogsignals | slvnvruntest | slvnvruntestopts
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Purpose

Syntax

Description

Tips

Input
Arguments
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Simulate model using test cases

outData = slvnvruntest(model, dataFile)
outData = slvnvruntest(model, dataFile, runOpts)
[outData, covData] = slvnvruntest(model, dataFile, runOpts)

outData = slvnvruntest(model, dataFile) simulates model using
all the test cases in dataFile. outData is a struct array that contains
the results of all the simulations.

outData = slvnvruntest(model, dataFile, runOpts) simulates
model using all the test cases in dataFile. runOpts defines the options
for simulating the test cases.

[outData, covData] = slvnvruntest(model, dataFile, runOpts)
simulates model using the test cases in dataFile. When the runOpts
field coverageEnabled is true, the Simulink Verification and
Validation software collects model coverage information during the
simulation. slvnvruntest returns the coverage data in the cvdata
object covData.

The dataFile that you create with a Simulink Design Verifier analysis
or by running slvnvlogsignals contains time values and data values.
When you simulate a model using these test cases, you may see missing
coverage. This problem occurs when the time values in the dataFile
are not aligned with the current simulation time step due to numeric
calculation differences. You see this problem more frequently with
multirate models, models that have multiple sample times.

model
Name or handle of the Simulink model to simulate
dataFile

Name of the data file or structure that contains the input data.
You can generate dataFile using the Simulink Design Verifier
software, or by running the slvnvlogsignals function.
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runOpts

A structure whose fields specify the configuration of

slvnvruntest.

Field

Description

testIdx

Test case index array to
simulate from dataFile. If
testIdxis [], slvnvruntest
simulates all test cases.

Default: []

outputFormat

Specifies format of outData:

® 'TimeSeries' (default) —
slvnvruntest stores output
values in time-series format.

® 'StructureWithTime' —
slvnvruntest stores output
values in the Structure
with time format.

coverageEnabled

If true, specifies that the
Simulink Verification and
Validation software collect
model coverage data during
simulation.

Default: false

coverageSetting

cvtest object for collecting
model coverage. If [],
slvnvruntest uses the
existing coverage settings for
model.

Default: []
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Output
Arguments

Examples

See Also

3-208

outData

A structure array containing the simulation results.

covData

cvdata object that contains the model coverage data collected
during simulation.

Open the sldemo_mdlref bus demo model and log the input signals to
the CounterA Model block. Then, using the logged signals, simulate the
model referenced in the Counter block:

open_system('sldemo_mdlref_bus');

loggedData = slvnvlogsignals('sldemo_mdlref_bus/CounterA');

runOpts = slvnvruntestopts;

runOpts.coverageEnabled = true

open_system('sldemo_mdlref_counter_bus');

[ outData, initialCov ] = slvnvruntest('sldemo_mdlref_counter_bus',...
loggedData, runOpts);

cvhtml('Initial coverage', initialCov);

cvsim | cvtest | sim | slvnvruntestopts
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Purpose
Syntax

Description

Output
Arguments

Generate simulation or execution options for slvnvruntest or
slvnvruncgvtest

runOpts = slvnvruntestopts
runOpts = slvnvruntestopts('cgv')

runOpts = slvnvruntestopts generates a runOpts structure for
slvnvruntest.

runOpts = slvnvruntestopts('cgv') generates a runOpts structure
for slvnvruncgvtest

runOpts

A structure whose fields specify the configuration of slvnvruntest
or slvnvruncgvtest. runOpts can have the following fields. If
you do not specify a field, slvnvruncgvtest or slvnvruntest
uses the default value.

Field Name Description

testIdx Test case index array to simulate or
execute from dataFile.

If testIdx = [] (default), all test cases
are simulated or executed.

outputFormat Specifies format of output values:

e 'TimeSeries' (the default) —
slvnvruntest/slvnvruncgvtest stores
the output values in time-series format.

® 'StructureWithTime' —
slvnvruntest/slvnvruncgvtest
stores the output values in the
Structure with time format.
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Field Name

Description

coverageEnabled

Available only for slvnvruntest

If true, slvnvruntestcollects model
coverage data during simulation.

Default: false

coverageSetting

Available only for slvnvruntest.

cvtest object to use for collecting model
coverage.

If coverageSettingis [], slvnvruntest
uses the coverage settings for the model
specified in the call to slvnvruntest.

Default: []

allowCopyModel
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Available only for slvnvruncgvtest

Specifies to create and configure the model
if you have not configured it correctly for
executing test cases with the CGV APIL.

If true and you have not configured
the model correctly for executing

test cases with the CGV API,
slvnvruncgvtest copies the model,
corrects the configuration, and executes
the test cases on the copied model.

If false (the default), an error occurs if
the tests cannot execute with the CGV
API.
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Field Name Description

Note If you have not configured the
top-level model or any referenced models
correctly, slvnvruncgvtest does not copy
the model, even if allowCopyModel is
true. An error occurs.

cgvComType Available only for slvnvruncgvtest.

Defines the software-in-the-loop (SIL) or

processor-in-the-loop (PIL) approach for
CGV:

e 'topmodel' (default)
® 'modelblock

cgvConn Only available for slvnvruncgvtest.

Specifies mode of execution for CGV:

e 'sim' (default)

e 'sil'
® 'tasking'
Examples Create runOpts objects for slvnvruntest and slvnvruncgvtest:
runtest_opts = slvnvruntestopts; ! Create options for slvnvruntest
runcgvtest_opts = slvnvruntestopts('cgv') ! Create options for slvnvruncgvtest

Alternatives Create a runOpts object at the MATLAB command line.

See Also slvnvruncgvtest | slvnvruntest
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Purpose

Syntax

Description

Input
Arguments
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Display lookup table coverage information for model object

coverage = tableinfo(cvdo, object)

coverage tableinfo(cvdo, object, ignore_descendants)
[coverage, exeCounts] = tableinfo(cvdo, object)

[coverage, exeCounts, brkEquality] = tableinfo(cvdo, object)

coverage = tableinfo(cvdo, object) returns lookup table coverage
results from the cvdata object cvdo for the model component object.

coverage = tableinfo(cvdo, object, ignore_descendants)
returns lookup table coverage results for object, depending on the
value of ignore_descendants.

[coverage, exeCounts] = tableinfo(cvdo, object) returns
lookup table coverage results and the execution count for each
interpolation/extrapolation interval in the lookup table block object.

[coverage, exeCounts, brkEquality] = tableinfo(cvdo,
object) returns lookup table coverage results, the execution count for
each interpolation/extrapolation interval, and the execution counts for
breakpoint equality.

cvdo
cvdata object

ignore_descendants

Logical value specifying whether to ignore the coverage of
descendant objects

1 — Ignore coverage of descendant objects
0 — Collect coverage for descendant objects

object

Full path or handle to a lookup table block or a model containing
a lookup table block.



tableinfo

Output brkEquality

Arguments A cell array containing vectors that identify the number of

times during simulation that the lookup table block input was
equivalent to a breakpoint value. Each vector represents the
breakpoints along a different lookup table dimension.

coverage

The value of coverage is a two-element vector of form
[covered _intervals total intervals], the elements of which

are:
covered_intervals Number of
interpolation/extrapolation
intervals satisfied for object
total intervals Total number of

interpolation/extrapolation
intervals for object

coverage is empty if cvdo does not contain lookup table coverage
results for object.

execounts

An array having the same dimensionality as the lookup table
block; its size has been extended to allow for the lookup table
extrapolation intervals.

Examples Collect lookup table coverage for the slvnvdemo_cv_small_controller
model and determine the percentage of interpolation/extrapolation
intervals coverage collected for the Gain Table block in the Gain
subsystem:

mdl = 'slvnvdemo_cv_small_controller';

open_system(mdl)

testObj = cvtest(mdl) %Create test spec object
testObj.settings.tableExec

1}
-

%Enable lookup table coverage
data = cvsim(testObj) %Simulate the model
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Alternatives

See Also

How To
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blk_handle = get_param([mdl, '/Gain/Gain Table'], 'Handle');
cov = tableinfo(data, blk_handle) %Retrieve 1/u table coverage
percent_cov = 100 * cov(1) / cov(2) %Percent MC/DC outcomes covered

To collect lookup coverage for a model:
1 Open the model.
2 In the Model Editor, select Tools > Coverage Settings.

3 On the Coverage tab, under Coverage Metrics, select Look-up
Table Coverage.

4 On the Results and Report tabs, select the desired options.
5 Click OK to close the Coverage Settings dialog box.

6 Simulate the model and review the lookup table coverage in the
report.

complexityinfo | conditioninfo | cvsim | decisioninfo |
getCoveragelInfo | mcdcinfo | sigrangeinfo | sigsizeinfo

“Lookup Table Coverage”



ModelAdyvisor.ListViewParameter.Attributes property

Purpose Attributes to display in Model Advisor Report Explorer

Values Cell array
Default: {} (empty cell array)

Descrlphon The Attributes property specifies the attributes to display in the
center pane of the Model Advisor Results Explorer.
Examples % define list view parameters
myLVParam = ModelAdvisor.ListViewParameter;
myLVParam.Name = 'Invalid font blocks'; % the name appeared at pull down filter

myLVParam.Data = get_param(searchResult, 'object')"';
myLVParam.Attributes = {'FontName'}; % name is default property
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ModelAdvisor.Check.CallbackContext property

Purpose

Values

Description
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Specify when to run check

‘PostCompile’
‘None' (default)

The CallbackContext property specifies the context for checking the
model or subsystem.

'"None' No special requirements for the model before
checking.
'Postcompile’ The model must be compiled.



ModelAdvisor.Check.CallbackHandle property
|

Purpose Callback function handle for check

Values Function handle.
An empty handle [ ] is the default.

Description The CallbackHandle property specifies the handle to the check callback
function.
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ModelAdvisor.Check.CallbackStyle property

Purpose Callback function type
Values 'StyleOne' (default)
‘StyleTwo'
‘StyleThree'
Description The CallbackStyle property specifies the type of the callback function.
'StyleOne’ Simple check callback function
'StyleTwo' Detailed check callback function
'StyleThree' Check callback function with hyperlinked

results
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ModelAdyvisor.ListViewParameter.Data property

Purpose

Values

Description

Examples

Objects in Model Advisor Result Explorer

Array of Simulink objects
Default: [] (empty array)

The Data property specifies the objects displayed in the Model Advisor
Result Explorer.

% define list view parameters
myLVParam = ModelAdvisor.ListViewParameter;

myLVParam.Name = 'Invalid font blocks'; % the name appeared at pull down filter

myLVParam.Data = get_param(searchResult, 'object')"';
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ModelAdvisor.Action.Description property
|

Purpose Message in Action box

Values String
Default:' ' (null string)

Description The Description property specifies the message displayed in the
Action box.
Examples % define action (fix) operation

myAction = ModelAdvisor.Action;
%sSpecify a callback function for the action
myAction.setCallbackFcn(@sampleActionCB);
myAction.Name='Fix block fonts';
myAction.Description=...
'Click the button to update all blocks with specified font';
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ModelAdvisor.FactoryGroup.Description property
|

Purpose Description of folder

Values String
Default: '' (null string)

Description The Description property provides information about the folder.
Details about the folder are displayed in the right pane of the Model
Advisor.

Examples % --- sample factory group

rec = ModelAdvisor.FactoryGroup('com.mathworks.sample.factorygroup');
rec.Description="'Demo Factory Group';
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ModelAdvisor.Group.Description property
|

Purpose Description of folder

Values String
Default: '' (null string)

Description The Description property provides information about the folder.
Details about the folder are displayed in the right pane of the Model
Advisor.

Examples MAG = ModelAdvisor.Group('com.mathworks.sample.GroupSample');

MAG.Description='This is my group';
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ModelAdvisor.InputParameter.Description property

Purpose Description of input parameter

Values String.
Default: '' (null string)

Description The Description property specifies a description of the input
parameter. Details about the check are displayed in the right pane of
the Model Advisor.

Examples % define input parameters
inputParam2 = ModelAdvisor.InputParameter;
inputParam2.Name = 'Standard font size';
inputParam2.Value='12";
inputParam2.Type='String';
inputParam2.Description="'sample tooltip';
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ModelAdvisor.Task.Description property

Purpose

Values

Description

Examples
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Description of task

String

Default: '' (null string)

The Description property is a description of the task that the Model
Advisor displays in the Analysis box.

When adding checks as tasks, the Model Advisor uses the task
Description property instead of the check TitleTips property.

MAT1
MAT1
MAT1

MAT2

MAT2.

MAT2

MAT3

MAT3.
MAT3.

= ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');

.DisplayName='Example task 1';
.Description='This is the first example task.'

= ModelAdvisor.Task('com.mathworks.sample.TaskSample2');
DisplayName='Example task 2';

.Description="'This is the second example task.'

= ModelAdvisor.Task('com.mathworks.sample.TaskSample3');
DisplayName='Example task 3';
Description='This is the third example task.'



ModelAdvisor.FactoryGroup.DisplayName property

Purpose

Values

Description

Examples

Name of folder

String
Default:' ' (null string)

The DisplayName specifies the name of the folder that is displayed in
the Model Advisor.

% --- sample factory group
rec = ModelAdvisor.FactoryGroup('com.mathworks.sample.factorygroup');
rec.DisplayName='Demo Factory Group';
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ModelAdvisor.Group.DisplayName property

Purpose Name of folder

Values String
Default:' ' (null string)

Description The DisplayName specifies the name of the folder that is displayed in
the Model Advisor.

Examples MAG = ModelAdvisor.Group('com.mathworks.sample.GroupSample');
MAG.DisplayName='My Group';
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ModelAdvisor.Task.DisplayName property
|

Purpose Name of task

Values String
Default: '' (null string)

Description The DisplayName property specifies the name of the task. The Model
Advisor displays each custom task in the tree using the name of the
task. Therefore, you should specify a unique name for each task. When
you specify the same name for multiple tasks, the Model Advisor
generates a warning.

When adding checks as tasks, the Model Advisor uses the task
DisplayName property instead of the check Title property.

E)(CII'1')I€ES MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');
MAT1.DisplayName='Example task with input parameter and auto-fix ability';

MAT2 = ModelAdvisor.Task('com.mathworks.sample.TaskSample2');
MAT2.DisplayName='Example task 2';

MAT3 = ModelAdvisor.Task('com.mathworks.sample.TaskSample3');
MAT3.DisplayName='Example task 3';
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ModelAdvisor.Check.Enable property

Purpose

Values

Description
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Indicate whether user can enable or disable check

true (default)
false

The Enable property specifies whether the user can enable or disable
the check.

true Display the check box control
false Hide the check box control



ModelAdvisor.Task.Enable property

Purpose

Values

Description

Examples

Indicate if user can enable and disable task

true (default)
false

The Enable property specifies whether the user can enable or disable
a task.

true (default) Display the check box control for task
false Hide the check box control for task

When adding checks as tasks, the Model Advisor uses the task Enable
property instead of the check Enable property.

MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');
MAT1.Enable ='false';
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ModelAdvisor.InputParameter.Entries property
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Purpose
Values

Description

Examples

Drop-down list entries
Depends on the value of the Type property.

The Entries property is valid only when the Type property is one of
the following:

® Enum

® ComboBox

® PushButton

inputParam3 = ModelAdvisor.InputParameter;
inputParam3.Name='Valid font';
inputParam3.Type="'Combobox';
inputParam3.Description="'sample tooltip';
inputParam3.Entries={'Arial', 'Arial Black'};



ModelAdvisor.Check.ID property

Purpose

Values

Description

Identifier for check

String
Default: '' (null string)

The ID property specifies a permanent, unique identifier for the check.
Note the following about the ID property:

® You must specify this property.

e The value of ID must remain constant.

The Model Advisor generates an error if ID is not unique.

Tasks and factory group definitions must refer to checks by ID.
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ModelAdvisor.FactoryGroup.ID property
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Purpose
Values

Description

Identifier for folder
String

The ID property specifies a permanent, unique identifier for the folder.

Note

® You must specify this field.
® The value of ID must remain constant.
¢ The Model Advisor generates an error if ID is not unique.

¢ Group definitions must refer to other groups by ID.




ModelAdvisor.Group.ID property

Purpose
Values

Description

Identifier for folder

String

The ID property specifies a permanent, unique identifier for the folder.

Note

® You must specify this field.
® The value of ID must remain constant.
¢ The Model Advisor generates an error if ID is not unique.

¢ Group definitions must refer to other groups by ID.
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ModelAdvisor.Task.ID property
|

Purpose Identifier for task

Values String
Default: '' (null string)

Description The ID property specifies a permanent, unique identifier for the task.

Note

¢ The Model Advisor automatically assigns a string to ID if you do
not specify it.

® The value of ID must remain constant.

¢ The Model Advisor generates an error if ID is not unique.

¢ Group definitions must refer to tasks using ID.

Examples MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');
MAT1.ID='Task_ID_1234';
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ModelAdvisor.Check.LicenseName property

Purpose

Values

Description

Product license names required to display and run check

Cell array of product license names

{}(empty cell array) (default)

The LicenseName property specifies a cell array of names for product
licenses required to display and run the check.

When the Model Advisor starts, it tests whether the product license
exists. If you do not meet the license requirements, the Model Advisor
does not display the check.

The Model Advisor performs a checkout of the product licenses when you
run the custom check. If you do not have the product licenses available,
you see an error message that the required license is not available.

Tip To find the correct text for license strings, type help license at
the MATLAB command line.
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ModelAdvisor.Task.LicenseName property

Purpose

Values

Description
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Product license names required to display and run task

Cell array of product license names

Default: {} (empty cell array)

The LicenseName property specifies a cell array of names for product
licenses required to display and run the check.

When the Model Advisor starts, it tests whether the product license
exists. If you do not meet the license requirements, the Model Advisor
does not display the check.

The Model Advisor performs a checkout of the product licenses when you
run the custom check. If you do not have the product licenses available,
you see an error message that the required license is not available.

If you specify ModelAdvisor.Check.LicenseName, the Model Advisor
displays the check when the union of both properties is true.

Tip To find the correct text for license strings, type help license at
the MATLAB command line.




ModelAdvisor.Check.ListViewVisible property

Purpose

Values

Description

Examples

Status of Explore Result button

false (default)
true

The ListViewVisible property is a Boolean value that sets the status
of the Explore Result button.

true Display the Explore Result button.
false Hide the Explore Result button.

% add 'Explore Result' button
rec.ListViewVisible = true;
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ModelAdvisor.FactoryGroup.MAODbj property

Purpose Model Advisor object

Values Handle to a Simulink.ModelAdvisor object

Description The MAObj property specifies a handle to the current Model Advisor
object.
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ModelAdvisor.Group.MAObj property
|

Purpose Model Advisor object

Values Handle to Simulink.ModelAdvisor object

Description The MAObj property specifies a handle to the current Model Advisor
object.
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ModelAdvisor.Task.MAODbj property

Purpose Model Advisor object
Values Handle to a Simulink.ModelAdvisor object
Description The MAObj property specifies the current Model Advisor object.

When adding checks as tasks, the Model Advisor uses the task MAObj
property instead of the check MAObj property.
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cv.cvdatagroup.name property

Purpose cv.cvdatagroup object name
Values name
Description The name property specifies the name of the cv.cvdatagroup object.
Examples cvdg = cvsimref (topModelName, cvtg);
cvdg.name = 'My Data_Group';
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cv.cvtestgroup.name property

Purpose cv.cvtestgroup object name
Value name
Description The name property specifies the name of the cv.cvtestgroup object.
Examples cvtol = cvtest('TopModel');
cvto2 = cvtest('SubModell');

cvto3 = cvtest('SubModel2');
cvtg = cv.cvtestgroup(cvtol, cvto2, cvto3);
cvtg.name = 'My_Test_Group';

See Also cvtest
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ModelAdvisor.Action.Name property
|

Purpose Action button label

Values String
Default: '' (null string)

Description The Name property specifies the label for the action button. This
property is required.

Examples % define action (fix) operation
myAction = ModelAdvisor.Action;
%sSpecify a callback function for the action
myAction.setCallbackFcn(@sampleActionCB);
myAction.Name='Fix block fonts';
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ModelAdvisor.InputParameter.Name property

Purpose Input parameter name

Values String.
Default: '' (null string)

Description The Name property specifies the name of the input parameter in the
custom check.
Examples inputParam2 = ModelAdvisor.InputParameter;
inputParam2.Name = 'Standard font size';

inputParam2.Value='12";
inputParam2.Type='String';
inputParam2.Description="'sample tooltip';
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ModelAdyvisor.ListViewParameter.Name property

Purpose Drop-down list entry

Values String
Default: '' (null string)

Descrlphon The Name property specifies an entry in the Show drop-down list in the
Model Advisor Result Explorer.
Examples % define list view parameters
myLVParam = ModelAdvisor.ListViewParameter;
myLVParam.Name = 'Invalid font blocks'; % the name appeared at pull down filter
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ModelAdvisor.Check.Result property

Purpose Results cell array

Values Cell array
Default: {} (empty cell array)

Descripl‘ion The Result property specifies the cell array for storing the results that
are returned by the callback function specified in CallbackHandle.

Tip To set the icon associated with the check, use the
Simulink.ModelAdvisor setCheckResultStatus and
setCheckErrorSeverity methods.
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ModelAdvisor.Check.Title property
|

Purpose Name of check

Values String
Default: '' (null string)

Description The Title property specifies the name of the check in the Model
Advisor. The Model Advisor displays each custom check in the tree
using the title of the check. Therefore, you should specify a unique title
for each check. When you specify the same title for multiple checks, the
Model Advisor generates a warning.

Examples rec = ModelAdvisor.Check('com.mathworks.sample.Checkl');
rec.Title = 'Check Simulink block font';
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ModelAdvisor.Check.TitleTips property

Purpose Description of check

Values String
Default: '' (null string)

Description The TitleTips property specifies a description of the check. Details
about the check are displayed in the right pane of the Model Advisor.

Examples rec = ModelAdvisor.Check('com.mathworks.sample.Checkl');

rec.Title = 'Check Simulink block font';
rec.TitleTips = 'Example style three callback';
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ModelAdvisor.InputParameter.Type property

Purpose

Values String.
Default:

Description

Use the Type property with the Value and Entries properties to define

Input parameter type

(null string)

input parameters.

The Type property specifies the type of input parameter.

Valid values are listed in the following table.

Type Data Default Description
Type Value
Bool Boolean | false A check box
ComboBox Cell First entry in | A drop-down menu
array the list e Use Entries to define the
entries in the list.

e Use Value to indicate a
specific entry in the menu
or to enter a value not in
the list.

Enum Cell First entry in | A drop-down menu
array the list e Use Entries to define the

entries in the list.

e Use Value to indicate a
specific entry in the list.
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ModelAdvisor.InputParameter.Type property

Examples

3-250

Type Data Default Description
Type Value
PushButton | N/A N/A A button

When you click the button,
the callback function
specified by Entries is
called.

String String "' (null A text box

string)

% define input parameters

inputParami = ModelAdvisor.InputParameter;
inputParami.Name = 'Skip font checks.';
inputParami.Type = 'Bool’;
inputParami.Value = false;



ModelAdvisor.Check.Value property

Purpose

Values

Description

Examples

Status of check

"true' (default)
'false'

The Value property specifies the initial status of the check.

"true' Check 1s enabled
‘false' Check is disabled

% hide all checks that do not belong to Demo group

if ~(strcmp(checkCellArray{i}.Group, 'Demo'))
checkCellArray{i}.Visible = false;
checkCellArray{i}.Value = false;

end
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ModelAdvisor.InputParameter.Value property

Purpose
Values

Description

Examples
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Value of input parameter
Depends on the Type property.

The Value property specifies the initial value of the input parameter.
This property is valid only when the Type property is one of the
following:

® 'Bool’
® 'String’
® 'Enum'

e 'ComboBox"'

% define input parameters

inputParami = ModelAdvisor.InputParameter;
inputParami.Name = 'Skip font checks.';
inputParami.Type = 'Bool';
inputParami.Value = false;



ModelAdvisor.Task.Value property
|

Purpose Status of task
Values "true' (default) — Initial status of task is enabled
'false' — Initial status of task is disabled
Description The Value property indicates the initial status of a task—whether it 1s

enabled or disabled.

When adding checks as tasks, the Model Advisor uses the task Value
property instead of the check Value property.

Examples MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');
MAT1.Value ='false';
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view

Purpose
Syntax

Description

Input
Arguments

Examples

Alternatives
See Also

Tutorials
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View Model Advisor run results for checks
view(CheckResultObj)

view(CheckResultObj) opens a web browser and displays the results
of the check specified by CheckResultObj. CheckResultObj is a
ModelAdvisor.CheckResult object returned by ModelAdvisor.run.

CheckResultObj

ModelAdvisor.CheckResult object which is a part
of a ModelAdvisor.SystemResult object returned by
ModelAdvisor.run.

View the Model Advisor run results for the first check in the
slvnvdemo_mdladv_config configuration file:

% Identify Model Advisor configuration file.

% Create list of models to run.

fileName = 'slvnvdemo_mdladv_config.mat';

SysList={'sldemo_auto_climatecontrol/Heater Control',...
'sldemo_auto_climatecontrol/AC Control'};

% Run the Model Advisor.
SysResultObjArray = ModelAdvisor.run(SysList, 'Configuration',fileName);

% View the 'Identify unconnected...' check result.
view(SysResultObjArray{1}.CheckResultObjs(1))

“Viewing the Model Advisor Report”
ModelAdvisor.run | ModelAdvisor.summaryReport | viewReport

“Workflow for Checking Systems Programmatically”
“Checking Multiple Systems in Parallel”



view

How To * “Checking Systems Programmatically”

+ “Archiving and Viewing Results”
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viewReport

Purpose

Syntax

Description

Input
Arguments

Examples
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View Model Advisor run results for systems

viewReport (SysResultObjArray)
viewReport(SysResultObjArray, 'MA")
viewReport (SysResultObjArray, 'Cmd")

viewReport (SysResultObjArray) opens the Model Advisor Report for
the system specified by SysResultObjArray. SysResultObjArrayis a
ModelAdvisor.SystemResult object returned by ModelAdvisor.run.

viewReport (SysResultObjArray, 'MA') opens the Model Advisor
and displays the results of the run for the system specified by
SysResultObjArray.

viewReport(SysResultObjArray, 'Cmd') displays the Model Advisor
run summary in the Command Window for the systems specified by
SysResultObjArray.

SysResultObjArray

ModelAdvisor.SystemResult object returned by
ModelAdvisor.run.

Open the Model Advisor report for
sldemo_auto_climatecontrol/Heater Control

% Identify Model Advisor configuration file.

% Create list of models to run.

fileName = 'slvnvdemo_mdladv_config.mat';

SysList={'sldemo_auto_climatecontrol/Heater Control',...
'sldemo_auto_climatecontrol/AC Control'};

% Run the Model Advisor.
SysResultObjArray = ModelAdvisor.run(SysList, 'Configuration',fileName);

% Open the Model Advisor report.
viewReport(SysResultObjArray{1})



viewReport

Open Model Advisor and display results for
sldemo_auto_climatecontrol/Heater Control.

% Identify Model Advisor configuration file.

% Create list of models to run.

fileName = 'slvnvdemo mdladv_config.mat';

SysList={'sldemo_auto_climatecontrol/Heater Control',...
"sldemo_auto_climatecontrol/AC Control'};

% Run the Model Advisor.
SysResultObjArray = ModelAdvisor.run(SysList, 'Configuration',fileName);

% Open the Model Advisor and display results.
viewReport (SysResultObjArray{1}, 'MA')

Display results in the Command Window for
sldemo_auto_climatecontrol/Heater Control.

% Identify Model Advisor configuration file.

% Create list of models to run.

fileName = 'slvnvdemo mdladv_config.mat';

SysList={'sldemo_auto_climatecontrol/Heater Control',...
'sldemo_auto_climatecontrol/AC Control'};

% Run the Model Advisor.
SysResultObjArray = ModelAdvisor.run(SysList, 'Configuration',fileName);

% Display results in the Command Window.
viewReport(SysResultObjArray{1}, 'Cmd')

Alternatives ® “Viewing the Model Advisor Report”
* “Viewing Results in the Model Advisor GUT”

* “Viewing Results in the Command Window”
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viewReport

See Also ModelAdvisor.run | ModelAdvisor.summaryReport | view

Tutorials + “Workflow for Checking Systems Programmatically”
* “Checking Multiple Systems in Parallel”

How To * “Checking Systems Programmatically”

+ “Archiving and Viewing Results”
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ModelAdvisor.Check.Visible property

Purpose

Values

Description

Examples

Indicate to display or hide check

"true' (default)
'false'

The Visible property specifies whether the Model Advisor displays
the check.

"true' Display the check
'false' Hide the check

% hide all checks that do not belong to Demo group

if ~(strcmp(checkCellArray{i}.Group, 'Demo'))
checkCellArray{i}.Visible = false;
checkCellArray{i}.Value = false;

end
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ModelAdvisor.Task.Visible property
|

Purpose Indicate to display or hide task

Values 'true' (default) — Display task in the Model Advisor
'false' — Hide task

Description The Visible property specifies whether the Model Advisor displays
the task.

Caution

When adding checks as tasks, you cannot specify both the task and
check Visible properties, you must specify one or the other. If you
specify both properties, the Model Advisor generates an error when the
check Visible property is false.

Examples MAT1 = ModelAdvisor.Task('com.mathworks.sample.TaskSamplel');
MAT1.Visible ='false';
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Block Reference




System Requirements

4-2

Purpose
Library

Description

Dialog
Box and
Parameters

List system requirements in Simulink diagrams
Simulink Verification and Validation

The System Requirements block lists all the system requirements
associated with the model or subsystem depicted in the current
diagram. It does not list requirements associated with individual blocks
in the diagram.

You can place this block anywhere in a diagram. It is not connected to
other Simulink blocks. You can only have one System Requirements
block in a diagram.

When you drag the System Requirements block from the Library
Browser into your Simulink diagram, it is automatically populated with
the system requirements, as shown.

System Requirements

1. "Estimation of mass airflow”

Each of the listed requirements is an active link to the actual
requirements document. When you double-click on a requirement name,
the associated requirements document opens in its editor window,
scrolled to the target location.

If the System Requirements block exists in a diagram, it automatically
updates the requirements listing as you add, modify, or delete
requirements for the model or subsystem.

To access the Block Parameters dialog box for the System Requirements
block, right-click on the System Requirements block and, from

the resulting pop-up menu, select Mask Parameters. The Block
Parameters dialog box opens, as shown.



System Requirements

E! Block Parameters: System Requirements ll

— Syztem Requirements [mask]

Listz the requirements for the current model,

—Parameters

Block. Title

Syztem Reguirements

0K I Cancel Help Apply

The Block Parameters dialog box for the System Requirements block
contains one parameter.

Block Title
The title of the system requirements list in the diagram. The
default title is System Requirements. You can type a customized
title, for example, Engine Requirements.
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System Requirements
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Model Advisor Checks

e “Simulink® Verification and Validation Checks” on page 5-2

* “D0O-178B Checks” on page 5-4

e “IEC 61508 and ISO 26262 Checks” on page 5-74

o “MathWorks Automotive Advisory Board Checks” on page 5-99

® “Requirements Consistency Checks” on page 5-169



5 Model Advisor Checks

Simulink Verification and Validation Checks

In this section...

“Simulink® Verification and Validation Checks Overview” on page 5-2

“Modeling Standards Checks Overview” on page 5-3

Simulink Verification and Validation Checks
Overview

Simulink Verification and Validation checks facilitate designing and
troubleshooting models from which code is generated for applications that
must meet safety or mission-critical requirements, modeling guidelines, or
requirements consistency.

The Model Advisor performs a checkout of the Simulink Verification and
Validation license when you run the Simulink Verification and Validation
checks.

For descriptions of the modeling standards checks, see

e “D0O-178B Checks” on page 5-4
e “IEC 61508 and ISO 26262 Checks” on page 5-74
o “MathWorks Automotive Advisory Board Checks” on page 5-99

For descriptions of the requirements consistency checks, see “Requirements
Consistency Checks” on page 5-169.

See Also

® “Consulting the Model Advisor” in the Simulink documentation
e “Simulink Checks” in the Simulink reference documentation

e “Simulink® Coder™ Checks” in the Simulink Coder documentation

5-2



Simulink® Verification and Validation™ Checks

Modeling Standards Checks Overview

Modeling standards checks facilitate designing and troubleshooting models
from which code is generated for applications that must meet safety or
mission-critical requirements or MathWorks® Automotive Advisory Board
(MAAB) modeling guidelines.

The Model Advisor performs a checkout of the Simulink Verification and
Validation license when you run the modeling standards checks.

For descriptions of the modeling standards checks, see

e “DO-178B Checks” on page 5-4
e “IEC 61508 and ISO 26262 Checks” on page 5-74
e “MathWorks Automotive Advisory Board Checks” on page 5-99

See Also

® “Consulting the Model Advisor” in the Simulink documentation
e “Simulink Checks” in the Simulink reference documentation

e “Simulink Coder Checks” in the Simulink Coder documentation
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5 Model Advisor Checks

DO-178B Checks

In this section...

“D0O-178B Checks Overview” on page 5-5

“Check safety-related optimization settings” on page 5-6

“Check safety-related diagnostic settings for solvers” on page 5-10
“Check safety-related diagnostic settings for sample time” on page 5-13
“Check safety-related diagnostic settings for signal data” on page 5-16
“Check safety-related diagnostic settings for parameters” on page 5-20

“Check safety-related diagnostic settings for data used for debugging” on
page 5-23

“Check safety-related diagnostic settings for data store memory” on page
5-25

“Check safety-related diagnostic settings for type conversions” on page 5-27

“Check safety-related diagnostic settings for signal connectivity” on page
5-30

“Check safety-related diagnostic settings for bus connectivity” on page 5-32

“Check safety-related diagnostic settings that apply to function-call
connectivity” on page 5-34

“Check safety-related diagnostic settings for compatibility” on page 5-36

“Check safety-related diagnostic settings for model initialization” on page
5-38

“Check safety-related diagnostic settings for model referencing” on page
5-40

“Check safety-related model referencing settings” on page 5-43

“Check safety-related code generation settings” on page 5-45

“Check safety-related diagnostic settings for saving” on page 5-52
“Check for model objects that do not link to requirements” on page 5-54
“Check for proper usage of Math blocks” on page 5-55

“Check state machine type of Stateflow charts” on page 5-57




DO-178B Checks

In this section...

“Check Stateflow charts for ordering of states and transitions” on page 5-59
“Check Stateflow debugging settings” on page 5-60

“Check for proper usage of lookup table blocks” on page 5-62

“Check Stateflow charts for uniquely defined data objects” on page 5-64
“Check usage of Math Operations blocks” on page 5-65

“Check usage of Signal Routing blocks” on page 5-67

“Check usage of Logic and Bit Operations blocks” on page 5-68

“Check usage of Ports and Subsystems blocks” on page 5-70

“Display model version information” on page 5-73

DO-178B Checks Overview

DO-178B checks facilitate designing and troubleshooting models from which
code is generated for applications that must meet safety or mission-critical
requirements.

The Model Advisor performs a checkout of the Simulink Verification and
Validation license when you run the DO-178B checks.

See Also

“Consulting the Model Advisor” in the Simulink documentation
¢ “Simulink Checks” in the Simulink reference documentation
e “Simulink Coder Checks” in the Simulink Coder documentation

e Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard


http://www.rtca.org/aboutrtca.asp

5 Model Advisor Checks

Check safety-related optimization settings
Check model configuration for optimization settings that can impact safety.

Description

This check verifies that model optimization configuration parameters are set
optimally for generating code for a safety-related application. Although highly
optimized code is desirable for most real-time systems, some optimizations
can have undesirable side effects that impact safety.

Results and Recommended Actions

Condition

Recommended Action

Block reduction optimization is selected.
This optimization can remove blocks from
generated code, resulting in requirements
with no associated code and violations for
traceability requirements. (See DO-178B,
Section 6.3.4e—Source code is traceable to
low-level requirements.)

Clear the Block reduction check box on
the Optimization pane of the Configuration
Parameters dialog box or set the parameter
BlockReduction to off.

Implementation of logic signals as Boolean
data is cleared. Strong data typing is
recommended for safety-related code.

(See DO-178B, Section 6.3.1e—High-level
requirements conform to standards,
DO-178B, Section 6.3.2e—Low-level
requirements conform to standards, and
MISRA-C:2004, Rule 12.6'.)

Select Implement logic signals as boolean
data (vs. double) on the Optimization pane of
the Configuration Parameters dialog box or set
the parameter BooleanDataType to on.
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Condition

Recommended Action

The model includes blocks that depend on
elapsed or absolute time and is configured to
minimize the amount of memory allocated
for the timers. Such a configuration limits
the number of days the application can
execute before a timer overflow occurs.
Many aerospace products are powered on
continuously and timers should not assume
a limited lifespan. (See DO-178B, Section
6.3.1g—Algorithms are accurate, DO-178B,
Section 6.3.2g—Algorithms are accurate,
and MISRA-C:2004, Rule 12.112)

Set Application lifespan (days) on the
Optimization pane of the Configuration
Parameters dialog box or set the parameter
LifeSpan to inf.

The optimization that suppresses the
generation of initialization code for
root-level inports and outports that are
set to zero 1s selected. For safety-related
code, you should explicitly initialize

all variables. (See DO-178B, Section
6.3.3b—Software architecture is consistent
and MISRA-C:2004, Rule 9.13.)

If you have a Embedded Coder license, and you
are using an ERT-based system target file, clear
the Remove root level I/0 zero initialization
check box on the Optimization pane of the
Configuration Parameters dialog box or set the

parameter ZeroExternalMemoryAtStartup to on.

Alternatively, integrate external, hand-written
code that initializes all I/O variables to zero
explicitly.

The optimization that suppresses the
generation of initialization code for internal
work structures, such as block states and
block outputs that are set to zero, is selected.
For safety-related code, you should explicitly
initialize all variables. (See DO-178B,
Section 6.3.3b—Software architecture is
consistent and MISRA-C:2004, Rule 9.13)

If you have a Embedded Coder license, and you
are using an ERT-based system target file, clear
the Remove internal data zero initialization
check box on the Optimization pane of the
Configuration Parameters dialog box or set the

parameter ZeroInternalMemoryAtStartup to on.

Alternatively, integrate external, hand-written
code that initializes all state variables to zero
explicitly.

5-7
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Condition

Recommended Action

The optimization that suppresses generation
of code resulting from floating-point to
integer conversions that wrap out-of-range
values is cleared. You must avoid
overflows for safety-related code. When
this optimization is off and your model
includes blocks that disable the Saturate
on overflow parameter, the code generator
wraps out-of-range values for those blocks.
This can result in unreachable and,
therefore, untestable code. (See DO-178B,
Section 6.3.1g—Algorithms are accurate,
DO-178B, Section 6.3.2g—Algorithms are
accurate, and MISRA-C:2004, Rule 12.112))

If you have a Simulink Coder license, select
Remove code from floating-point to integer
conversions that wraps out-of-range values
on the Optimization pane of the Configuration
Parameters dialog box or set the parameter
EfficientFloat2IntCast to on.

The optimization that suppresses generation
of code that guards against division by
zero for fixed-point data is selected. You
must avoid division-by-zero exceptions in
safety-related code. (See DO-178B, Section
6.3.1g—Algorithms are accurate, DO-178B,
Section 6.3.2g—Algorithms are accurate,
and MISRA-C:2004, Rule 21.1%))

If you have a Embedded Coder license, and
you are using an ERT-based system target file,
clear the Remove code that protects against
division arithmetic exceptions check box on
the Optimization pane of the Configuration
Parameters dialog box or set the parameter
NoFixptDivByZeroProtection to off.

The optimization that uses the specified
minimum and maximum values for signals
and parameters to optimize the generated
code is selected. This might result in
requirements without traceable code. (See
DO-178B Section 6.3.4e - Source code is
traceable to low-level requirements.)

If you have a Embedded Coder license, and
you are using an ERT-based system target

file, clear the “Optimize using the specified
minimum and maximum values” check box
on the Optimization pane of the Configuration
Parameters dialog box.

IMISRA-C:2004, Rule 12.6 - Operands of logical operators (&&, | | and !) should be effectively
Boolean. Expression that are effectively Boolean should not be used as operands to operators

other than (&&, | | or!).

2MISRA-C:2004, Rule 12.11 - Evaluation of constant unsigned expression should not lead

to wraparound.

SMISRA-C:2004, Rule 9.1 - All automatic variables shall have been assigned a value before

being used.
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Condition

Recommended Action

4MISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be ensured by the use of at
least one of the following:

e Static verification tools/techniques.

¢ Dynamic verification tools/techniques.

¢ Explicit coding of checks to handle runtime faults.

Action Results

Clicking Modify Settings configures model optimization settings that can
impact safety.

See Also

® “Optimization Pane: General” in the Simulink graphical user interface
documentation

® “Optimizing Generated Code” in the Simulink Coder documentation

® “Tips for Optimizing the Generated Code” in the Embedded Coder
documentation

® Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard


http://www.rtca.org/aboutrtca.asp
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Check safety-related diagnostic settings for solvers
Check model configuration for diagnostic settings that apply to solvers and

that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to solvers are set optimally for generating code for a safety-related application.

Results and Recommended Actions

Condition

Recommended Action

The diagnostic for detecting automatic
breakage of algebraic loops is set to none
or warning. The breaking of algebraic
loops can affect the predictability of the
order of block execution. For safety-related
applications, a model developer needs

to know when such breaks occur. (See
DO-178B, Section 6.3.3e — Software
architecture conforms to standards.)

Set Algebraic loop on the Diagnostics > Solver
pane of the Configuration Parameters dialog box
or set the parameter AlgebraicLoopMsg to error.
Consider breaking such loops explicitly with Unit
Delay blocks to ensure that execution order is
predictable. At a minimum, verify that the results
of loops breaking automatically are acceptable.

The diagnostic for detecting automatic
breakage of algebraic loops for Model
blocks, atomic subsystems, and enabled
subsystems is set to none or warning.
The breaking of algebraic loops can affect
the predictability of the order of block
execution. For safety-related applications,
a model developer needs to know when
such breaks occur. (See DO-178B, Section
6.3.3e — Software architecture conforms to
standards.)

Set Minimize algebraic loop on the
Diagnostics > Solver pane of the Configuration
Parameters dialog box or set the parameter
ArtificialAlgebraicLoopMsg to error.
Consider breaking such loops explicitly with Unit
Delay blocks to ensure that execution order is
predictable. At a minimum, verify that the results
of loops breaking automatically are acceptable.
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Condition Recommended Action

The diagnostic for detecting potential Set Block priority violation on the

conflict in block execution order is set Diagnostics > Solver pane of the Configuration
to none or warning. For safety-related Parameters dialog box or set the parameter
applications, block execution order must BlockPriorityViolationMsg to error.

be predictable. A model developer needs to
know when conflicting block priorities exist.
(See DO-178B, Section 6.3.3b — Software
architecture is consistent.)

The diagnostic for detecting whether a model | Set Unspecified inheritability of sample

contains an S-function that has not been times on the Diagnostics > Solver pane of the
specified explicitly to inherit sample time Configuration Parameters dialog box or set the
1s set to none or warning. These settings parameter UnknownTs1lnhSupMsg to error.

can result in unpredictable behavior. A
model developer needs to know when such
an S-function exists in a model so it can be
modified to produce predictable behavior.
(See DO-178B, Section 6.3.3e — Software
architecture conforms to standards.)

The diagnostic for detecting whether the Set Automatic solver parameter selection
Simulink software automatically modifies on the Diagnostics > Solver pane of the

the solver, step size, or simulation stop time | Configuration Parameters dialog box or set the
1s set to none or warning. Such changes parameter SolverPrmCheckMsg to error.

can affect the operation of generated
code. For safety-related applications, it is
better to detect such changes so a model
developer can explicitly set the parameters
to known values. (See DO-178B, Section
6.3.3e — Software architecture conforms to
standards.)

The diagnostic for detecting when a name Set State name clash on the

is used for more than one state in the Diagnostics > Solver pane of the Configuration
model is set to none. State names within a | Parameters dialog box or set the parameter
model should be unique. For safety-related | StateNameClashWarn to warning.

applications, it is better to detect name
clashes so a model developer can correct
them. (See DO-178B, Section 6.3.3b —
Software architecture is consistent.)
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Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
solvers and that can impact safety.

See Also

¢ Diagnostics Pane: Solver in the Simulink graphical user interface
documentation

¢ Diagnosing Simulation Errors in the Simulink documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard


http://www.rtca.org/aboutrtca.asp

DO-178B Checks

Check safety-related diagnostic settings for sample
time

Check model configuration for diagnostic settings that apply to sample time
and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to sample times are set optimally for generating code for a safety-related
application.

Results and Recommended Actions

Condition Recommended Action

The diagnostic for detecting when a source | Set Source block specifies -1 sample time on
block, such as a Sine Wave block, inherits the Diagnostics > Sample Time pane of the

a sample time (specified as -1) is set to Configuration Parameters dialog box or set the
none or warning. The use of inherited parameter InheritedTs1lnSrcMsg to error.
sample times for a source block can result
in unpredictable execution rates for the
source block and blocks connected to it.
For safety-related applications, source
blocks should have explicit sample times
to prevent incorrect execution sequencing.
(See DO-178B, Section 6.3.3e — Software
architecture conforms to standards.)

The diagnostic for detecting whether the Set Discrete used as continuous on the
input for a discrete block, such as the Diagnostics > Sample Time pane of the
Unit Delay block, is a continuous signal Configuration Parameters dialog box or set the
is set to none or warning. Signals with parameter DiscreteInheritContinuousMsg to

continuous sample times should not be used | error.
for embedded real-time code. (See DO-178B,
Section 6.3.3e — Software architecture
conforms to standards.)
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Condition

Recommended Action

The diagnostic for detecting invalid rate
transitions between two blocks operating in
multitasking mode is set to none or warning.
Such rate transitions should not be used for
embedded real-time code. (See DO-178B,
Section 6.3.3b — Software architecture is
consistent.)

Set Multitask rate transition on the
Diagnostics > Sample Time pane of the
Configuration Parameters dialog box or set the
parameter MultiTaskRateTransMsg to error.

The diagnostic for detecting subsystems
that can cause data corruption or
nondeterministic behavior is set to none
or warning. This diagnostic detects
whether conditionally executed multirate
subsystems (enabled, triggered, or
function-call subsystems) operate in
multitasking mode. Such subsystems can
corrupt data and behave unpredictably
in real-time environments that allow
preemption. (See DO-178B, Section 6.3.3b —
Software architecture is consistent.)

Set Multitask conditionally executed
subsystem on the Diagnostics > Sample Time
pane of the Configuration Parameters dialog box
or set the parameter MultiTaskCondExecSysMsg
to error.

The diagnostic for checking sample time
consistency between a Signal Specification
block and the connected destination block is
set to none or warning. An over-specified
sample time can result in an unpredictable
execution rate. (See DO-178B, Section
6.3.3e — Software architecture conforms to
standards.)

Set Enforce sample times specified

by Signal Specification blocks on the
Diagnostics > Sample Time pane of the
Configuration Parameters dialog box or set the
parameter SigSpecEnsureSampleTimeMsg to
error.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
sample time and that can impact safety.
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See Also

® Diagnostics Pane: Sample Time in the Simulink graphical user interface
documentation

® Diagnosing Simulation Errors in the Simulink documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard

5-15
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Check safety-related diagnostic settings for signal

data

Check model configuration for diagnostic settings that apply to signal data
and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to signal data are set optimally for generating code for a safety-related
application.

Results and Recommended Actions

Condition Recommended Action

The diagnostic that specifies how the
Simulink software resolves signals

Set Signal resolution on the
Diagnostics > Data Validity pane of the

associated with Simulink.Signal objects in
the MATLAB workspace is set to Explicit
and implicit or Explicit and warn
implicit. For safety-related applications,
model developers should be required to
define signal resolution explicitly. (See
DO-178B, Section 6.3.3b — Software
architecture is consistent.)

Configuration Parameters dialog box or set
the parameter SignalResolutionControl to
Explicit only. This provides predictable
operation by requiring users to define each
signal and block setting that must resolve to
Simulink.Signal objects in the workspace.

The Product block diagnostic that detects
a singular matrix while inverting one of
its inputs in matrix multiplication mode
is set to none or warning. Division by

a singular matrix can result in numeric
exceptions when executing generated code.
This is not acceptable in safety-related
systems. (See DO-178B, Section 6.3.1g —
Algorithms are accurate, DO-178B, Section
6.3.2g — Algorithms are accurate, and
MISRA-C:2004, Rule 21.11)

Set Division by singular matrix on the
Diagnostics > Data Validity pane of the
Configuration Parameters dialog box or set the
parameter CheckMatrixSingularityMsg to
error.
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Condition

Recommended Action

The diagnostic that detects when the
Simulink software cannot infer the data
type of a signal during data type propagation
1s set to none or warning. For safety-related
applications, model developers must ensure
that all data types are specified correctly.
(See DO-178B, Section 6.3.1e — High-level
requirements conform to standards,
DO-178B and Section 6.3.2e — Low-level
requirements conform to standards.)

Set Underspecified data types on the
Diagnostics > Data Validity pane of the

Configuration Parameters dialog box or set the

parameter UnderSpecifiedDataTypeMsg to
error.

The diagnostic that detects whether the
value of a signal or parameter is too

large to be represented by the signal or
parameter’s data type is set to none or
warning. Undetected numeric overflows
can result in unexpected application
behavior. (See DO-178B, Section 6.3.1g —
Algorithms are accurate, DO-178B, Section
6.3.2g — Algorithms are accurate, and
MISRA-C:2004, Rule 21.11)

Set Detect overflow on the Diagnostics > Data

Validity pane of the Configuration
Parameters dialog box or set the parameter
IntegerOverflowMsg to error.

The diagnostic that detects when the value
of a block output signal is Inf or NaN at
the current time step is set to none or
warning. When this type of block output
signal condition occurs, numeric exceptions
can result, and numeric exceptions

are not acceptable in safety-related
applications. (See DO-178B, Section 6.3.1g —
Algorithms are accurate, DO-178B, Section
6.3.2g — Algorithms are accurate, and
MISRA-C:2004, Rule 21.11)

Set Inf or NaN block output on the
Diagnostics > Data Validity pane of the

Configuration Parameters dialog box or set the

parameter SignalInfNanChecking to error.
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Condition

Recommended Action

The diagnostic that detects Simulink object
names that begin with rt is set to none or
warning. This diagnostic prevents name
clashes with generated signal names that
have an rt prefix. (See DO-178B, Section
6.3.1e — High-level requirements conform
to standards, and DO-178B, Section 6.3.2¢e
— Low-level requirements conform to
standards.)

Set "rt" prefix for identifiers on the
Diagnostics > Data Validity pane of the
Configuration Parameters dialog box or set the
parameter RTPrefix to error.

The diagnostic that detects simulation
range checking is set to none or warning.
This diagnostic detects when signals exceed
their specified ranges during simulation.
Simulink compares the signal values that a
block outputs with the specified range and
the block data type. (See DO-178B, Section
6.3.1g — Algorithms are accurate, DO-178B,
Section 6.3.2g — Algorithms are accurate,
and MISRA-C:2004, Rule 21.11%)

Set Simulation range checking on the
Diagnostics > Data Validity pane of the
Configuration Parameters dialog box or set the
parameter SignalRangeChecking to error.

IMISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be ensured by the use of at

least one of the following:

e Static verification tools/techniques.

¢ Dynamic verification tools/techniques.

¢ Explicit coding of checks to handle runtime faults.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
signal data and that can impact safety.

See Also

¢ Diagnostics Pane: Data Validity in the Simulink graphical user interface

documentation
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® Diagnosing Simulation Errors in the Simulink documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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Check safety-related diagnostic settings for

parameters

Check model configuration for diagnostic settings that apply to parameters
and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to parameters are set optimally for generating code for a safety-related

application.

Results and Recommended Actions

Condition

Recommended Action

The diagnostic that detects when a
parameter downcast occurs is set to none
or warning. A downcast to a lower signal
range can result in numeric overflows

of parameters, resulting in unexpected
behavior. (See DO-178B, Section 6.3.1g —
Algorithms are accurate, DO-178B, Section
6.3.2g — Algorithms are accurate, and
MISRA-C:2004, Rule 21.11)

Set Detect downcast on the

Diagnostics > Data Validity pane of the
Configuration Parameters dialog box or set the
parameter ParameterDowncastMsg to error.

The diagnostic that detects when a
parameter underflow occurs is set to none or
warning. When the data type of a parameter
does not have sufficient resolution, the
parameter value is zero instead of the
specified value. This can lead to incorrect
operation of generated code. (See DO-178B,
Section 6.3.1g — Algorithms are accurate,
DO-178B, Section 6.3.2g — Algorithms are
accurate, and MISRA-C:2004, Rule 21.11)

Set Detect underflow on the

Diagnostics > Data Validity pane of the
Configuration Parameters dialog box or set the
parameter ParameterUnderflowMsg to error.
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Condition

Recommended Action

The diagnostic that detects when a
parameter overflow occurs is set to none or
warning. Numeric overflows can result in
unexpected application behavior and should
be detected and corrected in safety-related
applications. (See DO-178B, Section 6.3.1g —
Algorithms are accurate, DO-178B, Section
6.3.2g — Algorithms are accurate, and
MISRA-C:2004, Rule 21.11)

Set Detect overflow on the Diagnostics > Data

Validity pane of the Configuration
Parameters dialog box or set the parameter
ParameterOverflowMsg to error.

The diagnostic that detects when a
parameter loses precision is set to none or
warning. Not detecting such errors can
result in a parameter being set to an incorrect
value in the generated code. (See DO-178B,
Section 6.3.1g — Algorithms are accurate,
DO-178B, Section 6.3.2g — Algorithms are
accurate, and MISRA-C:2004, Rules 10.12,
10.23, 10.3%, and 10.45.)

Set Detect precision loss on the
Diagnostics > Data Validity pane of the
Configuration Parameters dialog box or set

the parameter ParameterPrecisionLossMsg to

error.

The diagnostic that detects when an
expression with tunable variables is reduced
to its numerical equivalent is set to none

or warning. This can result in a tunable
parameter unexpectedly not being tunable
in generated code. (See DO-178B, Section
6.3.1g — Algorithms are accurate and
DO-178B, Section 6.3.2g — Algorithms are
accurate.)

Set Detect loss of tunability on the
Diagnostics > Data Validity pane of the

Configuration Parameters dialog box or set the

parameter ParameterTunabilitylLossMsg to
error.

IMISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be ensured by the use of at

least one of the following:

e Static verification tools/techniques.

¢ Dynamic verification tools/techniques.

¢ Explicit coding of checks to handle runtime faults.
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Condition Recommended Action

2MISRA-C:2004, Rule 10.1 - The value of an expression of integer type shall not be implicitly
converted to a different underlying type if: it is not a conversion to a wider integer type of the
same signedness, or the expression is complex, or the expression is not constant and is a function
argument, or the expression is not constant and is a return expression.

SMISRA-C:2004, Rule 10.2 - The value of an expression of floating type shall not be implicitly
converted to a different type if it is not a conversion to a wider floating type, or the expression is
complex, or the expression is a function argument, or the expression is a return expression.

4MISRA-C:2004, Rule 10.3 - The value of a complex expression of integer type may only be cast
to a type that is narrower and of the same signedness as the underlying type of the expression.

SMISRA-C:2004, Rule 10.4 - The value of a complex expression of float type may only be cast
to narrower floating type.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
parameters and that can impact safety.

See Also

® Diagnostics Pane: Data Validity in the Simulink graphical user interface
documentation

® Diagnosing Simulation Errors in the Simulink documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard


http://www.rtca.org/aboutrtca.asp

DO-178B Checks

Check safety-related diagnostic settings for data
used for debugging

Check model configuration for diagnostic settings that apply to data used for
debugging and that can impact safety.

Description
This check verifies that model diagnostic configuration parameters pertaining

to debugging are set optimally for generating code for a safety-related
application.

See

* DO-178B, Section 6.3.1e — High-level requirements conform to standards

* DO-178B, Section 6.3.2e — Low-level requirements conform to standards

Results and Recommended Actions

Condition Recommended Action

The diagnostic that enables model Set Model Verification block enabling on
verification blocks is set to Use local the Diagnostics > Data Validity pane of the
settings or Enable all. Such blocks Configuration Parameters dialog box or set the
should be disabled because they are parameter AssertControl to Disable All.

assertion blocks, which are for verification
only. Model developers should not use
assertions in embedded code.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
data used for debugging and that can impact safety.

See Also

® Diagnostics Pane: Data Validity in the Simulink graphical user interface
documentation

¢ Diagnosing Simulation Errors in the Simulink documentation
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¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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DO-178B Checks

Check safety-related diagnostic settings for data
store memory

Check model configuration for diagnostic settings that apply to data store
memory and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to data store memory are set optimally for generating code for a safety-related
application.

See DO-178B, Section 6.3.3b — Software architecture is consistent.

Results and Recommended Actions

Condition Recommended Action

The diagnostic that detects whether the Set Detect read before write on the

model attempts to read data from a data Diagnostics > Data Validity pane of the
store in which it has not stored data in the Configuration Parameters dialog box or set the
current time step is set to a value other parameter ReadBeforeWriteMsg to Enable all

than Enable all as errors. Reading data | as errors.
before it is written can result in use of stale
data or data that is not initialized.

The diagnostic that detects whether the Set Detect write after read on the

model attempts to store data in a data store, | Diagnostics > Data Validity pane of the
after previously reading data from it in the | Configuration Parameters dialog box or set the
current time step, is set to a value other parameter WriteAfterReadMsg to Enable all
than Enable all as errors. Writing data | as errors.

after it is read can result in use of stale or
incorrect data.
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Condition Recommended Action

The diagnostic that detects whether the Set Detect write after write on the

model attempts to store data in a data store | Diagnostics > Data Validity pane of the
twice in succession in the current time step | Configuration Parameters dialog box or set the
1s set to a value other than Enable all as | parameter WriteAfterWriteMsg to Enable all
errors. Writing data twice in one time step | as errors.

can result in unpredictable data.

The diagnostic that detects when one task Set Multitask data store on the

reads data from a Data Store Memory block | Diagnostics > Data Validity pane of the

to which another task writes data is set to Configuration Parameters dialog box or set the
none or warning. Reading or writing data in | parameter MultiTaskDSMMsg to error.
different tasks in multitask mode can result
in corrupted or unpredictable data.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply
to data store memory and that can impact safety.

See Also

® Diagnostics Pane: Data Validity in the Simulink graphical user interface
documentation

¢ Diagnosing Simulation Errors in the Simulink documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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DO-178B Checks

Check safety-related diagnostic settings for type

conversions

Check model configuration for diagnostic settings that apply to type
conversions and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to type conversions are set optimally for generating code for a safety-related

application.

Results and Recommended Actions

Condition

Recommended Action

The diagnostic that detects Data Type
Conversion blocks used where no type
conversion 1s necessary is set to none.
The Simulink software might remove
unnecessary Data Type Conversion blocks
from generated code. This might result
In requirements without corresponding
code. The removal of such blocks need to be
detected so model developers can remove
the unnecessary blocks explicitly. (See
DO-178B, Section 6.3.1g — Algorithms are
accurate and DO-178B, Section 6.3.2g —
Algorithms are accurate.)

Set Unnecessary type conversions on the

Diagnostics > Type Conversion pane of the
Configuration Parameters dialog box or set the

parameter UnnecessaryDatatypeConvMsg to
warning.

The diagnostic that detects vector-to-matrix
or matrix-to-vector conversions at block
inputs is set to none or warning. When the
Simulink software automatically converts
between vector and matrix dimensions,
unintended operations or unpredictable
behavior can occur. (See DO-178B, Section
6.3.1g — Algorithms are accurate and
DO-178B, Section 6.3.2g — Algorithms are
accurate.)

Set Vector/matrix block input conversion on
the Diagnostics > Type Conversion pane of
the Configuration Parameters dialog box or set
the parameter VectorMatrixConversionMsg to

error.
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Condition Recommended Action

The diagnostic that detects when a 32-bit Set 32-bit integer to single precision float
integer value is converted to a floating-point | conversion on the Diagnostics > Type
value is set to none. This type of conversion | Conversion pane of the Configuration

can result in a loss of precision due to Parameters dialog box or set the parameter
truncation of the least significant bits Int32ToFloatConvMsg to warning.

for large integer values. (See DO-178B,
Section 6.3.1g — Algorithms are accurate and
DO-178B, Section 6.3.2g — Algorithms are
accurate, and MISRA-C:2004, Rules 10.11,
10.22, 10.33, and 10.4%.)

IMISRA-C:2004, Rule 10.1 - The value of an expression of integer type shall not be implicitly
converted to a different underlying type if: it is not a conversion to a wider integer type of the
same signedness, or the expression is complex, or the expression is not constant and is a function
argument, or the expression is not constant and is a return expression.

2MISRA-C:2004, Rule 10.2 - The value of an expression of floating type shall not be implicitly
converted to a different type if it is not a conversion to a wider floating type, or the expression is
complex, or the expression is a function argument, or the expression is a return expression.

SMISRA-C:2004, Rule 10.3 - The value of a complex expression of integer type may only be cast
to a type that is narrower and of the same signedness as the underlying type of the expression.

4MISRA-C:2004, Rule 10.4 - The value of a complex expression of float type may only be cast
to narrower floating type.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
type conversions and that can impact safety.

See Also

® Diagnostics Pane: Type Conversion in the Simulink graphical user
interface documentation

e Data Type Conversion block in the Simulink reference documentation
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¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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Check safety-related diagnostic settings for signal
connectivity

Check model configuration for diagnostic settings that apply to signal
connectivity and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to signal connectivity are set optimally for generating code for a safety-related
application.

See

* DO-178B, Section 6.3.1e — High-level requirements conform to standards

* DO-178B, Section 6.3.2e — Low-level requirements conform to standards

Results and Recommended Actions

Condition Recommended Action

The diagnostic that detects virtual signals Set Signal label mismatch on the

that have a common source signal but Diagnostics > Connectivity pane of the
different labels is set to none or warning. Configuration Parameters dialog box or set the
This diagnostic pertains to virtual signals parameter SignallLabelMismatchMsg to error.

only and has no effect on generated code.
However, signal label mismatches can lead
to confusion during model reviews.

The diagnostic that detects when the model | Set Unconnected block input ports on
contains a block with an unconnected input | the Diagnostics > Connectivity pane of the
signal is set to none or warning. This must | Configuration Parameters dialog box or set the
be detected because code is not generated for | parameter UnconnectedInputMsg to error.
unconnected block inputs.
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Condition

Recommended Action

The diagnostic that detects when the model
contains a block with an unconnected output
signal is set to none or warning. This must
be detected because dead code can result
from unconnected block output signals.

Set Unconnected block output ports on
the Diagnostics > Connectivity pane of the
Configuration Parameters dialog box or set the
parameter UnconnectedOutputMsg to error.

The diagnostic that detects unconnected
signal lines and unmatched Goto or From
blocks is set to none or warning. This
error must be detected because code is not
generated for unconnected lines.

Set Unconnected line on the

Diagnostics > Connectivity pane of the
Configuration Parameters dialog box or set the
parameter UnconnectedLineMsg to error.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply
to signal connectivity and that can impact safety.

See Also

¢ Diagnostics Pane: Connectivity in the Simulink graphical user interface

documentation

¢ Signal Basics in the Simulink documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the

DO-178B, Software Considerations in Airborne Systems and Equipment

Certification standard
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Check safety-related diagnostic settings for bus

connectivity

Check model configuration for diagnostic settings that apply to bus
connectivity and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to bus connectivity are set optimally for generating code for a safety-related

application.

See DO-178B, Section 6.3.3b — Software architecture is consistent.

Results and Recommended Actions

Condition

Recommended Action

The diagnostic that detects whether a Model
block’s root Outport block is connected to a
bus but does not specify a bus object is set to
none or warning. For a bus signal to cross a
model boundary, the signal must be defined
as a bus object to ensure compatibility with
higher level models that use a model as a
reference model.

Set Unspecified bus object at root Outport
block on the Diagnostics > Connectivity pane
of the Configuration Parameters dialog box or set
the parameter RootOutportRequireBusObject
to error.

The diagnostic that detects whether the
name of a bus element matches the name
specified by the corresponding bus object
is set to none or warning. This diagnostic
prevents the use of incompatible buses in
a bus-capable block such that the output
names are inconsistent.

Set Element name mismatch on the
Diagnostics > Connectivity pane of the
Configuration Parameters dialog box or set the
parameter BusObjectLabelMismatch to error.

The diagnostic that detects when some
blocks treat a signal as a mux/vector,
while other blocks treat the signal as a
bus, is set to none or warning. When the
Simulink software automatically converts
a muxed signal to a bus, it is possible for

¢ Set Mux blocks used to create bus signals
on the Diagnostics > Connectivity pane of
the Configuration Parameters dialog box to
error, or set the parameter StrictBusMsg to
ErrorOnBusTreatedAsVector.
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Condition

Recommended Action

an unintended operation or unpredictable

behavior to occur.

® Set “Bus signal treated as vector” on the
Diagnostics > Connectivity pane of the
Configuration Parameters dialog box to
error, or the parameter StrictBusMsg to
ErrorOnBusTreatedAsVector.

You can use the Model Advisor or the
slreplace_mux utility function to replace all Mux
blocks used as bus creators with a Bus Creator
block.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
bus connectivity and that can impact safety.

See Also

® Diagnostics Pane: Connectivity in the Simulink graphical user interface
documentation

® Simulink.Bus in the Simulink reference documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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Check safety-related diagnostic settings that apply
to function-call connectivity

Check model configuration for diagnostic settings that apply to function-call
connectivity and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to function-call connectivity are set optimally for generating code for a
safety-related application.

DO-178B, Section 6.3.3b — Software architecture is consistent.

Results and Recommended Actions

Condition Recommended Action

The diagnostic that detects incorrect use Set Invalid function-call connection on

of a function-call subsystem is set to none the Diagnostics > Connectivity pane of the
or warning. If this condition is undetected, | Configuration Parameters dialog box or set the
incorrect code might be generated. parameter InvalidFcnCallConMsg to error.
The diagnostic that specifies whether the Set Context-dependent inputs on the
Simulink software has to compute inputs Diagnostics > Connectivity pane of the

of a function-call subsystem directly or Configuration Parameters dialog box or set the

indirectly while executing the subsystem is | parameter FcnCallInpInsideContextMsg to
set toUse local settings or Disable all. | Enable all.

This diagnostic detects unpredictable data
coupling between a function-call subsystem
and the inputs of the subsystem in the
generated code.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply to
function-call connectivity and that can impact safety.
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See Also
® Diagnostics Pane: Connectivity in the Simulink graphical user interface
documentation

® Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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Check safety-related diagnostic settings for
compatibility

Check model configuration for diagnostic settings that affect compatibility
and that might impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to compatibility are set optimally for generating code for a safety-related
application.

See

e DO-178B, Section 6.3.3b — Software architecture is consistent.

e MISRA-C:2004, Rule 9.1 — All automatic variables shall have been assigned
a value before being used.

Results and Recommended Actions

Condition Recommended Action

The diagnostic that detects when a block Set S-function upgrades needed on the
has not been upgraded to use features of the | Diagnostics > Compatibility pane of the
current release is set to none or warning. Configuration Parameters dialog box or set the

An S-function written for an earlier version | parameter SFcnCompatibilityMsg to error.
might not be compatible with the current
version and generated code could operate
incorrectly.

Action Results

Clicking Modify Settings configures model diagnostic settings that affect
compatibility and that might impact safety.

See Also

¢ Diagnosing Simulation Errors in the Simulink documentation
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® Diagnostics Pane: Compatibility in the Simulink graphical user interface
documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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Check safety-related diagnostic settings for model

initialization

In the model configuration, check diagnostic settings that affect model
Initialization and might impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to initialization are set optimally for generating code for a safety-related

application.

See

e DO-178B, Section 6.3.3b — Software architecture is consistent.
e MISRA-C:2004, Rule 9.1 — All automatic variables shall have been assigned

a value before being used.

Results and Recommended Actions

Condition

Recommended Action

The Check undefined subsystem initial
output diagnostic is cleared. This diagnostic
specifies whether the Simulink software
displays a warning if the model contains a
conditionally executed subsystem, in which a
block with a specified initial condition drives
an Outport block with an undefined initial
condition. A conditionally executed subsystem
could have an output that is not initialized.
If undetected, this condition can produce
behavior that is nondeterministic.

In the Configuration Parameters dialog
box, on the Diagnostics > Data Validity
pane, select Check undefined subsystem
initial output or set the parameter
CheckSSInitialOutputMsg to on.

The diagnostic that detects potential initial
output differences from earlier releases is
cleared. A conditionally executed subsystem
could have an output that is not initialized.
If undetected, this condition can produce
behavior that is nondeterministic.

In the Configuration Parameters dialog box,
on the Diagnostics > Compatibility pane,
select Check preactivation output of
execution context or set the parameter
CheckExecutionContextPreStartOutputMsg
to on.
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Condition

Recommended Action

The diagnostic that detects potential output
differences from earlier releases is cleared. A
conditionally executed subsystem could have
an output that is not initialized and feeds into a
block with a tunable parameter. If undetected,
this condition can cause the behavior of the
downstream block to be nondeterministic.

In the Configuration Parameters dialog
box, on the Diagnostics > Compatibility
pane, select Check runtime output of
execution context or set the parameter
CheckExecutionContextRuntimeOutputMsg
to on.

Action Results

To configure the diagnostic settings that affect model initialization and that
might impact safety, click Modify Settings.

See Also

¢ “Diagnosing Simulation Errors” in the Simulink documentation

® “Diagnostics Pane: Data Validity” in the Simulink graphical user interface

documentation

¢ For information on the DO-178B, Software Considerations in Airborne
Systems and Equipment Certification standard, Radio Technical
Commission for Aeronautics (RTCA)
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Check safety-related diagnostic settings for model

referencing

Check model configuration for diagnostic settings that apply to model
referencing and that can impact safety.

Description

This check verifies that model diagnostic configuration parameters pertaining
to model referencing are set optimally for generating code for a safety-related

application.

Results and Recommended Actions

Condition

Recommended Action

The diagnostic that detects a mismatch
between the version of the model that
creates or refreshes a Model block and the
current version of the referenced model is set
to error or warning. The detection occurs
during load and update operations. When
you get the latest version of the referenced
model from the software configuration
management system, rather than an

older version that was used in a previous
simulation, if this diagnostic is set to error,
the simulation is aborted. If the diagnostic is
set to warning, a warning message is issued.
To resolve the issue, the user must resave
the model being simulated, which may not
be the desired action. (See DO-178B, Section
6.3.3b — Software architecture is consistent.)

Set Model block version mismatch on
the Diagnostics > Model Referencing
pane of the Configuration Parameters
dialog box or set the parameter
ModelReferenceVersionMismatchMessage
to none.

The diagnostic that detects port and
parameter mismatches during model loading
and updating is set to none or warning. If
undetected, such mismatches can lead to
incorrect simulation results because the
parent and referenced models have different

Set Port and parameter mismatch on the
Diagnostics > Model Referencing pane of the
Configuration Parameters dialog box or set the
parameter ModelReferenceIOMismatchMessage
to error.
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Condition

Recommended Action

interfaces. (See DO-178B, Section 6.3.3b —
Software architecture is consistent.)

The Model configuration mismatch
diagnostic is set to none or error. This
diagnostic checks whether the configuration
parameters of a model referenced by

the current model match the current
model’s configuration parameters or are
inappropriate for a referenced model.

Some diagnostics for referenced models

are not supported in simulation mode.
Setting this diagnostic to error can prevent
simulations from running. Some differences
in configurations can lead to incorrect
simulation results and mismatches between
simulation and target code generation.
(See DO-178B, Section 6.3.3b — Software
architecture is consistent.)

Set Model configuration mismatch on the

Diagnostics > Model Referencing pane of the
Configuration Parameters dialog box or set the
parameter ModelReferenceCSMismatchMessage

to warning.

The diagnostic that detects invalid internal
connections to the current model’s root-level
Inport and Outport blocks is set to none or
warning. When this condition is detected,
the Simulink software might automatically
insert hidden blocks into the model to correct
the condition. The hidden blocks can result
in generated code that has no traceable
requirements. Setting the diagnostic to
error forces model developers to correct the
referenced models manually. (See DO-178B,
Section 6.3.3b — Software architecture is
consistent.)

Set Invalid root Inport/Outport block
connection on the Diagnostics > Model
Referencing pane of the Configuration
Parameters dialog box or set the parameter
ModelReferenceIOMessage to error.

The diagnostic that detects whether To
Workspace or Scope blocks are logging data
in a referenced model is set to none or
warning. Data logging is not supported for
To Workspace and Scope blocks in referenced
models. (See DO-178B, Section 6.3.1d —

Set Unsupported data logging on the

Diagnostics > Model Referencing pane of the
Configuration Parameters dialog box or set the
parameter ModelReferenceDataLoggingMessage

to error.
To log data, remove the blocks and log the
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Condition

Recommended Action

High-level requirements are verifiable
and DO-178B, Section 6.3.2d — Low-level
requirements are verifiable.)

referenced model signals. For more information,
see .

Action Results

Clicking Modify Settings configures model diagnostic settings that apply
to model referencing and that can impact safety.

See Also

® Diagnosing Simulation Errors in the Simulink documentation

® Diagnostics Pane: Model Referencing in the Simulink graphical user

interface documentation

¢ Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment

Certification standard

e in the Simulink documentation
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Check safety-related model referencing settings
Check model configuration for model referencing settings that can impact

safety.

Description

This check verifies that model configuration parameters for model referencing
are set optimally for generating code for a safety-related application.

Results and Recommended Actions

Condition

Recommended Action

The referenced model is configured such
that its target is rebuilt whenever you
update, simulate, or generate code for

the model, or if the Simulink software
detects any changes in known dependencies.
These configuration settings can result

in unnecessary regeneration of the code,
resulting in changing only the date of the file
and slowing down the build process when
using model references. (See DO-178B,
Section 6.3.1b — High-level requirements
are accurate and consistent and DO-178B,
Section 6.3.2b — Low-level requirements are
accurate and consistent.)

Set “Rebuild options” on the Model
Referencing pane of the Configuration
Parameters dialog box or set the parameter
UpdateModelReferenceTargets to Never or If
any changes detected.

The diagnostic that detects whether a
target needs to be rebuilt is set to None or
Warn if targets require rebuild. For
safety-related applications, an error should
alert model developers that the parent
and referenced models are inconsistent.
This diagnostic parameter is available
only if Rebuild options is set to Never.
(See DO-178B, Section 6.3.1b — High-level
requirements are accurate and consistent
and DO-178B, Section 6.3.2b — Low-level
requirements are accurate and consistent.)

Set “Never rebuild targets diagnostic” on the
Model Referencing pane of the Configuration
Parameters dialog box or set the parameter
CheckModelReferenceTargetMessage to Error
if targets require rebuild.
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Condition

Recommended Action

The ability to pass scalar root input by
value 1s on. This capability should be off
because scalar values can change during a
time step and result in unpredictable data.
(See DO-178B, Section 6.3.3b — Software
architecture 1s consistent.)

Set “Pass fixed-size scalar root inputs by

value for code generation” on the Model
Referencing pane of the Configuration
Parameters dialog box or set the parameter
ModelReferencePassRootInputsByReference to
off.

The model is configured to minimize
algebraic loop occurrences. This
configuration is incompatible with

the recommended setting of Single
output/update function for embedded
systems code. (See DO-178B, Section 6.3.3b
— Software architecture is consistent.)

Set “Minimize algebraic loop occurrences” on the
Model Referencing pane of the Configuration
Parameters dialog box or set the parameter
ModelReferenceMinAlgLoopOccurrences to off.

Action Results

Clicking Modify Settings configures model referencing settings that can

impact safety.

See Also

e Model Dependencies in the Simulink documentation

® Model Referencing Pane in the Simulink graphical user interface

documentation

e Radio Technical Commaission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment

Certification standard
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Check safety-related code generation settings

Check model configuration for code generation settings that can impact safety.

Description

This check verifies that model configuration parameters for code generation
are set optimally for a safety-related application.

Results and Recommended Actions

Condition

Recommended Action

The option to include comments in the
generated code is cleared. Comments are
necessary for good traceability between the
code and the model. (See DO-178B, Section
6.3.4e — Source code is traceable to low-level
requirements.)

Select Include comments on the Code
Generation > Comments pane of the
Configuration Parameters dialog box or set the
parameter GenerateComments to on.

The option to include comments that
describe the code for blocks is cleared.
Comments are necessary for good
traceability between the code and the model.
(See DO-178B, Section 6.3.4e — Source code
is traceable to low-level requirements.)

Select Simulink block / Stateflow

object comments on the Code
Generation > Comments pane of the
Configuration Parameters dialog box or set the
parameter SimulinkBlockComments to on.

The option to include comments that
describe the code for blocks eliminated
from a model is cleared. Comments are
necessary for good traceability between the
code and the model. (See DO-178B, Section
6.3.4e — Source code is traceable to low-level
requirements.)

Select Show eliminated blocks on the
Code Generation > Comments pane of the
Configuration Parameters dialog box or set the
parameter ShowEliminatedStatement to on.
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Condition

Recommended Action

The option to include the names of
parameter variables and source blocks

as comments in the model parameter
structure declaration in model prm.h is
cleared. Comments are necessary for good
traceability between the code and the model.
(See DO-178B, Section 6.3.4e — Source code
1s traceable to low-level requirements.)

Select Verbose comments for
SimulinkGlobal storage class on the

Code Generation > Comments pane of the
Configuration Parameters dialog box or set the
parameter ForceParamTrailComments to on.

The option to include requirement
descriptions assigned to Simulink blocks

as comments is cleared. Comments are
necessary for good traceability between the
code and the model. (See DO-178B, Section
6.3.4e — Source code is traceable to low-level
requirements.)

Select Requirements in block comments on
the Code Generation > Comments pane of the
Configuration Parameters dialog box or set the
parameter ReqsInCode to on.

The option to generate nonfinite data

and operations is selected. Support for
nonfinite numbers is inappropriate for
real-time embedded systems. (See DO-178B,
Section 6.3.1c — High-level requirements
are compatible with target computer

and DO-178B, Section 6.3.2¢c — Low-level
requirements are compatible with target
computer.)

Clear Support: non-finite numbers on the
Code Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter SupportNonFinite to off.

The option to generate and maintain integer
counters for absolute and elapsed time

1s selected. Support for absolute time is
inappropriate for real-time safety-related
systems. (See DO-178B, Section 6.3.1c —
High-level requirements are compatible
with target computer and DO-178B,
Section 6.3.2¢c — Low-level requirements are
compatible with target computer.)

Clear Support: absolute time on the

Code Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter SupportAbsoluteTime to off.
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Condition

Recommended Action

The option to generate code for blocks that
use continuous time is selected. Support
for continuous time is inappropriate for
real-time safety-related systems. (See
DO-178B, Section 6.3.1c — High-level
requirements are compatible with target
computer and DO-178B, Section 6.3.2¢c —
Low-level requirements are compatible with
target computer.)

Clear Support: continuous time on the
Code Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter SupportContinuousTime to off.

The option to generate code for noninlined
S-functions is selected. This option requires
support of nonfinite numbers, which is
inappropriate for real-time safety-related
systems. (See DO-178B, Section 6.3.1c —
High-level requirements are compatible
with target computer and DO-178B,
Section 6.3.2¢c — Low-level requirements are
compatible with target computer.)

Clear Support: non-inlined S-functions on
the Code Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter SupportNonInlinedSFcns to off.

The option to generate model function calls
compatible with the main program module
of the GRT target is selected. This option is
inappropriate for real-time safety-related
systems. (See DO-178B, Section 6.3.1c —
High-level requirements are compatible
with target computer and DO-178B,
Section 6.3.2c — Low-level requirements are
compatible with target computer.)

Clear GRT compatible call interface on the
Code Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter GRTInterface to off.
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Condition

Recommended Action

The option to generate the model update
function is cleared. Having a single call to
the output and update functions simplifies
the interface to the real-time operating
system (RTOS) and simplifies verification
of the generated code. (See DO-178B,
Section 6.3.1c — High-level requirements
are compatible with target computer

and DO-178B, Section 6.3.2¢c — Low-level
requirements are compatible with target
computer.)

Select Single output/update function on the
Code Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter CombineOutputUpdateFcns to on.

The option to generate the model terminate
function is selected. This function
deallocates dynamic memory, which is not
appropriate for real-time safety-related
systems. (See DO-178B, Section 6.3.1c —
High-level requirements are compatible
with target computer and DO-178B,
Section 6.3.2¢c — Low-level requirements are
compatible with target computer.)

Clear Terminate function required on the
Code Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter IncludeMdlTerminateFcn to off.

The option to log or monitor error status is
cleared. If you do not select this option, the
Simulink Coder product generates extra
code that might not be reachable for testing.
(See DO-178B, Section 6.3.1c — High-level
requirements are compatible with target
computer and DO-178B, Section 6.3.2¢c —
Low-level requirements are compatible with
target computer.)

Select Suppress error status in real-time
model data structure on the Code
Generation > Interface pane of the
Configuration Parameters dialog box or set the
parameter SuppressErrorStatus to on.




DO-178B Checks

Condition

Recommended Action

MAT-file logging is selected. This option
adds extra code for logging test points

to a MAT-file, which is not supported by
embedded targets. Use this option only in
test harnesses. (See DO-178B, Section 6.3.1c
— High-level requirements are compatible
with target computer and DO-178B,
Section 6.3.2c — Low-level requirements are
compatible with target computer.)

Clear MAT-file logging on the Code
Generation > Interface pane of the

Configuration Parameters dialog box or set the

parameter MatFilelLogging to off.

The option that specifies the style for
parenthesis usage is set to Minimum (Rely
on C/C++ operators precedence) or to
Nominal (Optimize for readability).
For safety-related applications, explicitly
specify precedence with parentheses. (See
DO-178B, Section 6.3.1c — High-level
requirements are compatible with target
computer, DO-178B, Section 6.3.2¢c —
Low-level requirements are compatible with
target computer, and MISRA-C:2004, Rule
12.11)

Set Parenthesis level on the Code

Generation > Code pane of the Configuration

Parameters dialog box or set the parameter
ParenthesesLevel to Maximum (Specify
precedence with parentheses).

The option that specifies whether to
preserve operand order is cleared. This
option increases the traceability of the
generated code. (See DO-178B, Section
6.3.4e — Source code is traceable to low-level
requirements.)

Select Preserve operand order in expression
on the Code Generation > Code pane of the
Configuration Parameters dialog box or set the

parameter PreserveExpressionOrder to on.

The option that specifies whether to preserve
empty primary condition expressions in if
statements is cleared. This option increases
the traceability of the generated code. ( See
DO-178B, Section 6.3.4e — Source code is
traceable to low-level requirements.)

Select Preserve condition expression in if
statement on the Code Generation > Code
pane of the Configuration Parameters dialog box
or set the parameter PreserveIfCondition to on.
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Condition

Recommended Action

The option that specifies whether to
generate preprocessor conditional directives

1s set to generate code for nonactive variants.

This might result in generating code that
does not trace to the active variant of a
variant model block or a variant subsystem.
(See DO-178B Section 6.3.4e — Source code
1s traceable to low-level requirements.)

Set “Generate preprocessor conditionals” on
the Code Generation > Interface pane of the
Configuration Parameters dialog box to Disable
All.

The minimum number of characters
specified for generating name mangling
strings is less than four. You can use this
option to minimize the likelihood that
parameter and signal names will change
during code generation when the model
changes. Use of this option assists with
minimizing code differences between file
versions, decreasing the effort to perform
code reviews. (See DO-178B, Section 6.3.4e
— Source code is traceable to low-level
requirements.)

Set Minimum mangle length on the
Code Generation > Symbols pane of the
Configuration Parameters dialog box or the
parameter MangleLength to a value of 4 or
greater.

IMISRA-C:2004, Rule 12.1 - Limited dependence should be placed on C’s operator precedence

rules in expressions.

Action Results

Clicking Modify Settings configures model code generation settings that

can impact safety.

Limitations

This check requires a Embedded Coder license and an ERT-based system

target file.

See Also

® “Code Generation Pane: Comments”“Code Generation Pane: Comments”
in the Simulink Coder reference documentation
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“Code Generation Pane: Symbols” in the Simulink Coder reference
documentation

“Code Generation Pane: Interface” in the Simulink Coder reference
documentation

“Code Generation Pane: Code Style” in the Embedded Coder reference
documentation

Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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Check safety-related diagnostic settings for saving
Check model configuration for diagnostic settings that apply to saving model

files

Description

This check verifies that model configuration parameters are set optimally for
saving a model for a safety-related application.

See DO-178B, Section 6.3.3b - Software architecture is consistent.

Results and Recommended Actions

Condition

Recommended Action

The diagnostic that detects whether a model
contains disabled library links before the
model is saved is set to none or warning. If
this condition is undetected, incorrect code
might be generated.

Set Block diagram contains disabled library
links on the Diagnostics > Saving> pane of the
Configuration Parameters dialog box or set the
parameter SaveWithDisabledLinkMsg to error.

The diagnostic that detects whether a
model contains library links that are using
parameters not in a mask before the model
is saved is set to none or warning. If this
condition is undetected, incorrect code
might be generated.

Set Block diagram contains parameterized
library links on the Diagnostics

> Saving> pane of the Configuration
Parameters dialog box or set the parameter
SaveWithParameterizedLinkMsg to error.

Action Results

Clicking Modify Settings configures model diagnostic settings that apply

to saving a model file.

See Also

¢ Disabling Links to Library Blocks in the Simulink documentation

¢ Identifying Disabled Library Links in the Simulink documentation

® Saving a Model in the Simulink documentation
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e Model Parameters in the Simulink documentation

¢ Diagnostics Pane: Saving in the Simulink documentation
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Check for model objects that do not link to
requirements

Check whether Simulink blocks and Stateflow objects link to a requirements
document.

Description

This check verifies whether Simulink blocks and Stateflow objects link to a
document containing engineering requirements for traceability.

See

* DO-178B, Section 6.3.1f - High-level requirements trace to system
requirements

* DO-178B, Section 6.3.2f - Low-level requirements trace to high-level
requirements

Results and Recommended Actions

Condition Recommended Action

Blocks do not link to a requirements | Link to requirements document.
document. See “Creating and Managing
Requirements Links”.

Limitations

When you run this check, the Model Advisor does not follow library links
or look under masks. The Model Advisor reviews all top-level blocks in the
system.

Tip

Run this check from the top model or subsystem that you want to check.

See Also
“Requirements Linking and Traceability”
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Check for proper usage of Math blocks

Check whether math operators require nonfinite number support.

Description

This check verifies that Math Function blocks do not use math operations that

need nonfinite number support with real-time embedded targets.

See

e DO-178B, Sections 6.3.1g and 6.3.2g - Algorithms are accurate.

e MISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be
ensured by the use of at least one of the following:

= Static verification tools/techniques.

= Dynamic verification tools/techniques.

= Explicit coding of checks to handle runtime faults.

Results and Recommended Actions

Condition

Recommended Action

Math Function blocks using log
(natural logarithm), 1og10 (base 10
logarithm), and rem (Remainder)
operators that require nonfinite
number support.

When using the Math Function block
with a log or 10g10 function, you
must protect the input to the block
in the model such that it is not less
then or equal to zero. Otherwise, the
output can produce a NaN or -Inf
and result in a run-time error in the
generated code.

When using the Math Function
block with a rem function, you must
protect the second input to the block
such that it is not equal to zero.
Otherwise the output can produce a
Inf or -Inf and result in a run-time
error in the generated code.
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Tips

With embedded systems, you must take care when using blocks that could
produce nonfinite outputs such as NaN, Inf or -Inf. Your design must protect
the inputs to these blocks in order to avoid run-time errors in the embedded
system.

See Also
Math Function block in the Simulink documentation
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Check state machine type of Stateflow charts
Identify whether Stateflow charts are all Mealy or all Moore charts.

Description

Compares the state machine type of all Stateflow charts to the type that
you specify in the input parameters.

See
e DO-178B, Section 6.3.1b - High-level requirements are accurate and
consistent

e DO-178B, Section 6.3.1e - High-level requirements conform to standards

e DO-178B, Section 6.3.2b - Low-level requirements are accurate and
consistent

e DO-178B, Section 6.3.2e - Low-level requirements conform to standards
e DO-178B, Section 6.3.3b - Software architecture is consistent

e DO-178B, Section 6.3.3e - Software architecture conform to standards

Input Parameters

Common
Check whether charts use the same state machine type, and are all
Mealy or all Moore charts.

Mealy
Check whether all charts are Mealy charts.

Moore
Check whether all charts are Moore charts.
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Results and Recommended Actions

Condition

Recommended Action

The input parameter is set to Common
and charts in the model use any of
the following:

¢ (lassic state machine types.

e Multiple state machine types.

For each chart, in the Chart
Properties dialog box, specify State
Machine Type to either Mealy or
Moore. Use the same state machine
type for all charts in the model.

The input parameter is set to Mealy
and charts in the model use other
state machine types.

For each chart, in the Chart
Properties dialog box, specify State
Machine Type to Mealy.

The input parameter is set to Moore
and charts in the model use other
state machine types.

For each chart, in the Chart
Properties dialog box, specify State
Machine Type to Moore.

See Also

e “hisf 0001: Mealy and Moore semantics”

¢ “Building Mealy and Moore Charts” in the Stateflow documentation.

e “Stateflow Chart Considerations” in the Simulink documentation.
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Check Stateflow charts for ordering of states and
transitions

Identify Stateflow charts that have User specified state/transition
execution order cleared.

Description

Identify Stateflow charts that have User specified state/transition
execution order cleared, and therefore do not use explicit ordering of
parallel states and transitions.

See

e DO-178B, Section 6.3.3b - Software architecture is consistent

e DO-178B, Section 6.3.3e - Software architecture conform to standards

Results and Recommended Actions

Condition Recommended Action

Stateflow charts have User For the specified charts, in the

specified state/transition Chart Properties dialog box, select

execution order cleared. User specified state/transition
execution order.

Action Results

Clicking Modify selects User specified state/transition execution order
for the specified charts.

See Also

e “hisf 0002: User-specified state/transition execution order”

“Transition Testing Order in Multilevel State Hierarchy” in the Stateflow
documentation.

e “KExecution Order for Parallel States” in the Stateflow documentation.

e “Stateflow Chart Considerations” in the Simulink documentation.
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Check Stateflow debugging settings

Identify whether Stateflow debugging options are cleared.

Description

Identify whether the following debugging options are cleared, which might
lead to unreachable code and indeterminate execution time:

¢ Enable debugging/animation

Enable overflow detection (with debugging)

State Inconsistency

e Transition Conflict

Data Range

Detect Cycles

See

e DO-178B, Section 6.3.1b - High-level requirements are accurate and
consistent

e DO-178B, Section 6.3.1e - High-level requirements conform to standards

e DO-178B, Section 6.3.2b - Low-level requirements are accurate and
consistent

e DO-178B, Section 6.3.2e - Low-level requirements conform to standards

Results and Recommended Actions

Condition Recommended Action
Any of the following debugging Select the debugging options. In the
options are cleared: Configuration Parameters dialog

¢ Enable debugging/animation | box, select:

e Enable overflow detection

(with debugging) e Simulation

Target > General > Enable
® State Inconsistency debugging/animation
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Condition

Recommended Action

¢ Transition Conflict
e Data Range
¢ Detect Cycles

¢ Simulation
Target > General > Enable
overflow detection (with
debugging)

In the Stateflow Debugging dialog
box, select:

¢ State Inconsistency

¢ Transition Conflict

e Data Range

¢ Detect Cycles

Action Results

Clicking Modify selects the specified debugging options.

See Also

e “hisf 0011: Stateflow debugging settings”

e “Stateflow Chart Considerations” in the Simulink documentation.
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Check for proper usage of lookup table blocks

Check for lookup table blocks that do not generate out-of-range checking code.

Description

This check verifies that the following blocks generate code to protect against
inputs that fall outside the range of valid breakpoint values:

e 1-D Lookup Table
e 2.D Lookup Table
* n-D Lookup Table
® Prelookup

This check also verifies that all Interpolation Using Prelookup blocks generate
code to protect against inputs that fall outside the range of valid index values.

Results and Recommended Actions

Condition Recommended Action

The lookup table block does not Change the setting on the block
generate out-of-range checking code. | dialog box so that out-of-range
checking code is generated.

e For the 1-D Lookup Table,
2-D Lookup Table, n-D
Lookup Table, and Prelookup
blocks, clear the check box
for Remove protection
against out-of-range input
in generated code.

¢ For the Interpolation Using
Prelookup block, clear the check
box for Remove protection
against out-of-range index in
generated code.
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Action Results

Clicking Modify ensures that all lookup table blocks are set to generate
out-of-range checking code.

See Also

¢ n-D Lookup Table block in the Simulink documentation
¢ Prelookup block in the Simulink documentation

¢ Interpolation Using Prelookup block in the Simulink documentation
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Check Stateflow charts for uniquely defined data

objects

Identify Stateflow charts that include data objects that are not uniquely

defined.

Description

This check searches your model for local data in Stateflow charts that is not

uniquely defined.

See

* DO-178B, Section 6.3.2b - Accuracy and Consistency of Low-Level

Requirements

o MISRA-C: 2004, Rule 5.6 - No identifier in one name space should have the
same spelling as an identifier in another name space, with the exception of

structure and union member names.

Results and Recommended Actions

Condition

Recommended Action

The Stateflow chart contains a data
object identifier defined in two or
more scopes.

For the identified chart, do one of
the following:

¢ (Create a unique data object
identifier within each of the
scopes.

¢ (Create a unique data object
identifier within the chart, at the
parent level.

See Also

¢ “higl_0061: Unique identifiers for clarity”
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Check usage of Math Operations blocks

Identify usage of Math Operation blocks that might impact safety.

Description

This check inspects your model for proper usage of:

® Absolute Value blocks
® Gain blocks

See

e MISRA-C:2004, Rule 14.1 - There shall be no unreachable code.

e MISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be
ensured by the use of at least one of the following:

= Static verification tools/techniques.

= Dynamic verification tools/techniques.

= Explicit coding of checks to handle runtime faults.

Results and Recommended Actions

Condition

Recommended Action

The model or subsystem contains
an Absolute Value block that is
operating on a Boolean or an
unsigned input data type. This
condition results in unreachable
simulation pathways through
the model and might result in
unreachable code.

For the identified block, do one of
the following:

¢ Change the input of the Absolute
Value block to a signed input type.

® Remove the Absolute Value block
from the model.

The model or subsystem contains
an Absolute Value block that is
operating on a signed integer value,
and the Saturate on integer
overflow check box is not selected.
For signed data types, the absolute

In the Block Parameters > Signal
Attributes dialog box, select the
Saturate on integer overflow
check box.
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Condition

Recommended Action

value of the most negative value

1s problematic because it is not
representable by the data type. This
condition results in an overflow in
the generated code.

The model or subsystem contains
Gain blocks with a of value 1.

If you are using Gain blocks as
buffers, consider replacing them
with Signal Conversion blocks.
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Check usage of Signal Routing blocks

Identify usage of Signal Routing blocks that might impact safety.

Description

This check identifies model or subsystem Switch blocks that might
generate code with inequality operations (~=) in expressions that contain a

floating-point variable or constant.

See MISRA-C:2004, Rule 13.3 - Floating-point expressions shall not be tested

for equality or inequality.

Results and Recommended Actions

Condition

Recommended Action

The model or subsystem contains a
Switch block that might generate
code with inequality operations
(~=) in expressions where at

least one side of the expression
contains a floating-point variable or
constant. The Switch block might
cause floating-point inequality
comparisons in the generated code.

For the identified block, do one of
the following:

® For the control input block,
change the Data type parameter
setting.

® Change the Switch block
Criteria for passing first input
parameter setting. This might
change the algorithm.
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Check usage of Logic and Bit Operations blocks

Identify usage of Logical Operator and Bit Operations blocks that might
impact safety.

Description
This check inspects your model for proper usage of:

® Blocks that compute relational operators, including Relational Operator,
Compare To Constant, Compare To Zero, and Detect Change blocks

® Logical Operator blocks
See

e DO-178B, Sections.6.3.1g and 6.3.2g - Algorithms are accurate.

® See MISRA-C:2004, Rule 13.3 - Floating-point expressions shall not be
tested for equality or inequality.

Results and Recommended Actions

Condition Recommended Action

The model or subsystem contains On the Block Parameters >

a block computing a relational Signal Attributes pane, set the
operator that is operating on Output data type to boolean for

different data types. The condition | the specified blocks.
can lead to unpredictable results in
the generated code.

The model or subsystem contains For the identified block, do one of
a block computing a relational the following:

operator that uses the == or ~=

operator to compare floating-point ® Change the signal data type.

signals. The use of these operators on
floating-point signals is unreliable
and unpredictable because of
floating-point precision issues.
These operators can lead to

® Rework the model to eliminate
using == or ~= operators on
floating-point signals.
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Condition

Recommended Action

unpredictable results in the
generated code.

The model or subsystem contains
a Logical Operator block that has
inputs or outputs that are not
Boolean inputs or outputs. The
block might result in floating-point
equality or inequality comparisons
in the generated code.

e Modify the Logical Operator
block so that all inputs and
outputs are Boolean. On the
Block Parameters > Signal
Attributes pane, consider
selecting Require all inputs to
have the same data type and
setting Output data type to
boolean.

¢ In the Configuration Parameters
dialog box, on the Optimization
pane, consider selecting the
Implement logic signals as
boolean data (vs. double).

See Also

® “hisl_0016: Usage of blocks that compute relational operators”

¢ “hisl_0017: Usage of blocks that compute relational operators (2)”
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Check usage of Ports and Subsystems blocks
Identify usage of Ports and Subsystems blocks that might impact safety.

Description
This check inspects your model for proper usage of:

® For Iterator blocks

® While Iterator blocks
o If blocks

® Switch Case blocks

See
e MISRA-C:2004, Rule 13.6 - Numeric variables being used within a for loop

for iteration counting should not be modified in the body of the loop.

e MISRA-C:2004, Rule 14.10 - All if else if constructs should contain a final
else clause.

e MISRA-C:2004, Rule 15.3 - The final clause of a switch statement shall
be the default clause.

e MISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be
ensured by the use of at least one of the following:

= Static verification tools/techniques.
= Dynamic verification tools/techniques.

= Explicit coding of checks to handle runtime faults.
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Results and Recommended Actions

Condition

Recommended Action

The model or subsystem contains a
For Iterator block that has variable
iterations. This condition can lead

to unpredictable execution times or
infinite loops in the generated code.

For the identified For Iterator
blocks, do one of the following:

e Set the Iteration limit source
parameter to internal.

e [If the Iteration limit source
parameter must be external, use
a Constant, Probe, or Width block
as the source.

® (lear the Set next i (iteration
variable) externally check box.

® (Consider selecting the Show
iteration variable check box and
observe the iteration value during
simulation.

The model or subsystem contains

a While Iterator block that has
unlimited iterations. This condition
can lead to infinite loops in the
generated code.

For the identified While Iterator
blocks:

¢ Set the Maximum number of
iterations (-1 for unlimited)
parameter to a positive integer
value.

¢ Consider selecting the Show
iteration number port check
box and observe the iteration
value during simulation.

The model or subsystem contains
an If block with an If expression or
Elseif expressions that might cause
floating-point equality or inequality
comparisons in generated code.

Modify the expressions in the If block
to avoid floating-point equality or
inequality comparisons in generated
code.
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Condition

Recommended Action

The model or subsystem contains
an If block using Elseif expressions
without an Else condition.

In the If block Block Parameters
dialog box, select Show else
condition. Connect the resulting
Else output port to an If Action
Subsystem block.

The model or subsystem contains an
If block with output ports that do
not connect to If Action Subsystem
blocks.

Ensure that all output ports of the If
block connect to If Action Subsystem
blocks.

The model or subsystem contains an
Switch Case block without a default
case.

In the Switch Case block Block
Parameters dialog box, select
Show default case. Connect the
resulting default output port to a
Switch Case Action Subsystem block.

The model or subsystem contains a
Switch Case block with an output
port that does not connect to a Switch
Case Action Subsystem block.

Ensure that all output ports of the
Switch Case blocks connect to Switch
Case Action Subsystem blocks.

See Also

® “hisl_0010: Usage of If blocks and If Action Subsystem blocks”
® “hisl_0011: Usage of Switch Case blocks and Action Subsystem blocks”
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Display model version information

Display model version information in your report.

Description

This check displays the following information for the current model:
® Version number

® Author

® Date

® Model checksum

Results and Recommended Actions

Condition Recommended Action

Could not retrieve model version and | This summary is provided for your

checksum information. information. No action is required.
See Also

e Validating Generated Code in the Simulink Coder documentation

® Radio Technical Commission for Aeronautics (RTCA) for information on the
DO-178B, Software Considerations in Airborne Systems and Equipment
Certification standard
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IEC 61508 and I1SO 26262 Checks
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In this section...

“IEC 61508 and ISO 26262 Checks Overview” on page 5-74
“Display model metrics and complexity report” on page 5-76
“Check for unconnected objects” on page 5-77

“Check for fully defined interface” on page 5-78

“Check for questionable constructs” on page 5-80

“Check usage of Stateflow constructs” on page 5-82

“Check state machine type of Stateflow charts” on page 5-87
“Check for model objects that do not link to requirements” on page 5-89
“Check usage of Math Operations blocks” on page 5-90

“Check usage of Signal Routing blocks” on page 5-92

“Check usage of Logic and Bit Operations blocks” on page 5-93
“Check usage of Ports and Subsystems blocks” on page 5-95

“Display configuration management data” on page 5-98

IEC 61508 and ISO 26262 Checks Overview

IEC 61508 and ISO 26262 checks facilitate designing and troubleshooting
models, subsystems, and the corresponding generated code for applications to
comply with IEC 61508-3 or ISO 26262-6.

The Model Advisor performs a checkout of the Simulink Verification and
Validation license when you run the IEC 61508 or ISO 26262 checks.

Tips
If your model uses model referencing, run the IEC 61508 or ISO 26262 checks
on all referenced models before running them on the top-level model.
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See Also
e [EC 61508-3 Functional safety of electrical/electronic/programmable
electronic safety-related systems — Part 3: Software requirements

e [SO 26262—6 Road vehicles — Functional safety — Part 6: Product
development: Software level

® Developing Models and Code That Comply with the IEC 16508 Standard in
the Embedded Coder documentation

* “Developing Models and Code That Comply with the ISO 26262 Standard”
in the Embedded Coder documentation

® “Consulting the Model Advisor” in the Simulink documentation
e “Simulink Checks” in the Simulink reference documentation

e “Simulink Coder Checks” in the Simulink Coder documentation
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Display model metrics and complexity report

Display number of elements and name, level, and depth of subsystems for the
model or subsystem.

Description

The IEC 61508 and ISO 26262 standards recommend the usage of size and

complexity metrics to assess the software under development. This check

provides metrics information for the model. The provided information can be

used to inspect whether the size or complexity of the model or subsystem

exceeds given limits. The check displays:

¢ A block count for each Simulink block type contained in the given model.

® The maximum subsystem depth of the given model.

® A count of Stateflow constructs in the given model (if applicable).

®* Name, level, and depth of the subsystems contained in the given model (if
applicable).

See

e [EC 61508-3, Table A.9 (5) — Software complexity metrics

e [SO/DIS 26262-6, Table 1 (1a) - Enforcement of low complexity, Table 4 (1a)
- Hierarchical structure of software components, Table 4 (1b) - Restricted
size of software components, and Table 4 (1c) - Restricted size of interfaces

Results and Recommended Actions

Condition Recommended Action

N/A This summary is provided for your
information. No action is required.

See Also

® sldiagnostics in the Simulink documentation

¢ “Cyclomatic Complexity” in the Stateflow documentation
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Check for unconnected obijects

Identify unconnected lines, input ports, and output ports in the model.

Description

Unconnected objects are likely to cause problems propagating signal
attributes such as data, type, sample time, and dimensions.

Ports connected to Ground or Terminator blocks pass this check.
See

e JEC 61508-3, Table A.3 (3) — Language subset

e [SO/DIS 26262-6, Table 1 (1b) - Use of language subsets, Table 1 (1d) - Use
of defensive implementation techniques

Results and Recommended Actions

Condition Recommended Action

There are unconnected lines, input ® Double-click an element in the list
ports, or output ports in the model of unconnected items to locate the
or subsystem. item in the model diagram.

® Properly connect the objects
identified in the results.

See Also
“Working with Signals” in the Simulink documentation
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Check for fully defined interface

Identify root model Inport blocks that do not have fully defined attributes.

Description

Using root model Inport blocks that do not have fully define dimensions,
sample time, or data type can lead to undesired simulation results. Simulink
back-propagates dimensions, sample times, and data types from downstream
blocks unless you explicitly assign these values.

See

e JEC 61508-3, Table B.9 (5) — Fully defined interface

e [SO/DIS 26262-6, Table 1 (1f) - Use of unambiguous graphical
representation

Results and Recommended Actions

Condition Recommended Action
The model has root-level Inport Explicitly define all root-level Inport
blocks that have undefined block attributes identified in the
attributes, such as an inherited results. Double-click an element
sample time, data type, or port from the list of underspecified items
dimension. to locate the condition.

Tips

The following configurations pass this check:
¢ Inport blocks with inherited port dimensions in conjunction with the usage
of bus objects

¢ Inport blocks with automatically inherited data types in conjunction with
bus objects

¢ Inport blocks with inherited sample times in conjunction with the Periodic
sample time constraint menu set to Ensure sample time independent
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See Also

® Working with Data Types in the Simulink documentation
® Determining Output Signal Dimensions in the Simulink documentation

® Specifying Sample Time in the Simulink documentation
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Check for questionable constructs

Identify blocks not supported by code generation or not recommended for
deployment.

Description

This check partially identifies model constructs that are not suited for code
generation or not recommended for production code generation as identified
in the Simulink Block Support tables for Simulink Coder and Embedded
Coder. If you are using blocks with support notes for code generation, review
the information and follow the given advice.

See
e JEC 61508-3, Table A.3 (3) — Language subset

e [SO/DIS 26262-6, Table 1 (1b) - Use of language subsets

Results and Recommended Actions

Condition Recommended Action

The model or subsystem contains Consider replacing the blocks listed

blocks that should not be used for in the results. Double-click an

code generation. element from the list of questionable
items to locate condition.

The model or subsystem contains Consider replacing the blocks listed

blocks that should not be used for in the results. Double-click an

production code deployment. element from the list of questionable
items to locate condition.

The model or subsystem contains If you are using Gain blocks as

Gain blocks whose value equals 1. buffers, consider replacing them

with Signal Conversion blocks.
Double-click an element from the
list of questionable items to locate
condition.
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Limitation

This check might not identify all instances of noncompliance with the
Simulink Coder and Embedded Coder “Simulink Built-In Blocks That Support
Code Generation” tables.

See Also

¢ “Simulink Built-In Blocks That Support Code Generation” tables in the
Simulink Coder documentation for Simulink Coder and Embedded Coder

® “Developing Models for Code Generation” in the Embedded Coder
documentation
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Check usage of Stateflow constructs
Identify usage of Stateflow constructs that might impact safety.

Description

This check identifies instances of Stateflow software being used in a way that
can impact an application’s safety, including:

e Use of strong data typing
® Port name mismatches

® Scope of data objects and events

* Formatting of state action statements

® Ordering of states and transitions
¢ Unreachable code

e Indeterminate execution time

Results and Recommended Actions

Condition

Recommended Action

A Stateflow chart is not configured
for strong data typing on boundaries
between a Simulink model and the
Stateflow chart. (See “hisf_0009:
Strong data typing (Simulink and
Stateflow boundary)” IEC 61508-3
Table A.3 (2) - Strongly typed
programming language, ISO/DIS
26262-6, Table 1 (1c¢) - Enforcement
of strong typing, and MISRA-C:2004,
Rules 10.11, 10.22, 10.3%, and 10.4%)

In the Chart properties dialog box,
select Use Strong Data Typing
with Simulink I/O for the Stateflow
chart. When you select this check
box, the Stateflow chart accepts
input signals of any data type
that Simulink models support,
provided that the type of the input
signal matches the type of the
corresponding Stateflow input data
object.

Signals have names that differ
from those of their corresponding
Stateflow ports. (See IEC 61508-3,
Table A.3 (3)- Language subset and

® Check whether the ports are
connected properly and, if not,
correct the connections.
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Condition

Recommended Action

ISO/DIS 26262-6, Table 1 (1b) - Use
of language subsets)

¢ Change the names of the signals
or the Stateflow ports so that the
names match.

Events are not defined in the
Stateflow hierarchy at the chart
level or below. (See IEC 61508-3,
Table A.3 (3)- Language subset and
ISO/DIS 26262-6, Table 1 (1b) - Use
of language subsets)

Define events at the chart level or
below.

Local data is not defined in the
Stateflow hierarchy at the chart
level or below. (See IEC 61508-3,
Table A.3 (3)- Language subset and
ISO/DIS 26262-6, Table 1 (1b) - Use
of language subsets)

Define local data at the chart level
or below.

A new line is missing from a state
action after:

® An entry (en), during (du), or
exit (ex) statement

¢ The semicolon (;) at the end of an
assignment statement

(See IEC 61508-3, Table A.3 (3)-
Language subset and ISO/DIS
26262-6, Table 1 (1b) - Use of
language subsets)

Add missing new lines.
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Condition

Recommended Action

Stateflow charts have User
specified state/transition
execution order cleared.
(See “hisf_0002: User-specified
state/transition execution order”,
IEC 61508-3, Table A.3 (3) -
Language subset, and ISO/DIS
26262-6, Table 1 (1b) - Use of
language subsets, Table 1 (1f) -
Use of unambiguous graphical
representation )

For the specified charts, in the
Chart Properties dialog box, select
User specified state/transition
execution order.

Any of the following debugging
options are cleared:
* Enable debugging/animation

e Enable overflow detection
(with debugging)

¢ State Inconsistency

¢ Transition Conflict

e Data Range

¢ Detect Cycles

(See “hisf_0011: Stateflow debugging
settings”, IEC 61508-3, Table A.7
(2) - Simulation/modeling, and
ISO/DIS 26262-6 Table 1 (1d) -

Use of defensive implementation
techniques)

Select the debugging options. In the
Configuration Parameters dialog
box, select:

¢ Simulation
Target > General > Enable
debugging/animation

¢ Simulation
Target > General > Enable
overflow detection (with
debugging)

In the Stateflow Debugging dialog
box, select:

¢ State Inconsistency

¢ Transition Conflict

e Data Range

¢ Detect Cycles
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Condition

Recommended Action

The Stateflow chart contains a
data object identifier defined in two
or more scopes. (See “hisl_0061:
Unique identifiers for clarity”, IEC
61508-3, Table A.3 (3) - Language

For the identified chart, do one of

the following:

¢ Create a unique data object
identifier within each of the
scopes.

subset, Table A.4 (5) - Design and
coding standards, ISO/DIS 26262-6,
Table 1 (1b) - Use of language
subsets, Table 1 (1e) - Use of
established design principles, Table
1 (1h) - Use of naming conventions
and MISRA-C:2004, Rule 5.6%)

IMISRA-C:2004, Rule 10.1 - The value of an expression of integer type
shall not be implicitly converted to a different underlying type if: it is not a
conversion to a wider integer type of the same signedness, or the expression
is complex, or the expression is not constant and is a function argument, or
the expression is not constant and is a return expression.

2MISRA-C:2004, Rule 10.2 - The value of an expression of floating type
shall not be implicitly converted to a different type if it is not a conversion
to a wider floating type, or the expression is complex, or the expression is a
function argument, or the expression is a return expression.

SMISRA-C:2004, Rule 10.3 - The value of a complex expression of integer
type may only be cast to a type that is narrower and of the same signedness
as the underlying type of the expression.

4MISRA-C:2004, Rule 10.4 - The value of a complex expression of float type
may only be cast to narrower floating type.

SMISRA-C:2004, Rule 5.6 - No identifier in one name space should have the
same spelling as an identifier in another name space, with the exception of
structure and union member names.

¢ Create a unique data object
identifier within the chart, at the
parent level.

See Also

See the following topics in the Stateflow documentation:

® “Strong Data Typing with Simulink 1/0”
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® “Property Fields”
® “Defining Events”
¢ “Defining Data”

* “Labeling States”

See “Stateflow Chart Considerations” in the Simulink documentation.
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Check state machine type of Stateflow charts
Identify whether Stateflow charts are all Mealy or all Moore charts.

Description

Compares the state machine type of all Stateflow charts to the type that
you specify in the input parameters.

See

e JEC 61508-3,Table A.7 (2) - Simulation/modeling
e [SO/DIS 26262-6, Table 1 (1b) - Use of language subsets

Input Parameters

Common
Check whether charts use the same state machine type, and are all
Mealy or all Moore charts.

Mealy
Check whether all charts are Mealy charts.

Moore
Check whether all charts are Moore charts.

Results and Recommended Actions

Condition Recommended Action

The input parameter is set to Common | For each chart, in the Chart
and charts in the model use any of Properties dialog box, specify State

the following: Machine Type to either Mealy or
Moore. Use the same state machine
¢ (Classic state machine types. type for all charts in the model.

e Multiple state machine types.

The input parameter is set to Mealy | For each chart, in the Chart
and charts in the model use other Properties dialog box, specify State
state machine types. Machine Type to Mealy.
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Condition

Recommended Action

The input parameter is set to Moore
and charts in the model use other
state machine types.

For each chart, in the Chart
Properties dialog box, specify State
Machine Type to Moore.

See Also

e “hisf 0001: Mealy and Moore semantics”

“Building Mealy and Moore Charts” in the Stateflow documentation.

e “Stateflow Chart Considerations” in the Simulink documentation.
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Check for model objects that do not link to
requirements

Check whether Simulink blocks and Stateflow objects link to a requirements
document.

See

e JEC 61508-3, Table A.1 (1) - Computer-aided specification tools, Table A.2
(8) - Computer-aided specification tools, and Table A.8 (1) - Impact analysis

e [SO/DIS 26262-6, Table 8 (1a) - Documentation of the software unit design
in natural language

Description

This check verifies whether Simulink blocks and Stateflow objects link to a
document containing engineering requirements for traceability.

Results and Recommended Actions

Condition Recommended Action

Blocks do not link to a requirements | Link to requirements document.
document. See “Creating and Managing
Requirements Links”.

Limitations

When you run this check, the Model Advisor does not follow library links
or look under masks. The Model Advisor reviews all top-level blocks in the
system.

Tip

Run this check from the top model or subsystem that you want to check.

See Also
“Requirements Linking and Traceability”
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Check usage of Math Operations blocks

Identify usage of Math Operation blocks that might impact safety.

Description
This check inspects your model for proper usage of:

® Absolute Value blocks
® Gain blocks

See
e JEC 61508-3, Table A.3 (3) — Language subset, IEC 61508-3, Table A.4 (3) —

Defensive programming, Table B.8 (3) — Control Flow Analysis

e [SO/DIS 26262-6, Table 1 (1b) - Use of language subsets, Table 1 (1d) - Use
of defensive implementation techniques, Table 7 (1f) - Control flow analysis

e MISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be
ensured by the use of at least one of the following:

= Static verification tools/techniques.
= Dynamic verification tools/techniques.

= Explicit coding of checks to handle runtime faults.

Results and Recommended Actions

Condition Recommended Action
The model or subsystem contains For the identified block, do one of
an Absolute Value block that is the following:
operating on a Boolean or an
unsigned input data type. This ¢ Change the input of the Absolute
condition results in unreachable Value block to a signed input type.
il ien pathvs{ays through ® Remove the Absolute Value block
the model and might result in

from the model.
unreachable code.
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Condition

Recommended Action

The model or subsystem contains
an Absolute Value block that is
operating on a signed integer value,
and the Saturate on integer
overflow check box is not selected.
For signed data types, the absolute
value of the most negative value

is problematic because it is not
representable by the data type. This
condition results in an overflow in
the generated code.

In the Block Parameters > Signal
Attributes dialog box, select the
Saturate on integer overflow
check box.

The model or subsystem contains
Gain blocks with a of value 1.

If you are using Gain blocks as
buffers, consider replacing them
with Signal Conversion blocks.
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Check usage of Signal Routing blocks

Identify usage of Signal Routing blocks that might impact safety.

Description

This check identifies model or subsystem Switch blocks that might
generate code with inequality operations (~=) in expressions that contain a

floating-point variable or constant.

See

e JEC 61508-3, Table A.3 (3) — Language subset, Table A.4 (3) — Defensive

programming

e [SO/DIS 26262-6, Table 1 (1b) - Use of language subsets, Table 1 (1d) - Use
of defensive implementation techniques

e MISRA-C:2004, Rule 13.3 - Floating-point expressions shall not be tested

for equality or inequality.

Results and Recommended Actions

Condition

Recommended Action

The model or subsystem contains a
Switch block that might generate
code with inequality operations
(~=) in expressions where at

least one side of the expression
contains a floating-point variable or
constant. The Switch block might
cause floating-point inequality
comparisons in the generated code.

For the identified block, do one of
the following:

® For the control input block,
change the Data type parameter
setting.

® Change the Switch block
Criteria for passing first input
parameter setting. This might
change the algorithm.
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Check usage of Logic and Bit Operations blocks

Identify usage of Logical Operator and Bit Operations blocks that might
impact safety.

Description
This check inspects your model for proper usage of:

® Blocks that compute relational operators, including Relational Operator,
Compare To Constant, Compare To Zero, and Detect Change blocks
® Logical Operator blocks

See
e JEC 61508-3, Table A.3 (2) — Strongly typed programming language, Table

A.3 (3) — Language subset, Table A.4 (3) - Defensive programming

e [SO/DIS 26262-6, Table 1 (1c¢) - Enforcement of strong typing, Table 1 (1b)
- Use of language subsets

e MISRA-C:2004, Rule 13.3 - Floating-point expressions shall not be tested
for equality or inequality.

Results and Recommended Actions

Condition Recommended Action

The model or subsystem contains On the Block Parameters >

a block computing a relational Signal Attributes pane, set the
operator that is operating on Output data type to boolean for

different data types. The condition | the specified blocks.
can lead to unpredictable results in
the generated code.

The model or subsystem contains For the identified block, do one of
a block computing a relational the following:

operator that uses the == or ~=

operator to compare floating-point ® Change the signal data type.

signals. The use of these operators on
floating-point signals is unreliable
and unpredictable because of

® Rework the model to eliminate
using == or ~= operators on
floating-point signals.
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Condition

Recommended Action

floating-point precision issues.
These operators can lead to
unpredictable results in the
generated code.

The model or subsystem contains
a Logical Operator block that has
inputs or outputs that are not
Boolean inputs or outputs. The
block might result in floating-point
equality or inequality comparisons
in the generated code.

e Modify the Logical Operator
block so that all inputs and
outputs are Boolean. On the
Block Parameters > Signal
Attributes pane, consider
selecting Require all inputs to
have the same data type and
setting Output data type to
boolean.

¢ In the Configuration Parameters
dialog box, on the Optimization
pane, consider selecting the
Implement logic signals as
boolean data (vs. double).

See Also

® “hisl_0016: Usage of blocks that compute relational operators”

® “hisl_0017: Usage of blocks that compute relational operators (2)”
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Check usage of Ports and Subsystems blocks
Identify usage of Ports and Subsystems blocks that might impact safety.

Description
This check inspects your model for proper usage of:

® For Iterator blocks

® While Iterator blocks
o If blocks

® Switch Case blocks

See
e JEC 61508-3, Table A.3 (3) - Language subset, Table A.4 (3) - Defensive
programming

e [SO/DIS 26262-6, Table 1 (1b) - Use of language subsets, Table 1 (1d) - Use
of defensive implementation techniques

e MISRA-C:2004, Rule 13.6 - Numeric variables being used within a for loop
for iteration counting should not be modified in the body of the loop.

e MISRA-C:2004, Rule 14.10 - All if else if constructs should contain a final
else clause.

e MISRA-C:2004, Rule 15.3 - The final clause of a switch statement shall
be the default clause.

e MISRA-C:2004, Rule 21.1 - Minimization of runtime failures shall be
ensured by the use of at least one of the following:

= Static verification tools/techniques.
= Dynamic verification tools/techniques.

= Explicit coding of checks to handle runtime faults.
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Results and Recommended Actions

Condition

Recommended Action

The model or subsystem contains a
For Iterator block that has variable
iterations. This condition can lead

to unpredictable execution times or
infinite loops in the generated code.

For the identified For Iterator
blocks, do one of the following:

e Set the Iteration limit source
parameter to internal.

e [If the Iteration limit source
parameter must be external, use
a Constant, Probe, or Width block
as the source.

® (lear the Set next i (iteration
variable) externally check box.

® (Consider selecting the Show
iteration variable check box and
observe the iteration value during
simulation.

The model or subsystem contains

a While Iterator block that has
unlimited iterations. This condition
can lead to infinite loops in the
generated code.

For the identified While Iterator
blocks:

¢ Set the Maximum number of
iterations (-1 for unlimited)
parameter to a positive integer
value.

¢ Consider selecting the Show
iteration number port check
box and observe the iteration
value during simulation.

The model or subsystem contains
an If block with an If expression or
Elseif expressions that might cause
floating-point equality or inequality
comparisons in generated code.

Modify the expressions in the If block
to avoid floating-point equality or
inequality comparisons in generated
code.
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Condition

Recommended Action

The model or subsystem contains
an If block using Elseif expressions
without an Else condition.

In the If block Block Parameters
dialog box, select Show else
condition. Connect the resulting
Else output port to an If Action
Subsystem block.

The model or subsystem contains an
If block with output ports that do
not connect to If Action Subsystem
blocks.

Ensure that all output ports of the If
block connect to If Action Subsystem
blocks.

The model or subsystem contains an
Switch Case block without a default
case.

In the Switch Case block Block
Parameters dialog box, select
Show default case. Connect the
resulting default output port to a
Switch Case Action Subsystem block.

The model or subsystem contains a
Switch Case block with an output
port that does not connect to a Switch
Case Action Subsystem block.

Ensure that all output ports of the
Switch Case blocks connect to Switch
Case Action Subsystem blocks.

See Also

® “hisl_0010: Usage of If blocks and If Action Subsystem blocks”
® “hisl_0011: Usage of Switch Case blocks and Action Subsystem blocks”
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Display configuration management data
Display model configuration and checksum information.

Description
This informer check displays the following information for the current model:

e Model version number

® Model author
e Date
e Model checksum

See
e JEC 61508-3, Table A.8 (5) — Software configuration management

e ISO/DIS 26262-8, Clause 7.4.2

Results and Recommended Actions

Condition Recommended Action

Could not retrieve model version and | This summary is provided for your

checksum information. information. No action is required.
See Also

e “How Simulink Helps You Manage Model Versions” in the Simulink
documentation

¢ Model Change Log in the Simulink® Report Generator™ documentation
¢ Simulink.BlockDiagram.getChecksum in the Simulink documentation

¢ Simulink.SubSystem.getChecksum in the Simulink documentation
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MathWorks Automotive Advisory Board Checks

In this section...
“MathWorks Automotive Advisory Board Checks Overview” on page 5-101

“Check for difference in font and font sizes” on page 5-103

“Check transition orientations in flow charts” on page 5-105

“Check for display of nondefault block attributes” on page 5-106
“Check for proper labeling on signal lines” on page 5-107

“Check for propagated labels on signal lines” on page 5-109

“Check default transition placement in Stateflow charts” on page 5-110

“Check return value assignments of graphical functions in Stateflow charts”
on page 5-111

“Check entry formatting of states in Stateflow charts” on page 5-112

“Check usage of return values from a graphical function in Stateflow
charts” on page 5-113

“Check for pointers in Stateflow charts” on page 5-114

“Check for event broadcasts in Stateflow charts” on page 5-115
“Check transition actions in Stateflow charts” on page 5-116

“Check for MATLAB expressions in Stateflow charts” on page 5-117
“Check for blocks that do not using one-based indexing” on page 5-118
“Check for invalid file names” on page 5-120

“Check for invalid model directory names” on page 5-121

“Check for blocks that are not discrete” on page 5-122

“Check for prohibited sink blocks” on page 5-123

“Check for invalid port positioning and configuration” on page 5-124

“Check for mismatches between names of ports and corresponding signals”
on page 5-126

“Check whether block names do not appear below blocks” on page 5-127

“Check for systems that mix primitive blocks and subsystems” on page 5-128
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In this section...

“Check whether model has unconnected block input ports, output ports, or
signal lines” on page 5-129

“Check for improperly positioned Trigger and Enable blocks” on page 5-130
“Check whether annotations have drop shadows” on page 5-131

“Check whether tunable parameters specify expressions, data type
conversions, or indexing operations” on page 5-132

“Check whether Stateflow events are defined at the chart level or below” on
page 5-133

“Check whether Stateflow data objects with local scope are defined at the
chart level or below” on page 5-134

“Check interface signals and parameters” on page 5-135

“Check for exclusive states, default states, and substate validity” on page
5-136

“Check optimization parameters for Boolean data types” on page 5-138
“Check model diagnostic settings” on page 5-139

“Check the display attributes of block names” on page 5-142

“Check icon display attributes for port blocks” on page 5-143

“Check whether subsystem block names include invalid characters” on
page 5-144

“Check whether Inport and Outport block names include invalid characters”
on page 5-146

“Check whether signal line names include invalid characters” on page 5-148
“Check whether block names include invalid characters” on page 5-150
“Check Trigger and Enable block port names” on page 5-152

“Check for Simulink diagrams that have nonstandard appearance
attributes” on page 5-153

“Check visibility of port block names” on page 5-155
“Check for direction of subsystem blocks” on page 5-157
“Check configuration of Relational Operator blocks” on page 5-158
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In this section...

“Check for use of tunable parameters in Stateflow” on page 5-159

“Check for proper use of Switch blocks” on page 5-160

“Check for proper use of signal buses and Mux block usage” on page 5-161
“Check for bitwise operations in Stateflow charts” on page 5-162

“Check for comparison operations in Stateflow charts” on page 5-164

“Check for unary minus operations on unsigned integers in Stateflow
charts” on page 5-165

“Check for equality operations between floating-point expressions in
Stateflow charts” on page 5-166

“Check for mismatches between Stateflow ports and associated signal
names” on page 5-167

“Check for proper scope of From and Goto blocks” on page 5-168

MathWorks Automotive Advisory Board Checks
Overview

MathWorks Automotive Advisory Board (MAAB) checks facilitate designing
and troubleshooting models from which code is generated for automotive
applications.

The Model Advisor performs a checkout of the Simulink Verification and
Validation license when you run the MAAB checks.

See Also

¢ “Consulting the Model Advisor” in the Simulink documentation
¢ “Simulink Checks” in the Simulink reference documentation
e “Simulink Coder Checks” in the Simulink Coder documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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¢ The MathWorks Automotive Advisory Board on the MathWorks Web site,
which lists downloads for the latest version of Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow
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Check for difference in font and font sizes
Check for difference in font and font sizes.

Description

With the exception of free text annotations within a model, text elements,
such as block names, block annotations, and signal labels, must have the same
font style and font size. Select a font style and font size that is legible and
portable (convertible between platforms), such as Arial or Helvetica 12 point.

See MAAB guideline db_0043: Simulink font and font size.

Input Parameters

Font Name
Apply the specified font to all text elements. Available fonts include
Helvetica (default), Arial, Arial Black, Mangal, or Modern.

Font Size
Apply the specified font size to all text elements. Available sizes include
-1, 6, 8, 9, 10 (default), 12, 14, 16, 18, 20, 22, and 24.

Font Angle
Apply the specified font angle to all text elements. Available angles
include auto (default), normal, italic, and oblique.

Font Weight
Apply the specified font weight to all text elements. Available weights
include auto (default), normal, 1light, demi , and bold.

Results and Recommended Actions

Condition Recommended Action

The fonts or font sizes for text Specify values for the font
elements in the model are not parameters and click Modify
consistent or portable. all Fonts, or manually change the

fonts and font sizes of text elements
in the model such that they are
consistent and portable.
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Action Results

Clicking Modify all Fonts changes the font and font size of all text elements
in the model according to the values you specify for the font parameters.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check transition orientations in flow charts
Check transition orientations in flow charts.

Description

The following rules apply to transitions in flow charts:

® Draw transition conditions horizontally.

® Draw transitions with a condition action vertically.

Loop constructs are exceptions to these rules.

See MAAB guideline db_0132: Transitions in Flowcharts.

Results and Recommended Actions

Condition

Recommended Action

The model includes a transition
with a condition that is not drawn
horizontally or a transition action
that is not drawn vertically.

Modify the model.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for display of nondefault block attributes

Identify blocks that use nondefault block parameter values that are not
displayed in the model diagram.

Description

Model diagrams should display block parameters that have values other than
default values. One way of displaying this information is by using the Block
Annotation tab in the Block Properties dialog box.

See MAAB guideline db_0140: Display of basic block parameters.

Results and Recommended Actions

Condition Recommended Action

Block parameters that have values In the Block Properties dialog, use
other than default values, and the the Block Annotation tab to add
values are not in the model display. | block parameter annotations.

Tip

If you use the add_block function with 'built-in/blocktype' as a source
block path name for Simulink built-in blocks, some default parameter values
of some blocks are different from the defaults that you get if you added those
blocks interactively using Simulink.

See Also

® For a list of block parameter default values, see “Block-Specific Parameters”
in the Simulink documentation.

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation

e add_block in the Simulink documentation
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Check for proper labeling on signal lines
Check for proper labeling on signal lines.

Description
You should use a label to identify:

® Signals originating from the following blocks (the block icon exception
noted below applies to all blocks listed except Inport, Bus Selector, Demux,
and Selector):

Bus Selector block (tool forces labeling)
Chart block (Stateflow)

Constant block

Data Store Read block

Demux block

From block

Inport block

Selector block

Subsystem block

Block Icon Exception If a signal label is visible in the display of the
icon for the originating block, you do not have to display a label for the
connected signal unless the signal label is needed elsewhere due to a rule
for signal destinations.

e Signals connected to one of the following destination blocks (directly
or indirectly with a basic block that performs an operation that is not
transformative):

Bus Creator block
Chart block (Stateflow)
Data Store Write block
Goto block

Mux block

Outport block
Subsystem block
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® Any signal of interest.

See MAAB guideline na_0008: Display of labels on signals.

Results and Recommended Actions

Condition

Recommended Action

Signals coming from Bus Selector,
Chart, Constant, Data Store Read,
Demux, From, Inport, or Selector
blocks are not labeled.

Double-click the line that represents
the signal. After the text cursor
appears, enter a name and click
anywhere outside the label to exit
label editing mode.

See Also

e “Signal Labels” in the Simulink documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for propagated labels on signal lines
Check for propagated labels on signal lines.

Description

You should propagate a signal label from its source rather than enter the
signal label explicitly (manually) if the signal originates from:

An Inport block in a nested subsystem. However, if the nested subsystem
1s a library subsystem, you can explicitly label the signal coming from the
Inport block to accommodate reuse of the library block.

A basic block that performs a nontransformative operation.

A Subsystem or Stateflow Chart block. However, if the connection
originates from the output of an instance of the library block, you can
explicitly label the signal to accommodate reuse of the library block.

See MAAB guideline na_0009: Entry versus propagation of signal labels.

Results and Recommended Actions

Condition Recommended Action

The model includes signal labels that | Use the open angle bracket (<)
were entered explicitly, but should character to mark signal labels
be propagated. that should be propagated and

remove the labels that were entered
explicitly.

See Also

“Signal Labels” in the Simulink documentation

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check default transition placement in Stateflow
charts
Check default transition placement in Stateflow charts.

Description

In a Stateflow chart, you should connect the default transition at the top of
the state and place the destination state of the default transition above other
states in the hierarchy.

See MAAB guideline jc_0531: Placement of the default transition.

Results and Recommended Actions

Condition Recommended Action

The default transition for a Stateflow | Move the default transition to the
chart is not connected at the top of | top of the state chart.

the state.
The destination state of a Stateflow | Adjust the position of the default
chart’s default transition is lower transition’s destination state such
than other states in the same that the state is above other states
hierarchy. in the same hierarchy.

See Also

¢ “Defining Transitions Between States” in the Stateflow documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check return value assignments of graphical
functions in Stateflow charts

Identify graphical functions with multiple assignments of return values in
Stateflow charts.

Description

The return value from a Stateflow graphical function must be set in only
one place.

See MAAB guideline jc_0511: Setting the return value from a graphical
function.

Results and Recommended Actions

Condition Recommended Action
The return value from a Stateflow Modify the specified graphical
graphical function is assigned in function so that its return value is
multiple places. set in one place.

See Also

® “Graphical Functions” in the Stateflow documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check entry formatting of states in Stateflow charts

Identify missing line breaks between entry action (en), during action (du), and
exit action (ex) entries in states. Identify missing line breaks after semicolons
(;) In statements.

Description

Start a new line after the entry, during, and exit entries, and after the
completion of a statement “;”.

See MAAB guideline jc_0501: Format of entries in a State block.

Results and Recommended Actions

Condition Recommended Action
An entry (en) is not on a new line. Add a new line after the entry.
A during (du) is not on a new line. Add a new line after the during.
An exit (ex) is not on a new line. Add a new line after the exit.
Multiple statements found on one Add a new line after each statement.
line.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check usage of return values from a graphical
function in Stateflow charts
Identify calls to graphical functions in conditional expressions.

Description
Do not use the return value of a graphical function in a comparison operation.

See MAAB guideline jc_0521: Use of the return value from graphical
functions.

Results and Recommended Actions

Condition Recommended Action

Conditional expressions contain calls | Assign return values of graphical

to graphical functions. functions to intermediate variables.
Use these intermediate variables in
the specified conditional expressions.

See Also

® “Graphical Functions” in the Stateflow documentation

e “Using Graphical Functions to Extend Actions” in the Stateflow
documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for pointers in Stateflow charts

Identify pointer operations on custom code variables.

Description

Pointers to custom code variables are not allowed.

See MAAB guideline jm_0011: Pointers in Stateflow.

Results and Recommended Actions

Condition

Recommended Action

Custom code variables use pointer
operations.

Modify the specified chart to
remove the dependency on pointer
operations.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for event broadcasts in Stateflow charts

Identify undirected event broadcasts that might cause recursion during
simulation and generate inefficient code.

Description
Event broadcasts in Stateflow charts must be directed.

See MAAB guideline jm_0012: Event broadcasts

Results and Recommended Actions

Condition Recommended Action

Event broadcasts are undirected. Rearchitect the diagram to use
directed event broadcasting. Use the
send syntax or qualified event names
to direct the event to a particular
state. Use multiple send statements
to direct an event to more than one
state.

See Also

¢ “Broadcasting Events in Actions” in the Stateflow documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check transition actions in Stateflow charts

Identify missing line breaks between transition actions.

Description

For readability, start each transition action on a new line.

See MAAB guideline db_0151: State machine patterns for transition actions.

Results and Recommended Actions

Condition

Recommended Action

Transition actions use incorrect
formatting.

Ensure that each transition action
begins on a new line.

See Also

e “Using Actions in Stateflow Charts” in the Stateflow documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for MATLAB expressions in Stateflow charts
Identify Stateflow objects that use MATLAB expressions that are not suitable

for code generation.

Description

Do not use MATLAB functions, instructions, and operators in Stateflow

objects.

See MAAB guideline db_0127: MATLAB commands in Stateflow.

Results and Recommended Actions

Condition

Recommended Action

Stateflow objects use MATLAB
expressions.

Replace all MATLAB expressions in
Stateflow objects.

See Also

e “Using MATLAB Functions and Data in Actions” in the Stateflow

documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for blocks that do not using one-based

indexing

Check for blocks that do not use one-based indexing.

Description

One-based indexing ([1, 2, 3,...]) is used for the following:

Product

Items

MATLAB

Workspace variables and structures
Local variables of MATLAB functions
Global variables

Simulink

Signal vectors and matrices
Parameter vectors and matrices

S-function input and output signal vectors
and matrices in MATLAB-code

S-function parameter vectors and matrices
in MATLAB-code

S-function local variables in MATLAB-code

Stateflow

Input and output signal vectors and
matrices

Parameter vectors and matrices

Local variables

Zero-based indexing ([0, 1, 2, ...]) is used for the following:
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Product Items

Simulink U

Signal vectors and matrices

S-function input and output signal vectors
and matrices in C code

S-function input parameters in C code

S-function parameter vectors and matrices
in C code

S-function local variables in C code

Stateflow o

Variables and structures in custom C code

C code °

Local variables and structures

Global variables

See MAAB guideline db_0112: Indexing.

Results and Recommended Actions

Condition Recommended Action

Blocks in your model are not Using block parameters, configure

configured for one-based indexing. all blocks for one-based indexing.
See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for invalid file names
Check for files residing in the same folder as the model that have illegal file

names.

Description

See MAAB guideline ar_0001: Filenames.

Results and Recommended Actions

Condition

Recommended Action

The file name contains illegal
characters.

Rename the file. Allowed characters
are a—z, A—Z, 0-9. and underscore

Q).

The file name starts with a number.

Rename the file.

The file name starts with an
underscore ("_").

Rename the file.

The file name ends with an
underscore ("_").

Rename the file.

The file extension contains one (or
more) underscores.

Change the file extension.

The file name has consecutive
underscores.

Rename the file.

The file name contains more than
one dot (".").

Rename the file.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for invalid model directory names

Checks model directory and subdirectory names for invalid characters.

Description

See MAAB guideline ar_0002: Directory names.

Results and Recommended Actions

Condition

Recommended Action

The directory name contains illegal
characters.

Rename the directory. Allowed
characters are a—z, A-Z, 0-9. and
underscore ().

The directory name starts with a
number.

Rename the directory.

The directory name starts with an
underscore ("_").

Rename the directory.

The directory name ends with an
underscore ("_").

Rename the directory.

The directory name has consecutive
underscores.

Rename the directory.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for blocks that are not discrete

Check for blocks that are not discrete.

Description

You cannot include continuous blocks in controller models.

See MAAB guideline jm_0001: Prohibited Simulink standard blocks inside

controllers.

Results and Recommended Actions

Condition

Recommended Action

Continuous blocks — Derivative,
Integrator, State-Space, Transfer
Fen, Transfer Delay, Variable Time
Delay, Variable Transport Delay,
and Zero-Pole — are not permitted
in models representing discrete
controllers.

Replace continuous blocks with
the equivalent blocks discretized
in the s-domain by using the
Discretizing library, as explain in
“How to Discretize Blocks from the
Simulink Model” in the Simulink
documentation.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for prohibited sink blocks
Check for prohibited Simulink sink blocks.

Description

You must design controller models from discrete blocks. Sink blocks, such
as the Scope block, are not allowed.

See MAAB guideline hd_0001: Prohibited Simulink sinks.

Results and Recommended Actions

Condition Recommended Action

Sink blocks are not permitted in Remove sink blocks from the model.
discrete controllers.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for invalid port positioning and configuration
Check whether the model contains ports with invalid position and

configuration.

Description

In models, ports must comply with the following rules:

® Place Inport blocks on the left side of the diagram. Move the Inport block
right only to prevent signal crossings.

e Place Outport blocks on the right side of the diagram. Move the Outport
block left only to prevent signal crossings.

® Avoid using duplicate Inport blocks at the subsystem level if possible.

® Do not use duplicate Inport blocks at the root level.

See MAAB guideline db_0042: Port block in Simulink models.

Results and Recommended Actions

Condition

Recommended Action

Inport blocks are too far to the right
and result in left-flowing signals.

Move the specified Inport blocks to
the left.

Outport blocks are too far to the left
and result in right-flowing signals.

Move the specified Output blocks to
the right.

Ports do not have the default
orientation.

Modify the model diagram such that
signal lines for output ports enter
the side of the block and signal lines
for input ports exit the right side of
the block.

Ports are duplicate Inport blocks.

e [f the duplicate Inport blocks are
in a subsystem, remove them
where possible.

e [f the duplicate Inport blocks are
at the root level, remove them.
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See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for mismatches between names of ports and
corresponding signals

Check for mismatches between names of ports and corresponding signals.

Description

Use matching names for ports and their corresponding signals.

See MAAB guideline jm_0010: Port block names in Simulink models.
Prerequisite

Prerequisite MAAB guidelines for this check are:

e db_0042: Port block in Simulink models

® na_0005: Port block name visibility in Simulink models

Results and Recommended Actions

Condition Recommended Action
Ports have names that differ from Change the port name or the signal
their corresponding signals. name to match the correct name for
the signal.
See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check whether block names do not appear below
blocks

Check whether block names do not appear below blocks.

Description
If shown, the name of all blocks should appear below the blocks.

See MAAB guideline db_0142: Position of block names.

Results and Recommended Actions

Condition Recommended Action
Blocks have names that do not Set the name of the block to appear
appear below the blocks. below the blocks.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for systems that mix primitive blocks and
subsystems

Check for systems that mix primitive blocks and subsystems.

Description

You must design every level of a model with building blocks of the same type,
for example, only subsystems or only primitive (basic) blocks.

See MAAB guideline db_0143: Similar block types on the model levels.

Results and Recommended Actions

Condition Recommended Action

A level in the model includes both ® Move nonvirtual blocks into the
subsystem blocks and primitive subsystem.

blocks.

e [f possible, replace blocks at
the i1dentified level of the model
hierarchy with blocks that you can
place at any module level. Such
blocks include Inport, Outport,
Enable (not at highest model
level), Trigger (not at highest
model level), Mux, Demux, Bus
Selector, Bus Creator, Selector,
Ground, Terminator, From, Goto,
Switch, Multiport Switch, Merge,
Unit Delay, Rate Transition, Type
Conversion, Data Store Memory,
If, and Switch Case.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation



MathWorks® Automotive Advisory Board Checks

Check whether model has unconnected block input
ports, output ports, or signal lines

Check whether model has unconnected input ports, output ports, or signal
lines.

Description

All unconnected inputs should be connected to ground blocks. All unconnected
outputs should be connected to terminator blocks. Respecting the guideline
eliminates error messages.

See MAAB guideline db_0081: Unconnected signals, block inputs and block
outputs.

Results and Recommended Actions

Condition Recommended Action

Blocks have unconnected inputs or Connect unconnected lines to blocks
outputs. specified by the design or to Ground
or Terminator blocks.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for improperly positioned Trigger and Enable
blocks

Check for improperly positioned Trigger and Enable blocks.

Description

Locate blocks that define subsystems as conditional or iterative at the top
of the subsystem diagram.

See MAAB guideline db_0146: Triggered, enabled, conditional Subsystems.

Results and Recommended Actions

Condition Recommended Action

Trigger , Enable, and Action Port Move the Trigger, Enable, and
blocks are not centered in the upper | Action Port blocks to the correct area
third of the model diagram. of the model diagram.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check whether annotations have drop shadows
Check whether annotations have drop shadows.

Description
Annotations should not have a drop shadow for readability.

See MAAB guideline jm_0013: Annotations.

Results and Recommended Actions

Condition Recommended Action

Annotations display drop shadows. Clear the Format > Show Drop
Shadow menu option.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check whether tunable parameters specify
expressions, data type conversions, or indexing

operations

Check whether tunable parameters specify expressions, data type conversions,

or indexing operations.

Description

To ensure that a parameter is tunable, you must enter the basic block without
the use of MATLAB calculations or scripting. For example, omit

¢ Expressions
® Data type conversions

® Selections of rows or columns

See MAAB guideline db_0110: Tunable parameters in basic blocks.

Results and Recommended Actions

Condition

Recommended Action

Blocks have a tunable parameter
that specifies an expression,
data type conversion, or indexing
operation.

In each case, move the calculation
outside of the block, for example,
by performing the calculation with
a series of Simulink blocks, or
precompute the value in the base
workspace as a new variable.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check whether Stateflow events are defined at the
chart level or below

Check whether Stateflow events are defined at the chart level or below.

Description

All events of a Stateflow chart must be defined at the chart level or lower.
Events cannot be at the machine level; that is, charts cannot interact with
local events.

See MAAB guideline db_0126: Scope of events.

Results and Recommended Actions

Condition Recommended Action
An event in a chart is not defined at | Define the event at the chart level
the chart level or below. or below.

See Also

¢ “Defining Events” in the Stateflow documentation.

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check whether Stateflow data objects with local
scope are defined at the chart level or below

Check whether Stateflow data objects with local scope are defined at the
chart level or below.

Description

You must define all local data of a Stateflow block on the chart level or below
in the object hierarchy. You cannot define local variables on the machine
level; however, parameters and constants are allowed at the machine level.

See MAAB guideline db_0125: Scope of internal signals and local auxiliary
variables.

Results and Recommended Actions

Condition Recommended Action

Local data is not defined in the Define local data at the chart level
Stateflow hierarchy at the chart or below.

level or below.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check interface signals and parameters

Check whether labeled Stateflow and Simulink input and output signals
are strongly typed.

Description

Strong data typing between Stateflow and Simulink input and output signals
is required.

See MAAB guideline db_0122: Stateflow and Simulink interface signals and
parameters.

Results and Recommended Actions

Condition Recommended Action

A Stateflow chart does not use strong | Select the Use Strong Data Typing
data typing with Simulink. with Simulink I/0 check box for
the specified block.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for exclusive states, default states, and

substate validity

Check states in state machines.

Description
In state machines:

® There must be at least two exclusive states.

® A state cannot have only one substate.

¢ The initial state of a hierarchical level with exclusive states is clearly

defined by a default transition.

See MAAB guideline db_0137: States in state machines.

Prerequisite

A prerequisite MAAB guideline for this check is db_0149: Flowchart patterns

for condition actions.

Results and Recommended Actions

Condition

Recommended Action

A system is underspecified.

Validate that the intended design
is properly represented in the
Stateflow diagram.

Chart has only one exclusive (OR)
state.

Make the state a parallel state, or
add another exclusive (OR) state.

Chart does not have a default state
defined.

Define a default state.

Chart has multiple default states
defined.

Define only one default state. Make
the others nondefault.

State has only one exclusive (OR)
substate.

Make the state a parallel state, or
add another exclusive (OR) state.
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Condition Recommended Action

State does not have a default Define a default substate.
substate defined.

State has multiple default substates | Define only one default substate,
defined. make the others nondefault.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check optimization parameters for Boolean data
types

Check the optimization parameter for Boolean data types.

Description
Optimization for Boolean data types is required

See MAAB guideline jc_0011: Optimization parameters for Boolean data
types.

Prerequisite

A prerequisite MAAB guideline for this check is na_0002: Appropriate
implementation of fundamental logical and numerical operations.

Results and Recommended Actions

Condition Recommended Action
Configuration setting for Select the Implement logic signals
Implement logic signals as as boolean data (vs. double) check
boolean data (vs. double) is box in the Configuration Parameters
incorrect. dialog box Optimization pane.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check model diagnostic settings
Check the model diagnostics configuration parameter settings.

Description
You should enable the following diagnostics:

Algebraic loop

Minimize algebraic loop

Inf or NaN block output

Duplicate data store names
Unconnected block input ports
Unconnected block output ports
Unconnected line

Unspecified bus object at root Outport block
Mux blocks used to create bus signals
Element name mismatch

Invalid function-call connection

Diagnostics not listed in the Results and Recommended Actions section below
can be set to any value.

See MAAB guideline jc_0021: Model diagnostic settings.

Results and Recommended Actions

Condition Recommended Action

Algebraic loop is set to none. Set Algebraic loop on the

Diagnostics > Solver pane of the
Configuration Parameters dialog box to error
or warning. Otherwise, Simulink might
attempt to automatically break the algebraic
loops, which can affect execution order of the
blocks.

Minimize algebraic loop is set to none. Set Minimize algebraic loop on the
Diagnostics > Solver pane of the
Configuration Parameters dialog box to
error or warning. Otherwise, Simulink
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Condition

Recommended Action

might attempt to automatically break the
algebraic loops for reference models and atomic
subsystems, which can affect the execution
order for those models or subsystems.

Inf or NaN block output is set to none,
which can result in numerical exceptions in the
generated code.

Set Inf or NaN block output on the
Diagnostics > Data Validity > Signals pane
of the Configuration Parameters dialog box to
error or warning.

Duplicate data store names is set to none,
which can result in nonunique variable naming
in the generated code.

Set Duplicate data store names on the
Diagnostics > Data Validity > Signals
pane of the Configuration Parameters dialog
box to error or warning.

Unconnected block input ports is set to
none, which prevents code generation.

Set Unconnected block input ports on the
Diagnostics > Data Validity > Signals
pane of the Configuration Parameters dialog
box to error or warning.

Unconnected block output ports is set to
none, which can lead to dead code.

Set Unconnected block output ports on
the Diagnostics > Data Validity > Signals
pane of the Configuration Parameters dialog
box to error or warning.

Unconnected line is set to none, which
prevents code generation.

Set Unconnected line on the
Diagnostics > Connectivity > Signals
pane of the Configuration Parameters dialog
box to error or warning.

Unspecified bus object at root Outport
block is set to none, which can lead to an
unspecified interface if the model is referenced
from another model.

Set Unspecified bus object

at root Outport block on the
Diagnostics > Connectivity > Buses
pane of the Configuration Parameters dialog
box to error or warning.

Mux blocks used to create bus signals is
set to none, which can lead to an unintended
bus being created in the model.

Set Mux blocks used to create bus signals
on the Diagnostics > Connectivity > Buses
pane of the Configuration Parameters dialog
box to error or warning.
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Condition Recommended Action

Element name mismatch is set to none, Set Element name mismatch on the

which can lead to an incorrect interface in the | Diagnostics > Connectivity > Buses pane

generated code. of the Configuration Parameters dialog box to
error or warning.

Invalid function-call connection is set Set Invalid function-call connection on the

to none, which can lead to an error in the Diagnostics > Connectivity > Function

operation of the generated code. Calls pane of the Configuration Parameters

dialog box to error or warning, since this
condition can lead to an error in the operation
of the generated code.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check the display attributes of block names
Check the display attributes of block names.

Description

Block names should be displayed when providing descriptive information.
Block names should not be displayed if the block function is known from its
appearance.

See MAAB guideline jc_0061: Display of block names.

Results and Recommended Actions

Condition Recommended Action

Block name is not descriptive. These block names should be
modified to be more descriptive or
not be shown.

Block name is not displayed. These block names should be
shown since they appear to have a
descriptive name.

Block name 1s obvious. These block names should not be
displayed.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation

5-142



MathWorks® Automotive Advisory Board Checks

Check icon display attributes for port blocks
Check the Icon display setting for Inport and Outport blocks.

Description

The Icon display setting is required.

See MAAB guideline jc_0081: Icon display for Port block.

Results and Recommended Actions

Condition

Recommended Action

The Icon display setting is
incorrect.

Set the Icon display to Port
number for the specified Inport and
Outport blocks.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check whether subsystem block names include
invalid characters

Check whether subsystem block names include invalid characters.

Description
The names of all subsystem blocks are required.

See MAAB guideline je_0201: Usable characters for Subsystem names.

Results and Recommended Actions

Condition Recommended Action

The subsystem name contains illegal | Rename the subsystem. Allowed
characters. characters include a—z, A-Z, 0-9,
underscore (_), and period (.).

The subsystem name starts with a Rename the subsystem.
number.

The subsystem name starts with an | Rename the subsystem.
underscore ("_").

The subsystem name ends with an Rename the subsystem.
underscore ("_").

The subsystem name contains Rename the subsystem.
consecutive underscores.

The subsystem name has consecutive | Rename the subsystem.
underscores.

The subsystem name has blank Rename the subsystem.
spaces.

Tips

Use underscores to separate parts of a subsystem name instead of spaces.
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See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check whether Inport and Outport block names
include invalid characters
Check whether Inport and Outport block names include invalid characters.

Description
The names of all Inport and Outport blocks are required.

See MAAB guideline jc_0211: Usable characters for Inport blocks and Outport
blocks.

Results and Recommended Actions

Condition Recommended Action

The block name contains illegal Rename the block. Allowed

characters. characters include a—z, A-Z, 0-9,
underscore (_), and period (.).

The block name starts with a Rename the block.

number.

The block name starts with an Rename the block.

underscore ("_").

The block name ends with an Rename the block.
underscore ("_").

The block name contains consecutive | Rename the block.

underscores.

The block name has consecutive Rename the block.

underscores.

The block name has blank spaces. Rename the block.
Tips

Use underscores to separate parts of a block name instead of spaces.
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See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check whether signal line names include invalid
characters

Check whether signal line names include invalid characters.

Description
The names of all signal lines are required.

See MAAB guideline je_0221: Usable characters for signal line names.

Results and Recommended Actions

Condition Recommended Action

The signal line name contains illegal | Rename the signal line. Allowed
characters. characters include a—z, A-Z, 0-9,
underscore (_), and period (.).

The signal line name starts with a Rename the signal line.
number.

The signal line name starts with an | Rename the signal line.
underscore ("_").

The signal line name ends with an Rename the signal line.
underscore ("_").

The signal line name contains Rename the signal line.
consecutive underscores.

The signal line name has consecutive | Rename the signal line.
underscores.

The signal line name has blank Rename the signal line.
spaces.

The signal line name has control Rename the signal line.
characters.

Tips

Use underscores to separate parts of a signal line name instead of spaces.
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See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check whether block names include invalid
characters

Check whether block names include invalid characters.

Description
The names of all blocks are required.

This guideline does not apply to subsystem blocks.

See MAAB guideline je_0231: Usable characters for block names.

Prerequisite

A prerequisite MAAB guideline for this check is jc_0201: Usable characters
for Subsystem names.

Results and Recommended Actions

Condition Recommended Action

The block name contains illegal Rename the block. Allowed

characters. characters include a-z, A-Z, 0-9,
underscore (_), and period (.).

The block name starts with a Rename the block.

number.

The block name has blank spaces. Rename the block.

The block name has double byte Rename the block.

characters.

Tips

Carriage returns are allowed in block names.
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See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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5-152

Check Trigger and Enable block port names
Check Trigger and Enable block port names.

Description

Block port names should match the name of the signal triggering the

subsystem.

See MAAB guideline jc_0281: Naming of Trigger Port block and Enable Port

block.

Results and Recommended Actions

Condition

Recommended Action

Trigger block does not match the
name of the signal to which it is
connected.

Match Trigger block names to the
connecting signal.

Enable block does not match the
name of the signal to which it is
connected.

Match Enable block names to the
connecting signal.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for Simulink diagrams that have nonstandard

appearance atiributes

Check model appearance setting attributes.

Description

Model appearance settings are required to conform to the guidelines when

the model is released.

See MAAB guideline na_0004: Simulink model appearance.

Results and Recommended Actions

Condition

Recommended Action

Diagrams do not have white
backgrounds.

Select Format > Screen
Color > Automatic.

Diagrams do not have zoom factor
set to 100%.

Select View > Normal (100%).

The toolbar is not visible.

Select View > Toolbar.

The status bar is not visible.

Select View > Status Bar.

Block backgrounds are not white.

Blocks should have black
foregrounds with white backgrounds.
Click the specified block and

select Format > Foreground
Color > Black and

Format > Background

Color > White.

Wide Nonscalar Lines is cleared.

Select Format > Port/Signal
Displays > Wide Nonscalar
Lines.

Viewer Indicators is cleared.

Select Format > Port/Signal
Displays > Viewer Indicators.

Testpoint Indicators is cleared.

Select Format > Port/Signal
Displays > Testpoint Indicators.
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Condition

Recommended Action

Port Data Types is selected.

Clear Format > Port/Signal
Displays > Port Data Types.

Storage Class is selected.

Clear Format > Port/Signal
Displays > Storage Class.

Signal Dimensions is selected.

Clear Format > Port/Signal
Displays > Signal Dimensions.

Model Browser is selected.

Clear View > Model Browser
Options > Model Browser.

Sorted Order is selected.

Clear Format > Block
Displays > Sorted Order.

Model Block Version is selected.

Clear Format > Block
Displays > Model Block Version.

Model Block I/O Mismatch is
selected.

Clear Format > Block
Displays > Model Block I/0
Mismatch.

Execution Context Indicator is
selected.

Clear Format > Block
Displays > Execution Context
Indicator.

Sample Time Colors is selected.

Clear Format > Port/Signal
Displays > Sample Time Colors.

Library Link Display is set to
User or All.

Select Format > Library Link
Display > None.

Linearization Indicators is
cleared.

Select Format > Port/Signal
Displays > Linearization
Indicators.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check visibility of port block names

Check the visibility of port block names.

Description

An organization applying the MAAB guidelines must select one of the
following alternatives to enforce:

¢ The name of port blocks are not hidden.

¢ The name of port blocks must be hidden.

See MAAB guideline na_0005: Port block name visibility in Simulink models.

Input Parameters

All Port names should be shown (Format/Show Name)
Select this check box if all ports should show the name, including

subsystems.

Results and Recommended Actions

Condition

Recommended Action

Blocks do not show their name and
the All Port names should be
shown (Format/Show Name)
check box is selected.

Change the format of the specified
blocks to show names according to
the input requirement.

Blocks show their name and the All
Port names should be shown
(Format/Show Name) check box is
cleared.

Change the format of the specified
blocks to hide names according to
the input requirement.

Subsystem blocks do not show their
port names.

Set the subsystem parameter Show
port labels to a value other than
none.

Subsystem blocks show their port
names.

Set the subsystem parameter Show
port labels to none.
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Limitations
This check does not look in masked subsystems.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for direction of subsystem blocks

Check the orientation of subsystem blocks.

Description

Subsystem inputs must be located on the left side of the block, and outputs
must be located on the right side of the block.

See MAAB guideline jc_0111: Direction of Subsystem.

Results and Recommended Actions

Condition Recommended Action

Subsystem blocks are not in the Change the subsystem blocks to have

correct orientation. the correct orientation, with inports
on the left and outports on the right.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check configuration of Relational Operator blocks
Check the position of Constant blocks used in Relational Operator blocks.

Description

When the relational operator is used to compare a signal to a constant value,
the constant input should be the second, lower input.

See MAAB guideline jc_0131: Use of Relational Operator block.

Results and Recommended Actions

Condition Recommended Action
Relational Operator blocks have a Move the Constant block to the
Constant block on the first, upper second, lower input.
input.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for use of tunable parameters in Stateflow
Check for use of tunable parameters in Stateflow charts.

Description

Include tunable parameters in a Stateflow chart as inputs from the Simulink
model.

See MAAB guideline je_0541: Use of tunable parameters in Stateflow.

Results and Recommended Actions

Condition Recommended Action

Stateflow charts reference Simulink | Make the Simulink data objects
data objects, which should be used inputs from the Simulink model to
as inputs from the Simulink model. | the specified Stateflow chart.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for proper use of Switch blocks
Check for proper use of Switch blocks.

Description

This check verifies that the Switch block’s control input (the second input)
1s a Boolean value and that the block is configured to pass the first input
when the control input is nonzero.

See MAAB guideline jc_0141: Use of the Switch block.

Results and Recommended Actions

Condition Recommended Action

The Switch block’s control input Change the data type of the control
(second input) is not a Boolean value. | input to Boolean.

The Switch block is not configured to | Set the block parameter Criteria
pass the first input when the control | for passing first input to u2 ~=0.
input is nonzero.

See Also

e See the description of the Switch block in the Simulink documentation.

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for proper use of signal buses and Mux block

usage

Check for proper use of signal busses and Mux block usage.

Description

This check verifies whether a model is using signal buses and Mux blocks

properly.

See MAAB guideline na_0010: Grouping data flows into signals.

Results and Recommended Actions

Condition

Recommended Action

The individual scalar input signals
for a Mux block do not have
common functionality, data types,
dimensions, and units.

Modify the scalar input signals such
that the specifications match.

The output of a Mux block is not a
vector.

Change the output of the Mux block
to a vector.

All inputs to a Mux block are not
scalars.

Make sure that all input signals to
Mux blocks are scalars.

The input for a Bus Selector block is
not a bus signal.

Make sure that the input for all Bus
Selector blocks is a bus signal.

See Also

¢ “Using Composite Signals” in the Simulink documentation.

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Check for bitwise operations in Stateflow charts

Identify bitwise operators (&, |, and ") in Stateflow charts. If you select
Enable C-bit operations for a chart, only bitwise operators in expressions
containing Boolean data types are reported. Otherwise, all bitwise operators

are reported for the chart.

Description

Do not use bitwise operators in Stateflow charts, unless you enable bitwise

operations.

See MAAB guideline na_0001: Bitwise Stateflow operators.

Results and Recommended Actions

Condition

Recommended Action

Stateflow charts with Enable C-bit
operations selected use bitwise
operators (&, |, and ") in expressions
containing Boolean data types.

Do not use Boolean data types in the
specified expressions.

The Model Advisor could not
determine the data types in
expressions with bitwise operations.

To allow Model Advisor to
determine the data types, consider
explicitly typecasting the specified
expressions.

Stateflow charts with Enable C-bit
operations cleared use bitwise
operators (&, |, and *).

To fix this issue, do any of the

following:

® Modify the expressions to replace
bitwise operators.

¢ If not using Boolean data
types, consider enabling bitwise
operations. In the Chart
properties dialog box, select
Enable C-bit operations.
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See Also

* “Binary and Bitwise Operations” in the Stateflow documentation

o “MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for comparison operations in Stateflow charts

Identify comparison operations with different data types in Stateflow objects.

Description
Comparisons should be made between variables of the same data types.

See MAAB guideline na_0013: Comparison operation in Stateflow

Results and Recommended Actions

Condition Recommended Action
Comparison operations with Revisit the specified operations to
different data types were found. avoid comparison operations with
different data types.

The Model Advisor could not To allow Model Advisor to
determine the data types in determine the data types, consider
expressions with comparison explicitly typecasting the specified
operations. expressions.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for unary minus operations on unsigned
integers in Stateflow charts

Identify unary minus operations applied to unsigned integers in Stateflow
objects.

Description

Do not perform unary minus operations on unsigned integers in Stateflow
objects.

See MAAB guideline jc_0451: Use of unary minus on unsigned integers in
Stateflow

Results and Recommended Actions

Condition Recommended Action
Unary minus operations are applied | Modify the specified objects to
to unsigned integers in Stateflow remove dependency on unary minus
objects. operations.
The Model Advisor could not To allow Model Advisor to
determine the data types in determine the data types, consider
expressions with unary minus explicitly typecasting the specified
operations. expressions.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for equality operations between floating-point
expressions in Stateflow charts

Identify equal to operations (==) in expressions where at least one side of the
expression is a floating-point variable or constant.

Description

Do not use equal to operations with floating-point data types. You can use
equal to operations with integer data types.

See MAAB guideline je_0481: Use of hard equality comparisons for floating
point numbers in Stateflow

Results and Recommended Actions

Condition Recommended Action
Expressions use equal to operations | Modify the specified expressions to
(==) where at least one side of avoid equal to operations between
the expression is a floating-point floating-point expressions. If an
variable or constant. equal to operation is required, a

margin of error should be defined
and used in the operation.

The Model Advisor could not To allow Model Advisor to
determine the data types in determine the data types, consider
expressions with equality operations. | explicitly typecasting the specified
expressions.
See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for mismatches between Stateflow ports and
associated signal names

Check for mismatches between Stateflow ports and associated signal names.

Description

The name of Stateflow input and output should be the same as the
corresponding signal.

See MAAB guideline db_0123: Stateflow port names.

Results and Recommended Actions

Condition Recommended Action
Signals have names that differ Change the names of either the
from those of their corresponding signals or the Stateflow ports.
Stateflow ports.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink
documentation
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Check for proper scope of From and Goto blocks
Check the scope of From and Goto blocks.

Description

You can use global scope for controlling flow. However, From and Goto blocks

must use local scope for signal flows.

See MAAB guideline na_0011: Scope of Goto and From blocks.

Results and Recommended Actions

Condition

Recommended Action

From and Goto blocks are not
configured with local scope.

e Make sure the ports are connected
correctly.

¢ Change the scope of the specified
blocks to local.

See Also

“MathWorks Automotive Advisory Board Control Algorithm Modeling
Guidelines Using MATLAB, Simulink, and Stateflow” in the Simulink

documentation
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Requirements Consistency Checks

In this section...

“Identify requirement links with missing documents” on page 5-170

“Identify requirement links that specify invalid locations within documents”
on page 5-171

“Identify selection-based links having descriptions that do not match their
requirements document text” on page 5-172

“Identify requirement links with inconsistent path types and preferences”
on page 5-174

5-169
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Identify requirement links with missing documents
Ensure that requirements link to existing documents.

Description

You used the Requirements Management Interface (RMI) to associate a
design requirements document with a part of your model design and the
interface cannot find the specified document.

Results and Recommended Actions

Condition Recommended Action

The requirements document Open the Requirements dialog box

associated with a part of your and correct the path name of the

model design is not accessible at the | requirements document or move the

specified location. document to the specified location.
Tips

If your model has links to a DOORS requirements document, to run this
check, the DOORS software must be open and you must be logged in.

See Also
“Keeping Requirements Information Up to Date”
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Identify requirement links that specify invalid
locations within documents

Ensure that requirements link to valid locations (e.g., bookmarks, line
numbers, anchors) within documents.

Description

You used the Requirements Management Interface (RMI) to associate a
location in a design requirements document (a bookmark, line number, or
anchor) with a part of your model design and the interface cannot find the
specified location in the specified document.

Results and Recommended Actions

Condition Recommended Action

The location in the requirements Open the Requirements dialog box
document associated with a part of | and correct the location reference
your model design is not accessible. | within the requirements document.

Tips
If your model has links to a DOORS requirements document, to run this
check, the DOORS software must be open and you must be logged in.

If your model has links to a Microsoft Word or Microsoft® Excel® document, to
run this check, those applications must be closed on your computer.

See Also
“Keeping Requirements Information Up to Date”
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Identify selection-based links having descriptions
that do not match their requirements document text

Ensure that descriptions of selection-based links use the same text found in
their requirements documents.

Description

You used selection-based linking of the Requirements Management Interface
(RMI) to label requirements in the model’s Requirements menu with text
that appears in the corresponding requirements document. This check helps
you manage traceability by identifying requirement descriptions in the menu
that are not synchronized with text in the documents.

Results and Recommended Actions

Condition Recommended Action
Selection-based links have If the difference reflects a change in
descriptions that differ from the requirements document, click
their corresponding selections in the | Update in the Model Advisor results
requirements documents. to replace the current description

in the selection-based link with

the text from the requirements
document (the external description).
Alternatively, you can right-click
the object in the model window,
select Edit/Add Links from the
Requirements menu, and use

the Requirements dialog box that
appears to synchronize the text.

Tips
If your model has links to a DOORS requirements document, to run this
check, the DOORS software must be open and you must be logged in.

If your model has links to a Microsoft Word or Microsoft Excel document, to
run this check, those applications must be closed on your computer.
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See Also
“Creating and Managing Requirements Links”
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Identify requirement links with inconsistent path
types and preferences
Check that requirement paths are of the type selected in the preferences.

Description

You are using the Requirements Management Interface (RMI) and the paths
specifying the location of your requirements documents differ from the file
reference type set as your preference.

Results and Recommended Actions

Condition Recommended Action

The paths indicating the location | Change the preferred document file

of requirements documents use reference type or the specified paths by
a file reference type that differs doing one of the following:

from the preference specified in
the Requirements Settings dialog | ® Click Fix to change the current path
box, on the Selection Linking to the valid path.

izl ¢ In the model window, select

Tools > Requirements > Settings,
select the Selection Linking

tab, and change the value for the
Document file reference option.

Linux Check for Absolute Paths

On Linux® systems, this check is named Identify requirement links with
absolute path type. The check reports warnings for all requirements links
that use an absolute path.

The recommended action 1is:

1 Right-click the model object and select Requirements > Edit/Add Links.

2 Modify the path in the Document field to use a path relative to the current
working folder or the model location.
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See Also
“Creating and Managing Requirements Links”
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